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Preface

This guide is one of several resources available to help you learn about the Adobe® LiveCycle™ suite of 
products. LiveCycle products help automate and accelerate the flow of business-critical information to and 
from customers, partners, constituents, and employees.

What’s in this guide?
This guide provides information about how to install and configure the following LiveCycle products on 
Microsoft® Windows®, Linux®, and Sun™ Solaris™, and how to deploy the products to a BEA WebLogic 
Server®:

● Adobe LiveCycle Assembler 7.2.1

● Adobe LiveCycle Forms 7.2

● Adobe LiveCycle Form Manager 7.2

● Adobe LiveCycle PDF Generator 7.2 Professional, LiveCycle PDF Generator 7.2 Elements, and 
LiveCycle PDF Generator 7.2 for PostScript®

● Adobe LiveCycle Print 7.2

● Adobe LiveCycle Workflow 7.2.1

This guide also provides information about how to install and configure Watched Folder 1.1.

Who should read this guide?
This guide provides information for administrators or developers responsible for installing, configuring, 
administering, or deploying LiveCycle products. The information provided is based on the assumption that 
anyone reading this guide is familiar with application servers, Linux, Windows, or Solaris operating 
systems, MySQL, Oracle®, DB2®, or SQL Server database servers, and web environments. 

Conventions used in this guide
This guide uses the following naming conventions for common file paths.

Name Default value Description

[LiveCycle root] Windows: 
C:\Adobe\LiveCycle\

Linux and UNIX®:
/opt/adobe/livecycle/

The installation directory that is 
used for all LiveCycle products. The 
installation directory contains 
subdirectories for Adobe 
Configuration Manager, product 
SDKs, and each LiveCycle product 
installed (along with the product 
documentation). 
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Most of the information about directory locations in this guide is cross-platform (all file names and paths 
are case-sensitive on Linux). Any platform-specific information is indicated as required.

Related documentation
This guide contains instructions for deploying LiveCycle products to WebLogic Server. The Installing and 
Configuring LiveCycle guides for other supported application servers can be accessed at: 
www.adobe.com/support/documentation/en/livecycle/

The resources in this table can help you learn about and get started using LiveCycle products. 

[product root] Windows:
C:\Adobe\LiveCycle\Assembler
C:\Adobe\LiveCycle\pdfgenerator
C:\Adobe\LiveCycle\Workflow
C:\Adobe\LiveCycle\Forms
C:\Adobe\LiveCycle\Print
C:\Adobe\LiveCycle\Formmanager

Linux, UNIX:
/opt/adobe/livecycle/assembler
/opt/adobe/livecycle/pdfgenerator
/opt/adobe/livecycle/workflow
/opt/adobe/livecycle/forms
/opt/adobe/livecycle/print
/opt/adobe/livecycle/formmanager

The directories where 
product-specific directories and 
files (such as documentation, 
uninstall files, samples, and license 
information) are located.

[appserver root] Windows:
C:\bea\weblogic81\

Linux and UNIX:
/opt/bea/weblogic81

The home directory of the 
application server that runs the 
LiveCycle products. 

BEA_HOME Windows:
C:\bea

Linux, UNIX: 
/opt/bea

The install directory for WebLogic 
as specified for the BEA_HOME 
environment variable.

[appserverdomain] Windows:
C:\bea\user_projects\domains\mydomain

UNIX: 
/opt/bea/user_projects/domains/mydomain

The domain that you configured on 
WebLogic.

Name Default value Description

For information about See

General information about a product and 
how it integrates with other Adobe products

Overview guides for each product

The product architecture, how to use the APIs, 
and how to develop custom applications for 
use with the products

The developer guides for each product. For example, 
Developing Custom Application for LiveCycle Workflow 
or Developing Applications for LiveCycle Assembler.

http://www.adobe.com/support/documentation/en/livecycle/
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For information about additional documentation available for each of the LiveCycle products, see the 
doc_map.pdf files located in each [product root]/documentation folder. 

Note: When copying and pasting strings directly from this guide, you may copy the tag <CR> if the 
instructions span a line in the guide.

Updated LiveCycle product information

Adobe Systems has posted a Knowledge Center article to communicate any updated LiveCycle product 
information with customers. You can access the article at: 
www.adobe.com/support/products/enterprise/knowledgecenter/c4811.pdf.

The EJB API, including descriptions and 
explanations of its classes and methods.

The API Reference for each product. Most API 
References are installed as JavaDocs with each 
product. However, some API references are provided 
as PDF documents with the product.

The syntax for the Document Description XML 
(DDX) grammar and related XML grammars 
supported by LiveCycle Assembler

Document Description XML Reference

Setting up and administering Watched Folders Watched Folder Administration Help

Managing access to the Adobe Administrator 
user interface

User Management Administration Help

How to use LiveCycle Workflow Designer Creating Workflows or LiveCycle Workflow Designer Help

Using the LiveCycle Workflow SDK to create 
Quick Process Action Components (QPACs) 
that invoke methods in the LiveCycle product 
EJB APIs

The QPAC guides, available with the LiveCycle 
Workflow SDK. For example Using LiveCycle Assembler 
QPACs or Using LiveCycle Forms QPACs.

Other services and products that integrate 
with LiveCycle products

www.adobe.com 

Patch updates, technical notes, and additional 
information on this product version

www.adobe.com/support/products/enterprise
/index.html

For information about See

www.adobe.com
http://www.adobe.com/support/products/enterprise/index.html
http://www.adobe.com/support/products/enterprise/knowledgecenter/c4811.pdf
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1 Before You Install

This chapter describes how to prepare your system for installing LiveCycle products:

● “About the installation, configuration, and deployment process” on page 11

● “Methods for installing, configuring, and deploying LiveCycle products” on page 12

● “Installing and deploying multiple LiveCycle products” on page 12

● “System requirements” on page 13

● “Installation, configuration, and deployment checklists” on page 16

● “Updated LiveCycle product information” on page 18

Before you begin installing LiveCycle products on your application server, visit the Adobe LiveCycle 
product download page at the following location to make certain you have the latest version of the 
software:

www.adobe.com/support/products/enterprise/support_downloads.html

About the installation, configuration, and deployment process
Installing, configuring, and deploying LiveCycle products involves the following processes: 

Installing: Installing the products places all of the required files onto your computer, within one 
installation directory structure. You install the products by running the installation program. The 
default installation directory is C:\Adobe\LiveCycle (Windows) or /opt/adobe/livecycle (Linux or UNIX); 
however, you can install the files to a different directory. In this guide, the default installation directory 
is referred to as [LiveCycle root]. In order for multiple LiveCycle products to work with one another, you 
must install all of the products in the same [LiveCycle root] location. This enables you to assemble the 
multiple LiveCycle products into one EAR file. (See “Installing LiveCycle Products” on page 19.)

Configuring and assembling: Configuring the products modifies a variety of settings that determine 
how the products work. Assembling the products packages all of the installed components that the 
products need into a deployable EAR file, according to your configuration instructions. You configure 
and assemble the products for deployment by running Configuration Manager. (See “Configuring 
LiveCycle Products for Deployment” on page 62.) You can configure and assemble multiple LiveCycle 
products at the same time. 

Deploying: Deploying the products involves deploying the assembled EAR file and a few other 
configured files to the WebLogic application server on which you plan to run your LiveCycle solution. If 
you have configured and assembled multiple products, most of the deployable components for the 
multiple products are packaged within the single deployable LiveCycle.ear file. 

Initializing the LiveCycle database: Initializing the LiveCycle database creates tables for use with 
Adobe User Management and certain LiveCycle products. Deploying any LiveCycle product that 
connects to the LiveCycle database requires you to initialize the LiveCycle database after the 
deployment process. (See “Initializing the Database” on page 79.)

http://www.adobe.com/support/products/enterprise/support_downloads.html
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Methods for installing, configuring, and deploying LiveCycle 
products

You can use one of the following methods for installing, configuring, and deploying LiveCycle products as 
well as initializing the database: 

Automatic: The automatic method lets you install the files, and then run Configuration Manager to 
automatically perform the following tasks:

● Configure and assemble LiveCycle products for deployment

● Configure your application server settings for LiveCycle products

● Automatically deploy LiveCycle products to your application server

● Initialize database schemas for deployed LiveCycle products

● Verify the deployed LiveCycle products

However, you must manually install your application server before running Configuration Manager.

Manual: The manual method lets you install the files, and then run Configuration Manager to 
configure the application server, the EAR file and other components, and deploy the EAR file. You can 
also choose to configure your application server and deploy your EAR file manually. However, you must 
manually install and, once configured, start your application server as well as create and configure the 
database before running Configuration Manager and deploying to the application server. You must 
also run Configuration Manager a second time (after deployment) to initialize the database. (See 
“Manual installation and deployment checklist” on page 17.) 

Installing and deploying multiple LiveCycle products 

To deploy more than one of the LiveCycle products discussed in this guide so that they interoperate, you 
need to install the products in the same location, assemble them in a single EAR file, and then deploy the 
EAR file. 

Upgrading LiveCycle products
For information on upgrading LiveCycle products, refer to “Upgrading LiveCycle Products to Version 7.2 
or 7.2.1” on page 125 in this guide.

About Watched Folder installation
Both LiveCycle Assembler and LiveCycle PDF Generator can use watched folder functionality as a method 
for initiating jobs for processing. However, LiveCycle Assembler and LiveCycle PDF Generator use different 
watched folder technologies. 

LiveCycle Assembler uses a service called Watched Folder, which you install separately and configure with 
LiveCycle Workflow using Configuration Manager. This service is included in the deployable LiveCycle.ear 
file. 
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LiveCycle PDF Generator uses an embedded watched folder functionality, which does not require a 
separate installation. The configuration tasks required for LiveCycle PDF Generator watched folders is 
included in the “LiveCycle PDF Generator post-deployment tasks” on page 59.

All other installation and configuration references to Watched Folder in this guide pertain to the service 
that is used by LiveCycle Workflow and LiveCycle Assembler.

System requirements
This section includes details about the software and hardware that is required for running LiveCycle 
products. 

Supported software

This table provides a summary of the application servers, web browsers, and JDK versions that LiveCycle 
products support. For a complete list, see “Supported Platform and Software Combinations” on page 109.

Required software Supported version

Operating system ● Microsoft Windows Server™ 2003 Enterprise Edition or Standard Edition

● (LiveCycle Workflow Designer) Microsoft Windows XP Service Pack 2 

● Sun Solaris 9

● SUSE™ Linux Enterprise Server 9.0 i386 (32-bit)

● Red Hat® Linux Advanced Server 2.1 or 3.0

Note: LiveCycle PDF Generator Elements and 
LiveCycle PDF Generator Professional are only supported on 
Microsoft Windows Server 2003.

For the latest operating system versions supported by BEA WebLogic, see: 
http://e-docs.bea.com/platform/suppconfigs/configs81/81_over/overview.
html#1146895

Application server ● BEA WebLogic 8.1, Service Pack 5

Note: Your application server must have an active Internet connection to 
access LiveCycle Administrator.

Web browser ● Microsoft Internet Explorer 6.0 for Windows

● Netscape 7.1 or higher for Windows

● Netscape 7.2 or higher for Linux

● Mozilla 1.8 or higher for Windows and Linux

● Safari 1.2.3, Safari 1.3, Safari 2.0 (end-user support for Macintosh only)

● (LiveCycle Forms) Firefox 1.0

Note: LiveCycle PDF Generator only supports Microsoft Internet Explorer 
6.0.

http://e-docs.bea.com/platform/suppconfigs/configs81/81_over/overview.html#1146895
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Platform and software combinations

This table summarizes the software combination and database combination supported for BEA WebLogic 
8.1 SP5. For a complete list of supported software on each operating system, see “Supported Platform and 
Software Combinations” on page 109. 

Note: LiveCycle PDF Generator Elements and LiveCycle PDF Generator Professional only run on the 
Windows Server 2003 Enterprise Edition platform.

JDK ● J2SDK version 1.4.2_08 (embedded in BEA WebLogic 8.1, Service Pack 5)

You must create or set the JAVA_HOME environment variable to point to the 
location where Java™ is installed. Ensure that the Java 2 Standard Edition 
(J2SE) installation \bin directory is in the PATH environment variable. (This is 
not required for LiveCycle PDF Generator and LiveCycle Assembler.)

Database ● Microsoft SQL Server 2000 SP 3

● Oracle 9i

● Oracle 10g

Database driver ● Microsoft SQL Server 2000 - wlbase.jar, wlsqlserver.jar, and wlutil.jar

Note: You must use the database drivers provided with WebLogic rather 
than those supplied by Microsoft. By default these files are 
installed in the [appserver root]/server/lib directory.

● Microsoft SQL Server 2000 for BAM - msbase.jar, mssqlserver.jar, and 
msutil.jar

● Oracle - ojdbc14.jar, version 10.2.0.1

LDAP server ● Sun ONE 5.1, 5.2 

● Microsoft Active Directory 2000 

● Microsoft Active Directory 2003 

● Novell® eDirectory 8.7 

Required software Supported version

Operating system Database

Microsoft Windows Server 2003 Enterprise Edition or 
Standard Edition

Microsoft SQL Server 2000 SP 3

Sun Solaris 9 Oracle 10g

SUSE Linux Enterprise Server 9 Oracle 10g
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Minimum hardware requirements

The table in this section lists the supported operating systems and corresponding hardware. For any 
installation, these settings are recommended as a minimum:

● Disk space for installation: 3 GB per product, except LiveCycle PDF Generator, which requires 3.5 GB

● System temp space during installation: 3 GB

● Memory for running the products: 1 GB per product for each CPU, except LiveCycle PDF Generator, 
which requires 1.5 GB per CPU

Additional requirements for LiveCycle PDF Generator Elements and 
LiveCycle PDF Generator Professional

LiveCycle PDF Generator Elements and LiveCycle PDF Generator Professional must be installed on 
Microsoft Windows Server 2003 with the en_US locale. The Windows user who installs the product must 
have administrative rights, and must be the same user who installed Microsoft Office on that computer. 

Before installing LiveCycle PDF Generator Elements or LiveCycle PDF Generator Professional, you must 
ensure that Adobe Acrobat® Professional or Acrobat Standard is not installed. If Acrobat is installed, you 
must uninstall it and restart the computer. However, Adobe Reader® can be installed.

Before installing LiveCycle PDF Generator Elements or LiveCycle PDF Generator Professional, you must 
also install the software that supports the file formats for which PDF conversion support is required. 
LiveCycle PDF Generator Elements and LiveCycle PDF Generator Professional can be extended to convert 
these additional file types to PDF files using the following applications:

● Microsoft Office 2000, XP, or 2003

● (LiveCycle PDF Generator Professional) Microsoft Office Visio 2003 

● (LiveCycle PDF Generator Professional) Microsoft Project 2003

● (LiveCycle PDF Generator Professional) AutoCAD 2005 

● Corel WordPerfect 12

● Adobe Photoshop® CS2

Before completing an automatic installation of LiveCycle PDF Generator on Windows, ensure that the 
Service Control Manager command line tool, sc.exe, is installed in the Windows environment variable. 
Some Windows servers do not have this software preinstalled. By default, the sc.exe file is installed in the 
\Windows\system32 directory.

LiveCycle PDF Generator Professional and LiveCycle PDF Generator Elements must be installed on the 
same server where it needs to be configured and deployed.

Operating system Minimum hardware requirement

Windows Server 2003 Enterprise Edition or 
Standard Edition

Intel® Pentium® 3 or x86 equivalent, 1GHz processor

Sun Solaris 9 Sun UltraSPARC® IIe, 650 MHz processor

SUSE Linux Enterprise Server 9.0 i386 (32-bit) Pentium 3 or x86 equivalent, 1GHz processor

Red Hat Linux Advanced Server 2.1 or 3.0 Pentium 3 or x86 equivalent, 1GHz processor



Adobe LiveCycle Before You Install
Installing and Configuring LiveCycle for WebLogic  Additional requirements for LiveCycle PDF Generator for PostScript     16

Additional requirements for LiveCycle PDF Generator for PostScript

LiveCycle PDF Generator for PostScript is supported on all of the operating systems listed in “Supported 
software” on page 13.

To install LiveCycle PDF Generator for PostScript on Linux or UNIX, ensure that the bc tool (an arbitrary 
precision calculator language) is installed on the computer. You can download the GNU bc tool from 
www.gnu.org/software/bc/bc.html.

Installation, configuration, and deployment checklists
This section includes checklists that you can use to step through the installation and configuration 
process. A checklist is provided for installing and configuring when using either the automatic method or 
the manual method.

Before starting the installation, ensure that the JAR files are not associated with WinZip or any other 
application other than the Java application launcher.

Automatic installation and deployment checklist

The following table includes the steps required for installing LiveCycle products using the automatic 
method. Your application server must be installed before you perform the installation. 

Perform this type of installation if you are installing the products in a production environment. 

Note: If you are installing multiple LiveCycle products, ensure that they are all installed before running 
Configuration Manager to configure and deploy them.

Task Topic

Ensure that you have the required software 
installed in the target environment.

“System requirements” on page 13

Run the installation program. “Installing LiveCycle Products” on page 19

Create the database to use with 
User Management and configure data source 
information for the application server.

“Preparing Your Environment” on page 26

Run Configuration Manager and select the Typical 
Configuration Wizard. This will configure and 
assemble the products, configure application 
server settings, deploy the products to the 
application server, initialize the LiveCycle database, 
and verify the deployment.

“Configuring LiveCycle Products for 
Deployment” on page 62

Access Administrator and User Management. “Accessing Administrator” on page 53

Configure LDAP access. “Configuring LiveCycle Products to Access 
LDAP” on page 82

http://www.gnu.org/software/bc/bc.html
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Manual installation and deployment checklist

The following table includes the steps required for installing LiveCycle products using the manual method. 
Your application server must be installed before you perform the installation.

Note: If you are installing multiple products, ensure that they are all installed before running 
Configuration Manager to configure and deploy them.

Configure SSL on the application server, if 
required.

“Configuring SSL on WebLogic” on 
page 87

(LiveCycle Workflow) Create the BAM metadata 
database and configure the application server for 
BAM Server.

“Manually Configuring BAM Server for 
WebLogic” on page 90

Check the log file. “Viewing log files” on page 78

Task Topic

Task Topic

Ensure that you have the required software 
installed in the target environment.

“System requirements” on page 13

Run the installation program. “Installing LiveCycle Products” on page 19

Create the database to use with User Management 
and install and prepare the application server.

“Preparing Your Environment” on page 26

Run Configuration Manager and select the Custom 
Configuration Wizard. This will configure and 
assemble the products.

“Configuring LiveCycle Products for 
Deployment” on page 62

Configure WebLogic settings. A variety of settings 
must be configured. 

“Manually Configuring WebLogic” on 
page 66 

Deploy the product deployment files to the 
application server.

“Manually Deploying to WebLogic” on 
page 76 

Run Configuration Manager to initialize the 
database.

“Initializing the Database” on page 79

Access Administrator and User Management. “Accessing Administrator” on page 53

Configure LDAP access. “Configuring LiveCycle Products to Access 
LDAP” on page 82

Configure SSL on the application server, if 
required.

“Configuring SSL on WebLogic” on 
page 87
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Updated LiveCycle product information

Adobe Systems has posted a Knowledge Center article to communicate any updated LiveCycle product 
information with customers. You can access the Knowledge Center article at: 
www.adobe.com/support/products/enterprise/knowledgecenter/c4811.pdf

(LiveCycle Workflow) Create the BAM metadata 
database and configure the application server for 
BAM Server.

“Manually Configuring BAM Server for 
WebLogic” on page 90

Check the log file. “Viewing log files” on page 78

Task Topic

http://www.adobe.com/support/products/enterprise/knowledgecenter/c4811.pdf
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2 Installing LiveCycle Products

This chapter describes how to use the installation program to install LiveCycle products on a Windows, 
Linux, or UNIX operating system.

If you are installing LiveCycle PDF Generator (all versions), see Installing LiveCycle PDF Generator. 

Note: If you are installing multiple LiveCycle products we recommend you install LiveCycle PDF Generator 
first. If you install LiveCycle PDF Generator after installing other LiveCycle products you must 
complete the steps in “To install LiveCycle PDF Generator with previously installed LiveCycle 
products:” on page 20.

If you are installing any of the following LiveCycle products, see “Installing LiveCycle products” on page 21:

● LiveCycle Assembler

● LiveCycle Forms

● LiveCycle Form Manager

● LiveCycle Workflow

If you are installing LiveCycle Print (for use with LiveCycle Forms), see “Installing LiveCycle Print” on page 23. 

Note: You must install LiveCycle Forms prior to installing LiveCycle Print.

If you are installing Watched Folder (for use with LiveCycle Workflow and LiveCycle Assembler), see 
“Installing Watched Folder” on page 24.

Before you install the products, you must ensure that your environment includes the software and 
hardware required to run LiveCycle products. You should also understand the installation options and 
have prepared the environment as required. (See “Before You Install” on page 11.)

If you are installing to a location where a LiveCycle product is already installed, install the new product, run 
Configuration Manager to reassemble the products, undeploy the deployed product from the application 
server, and then redeploy the files to the application server.

Installing LiveCycle PDF Generator
The procedure in this section applies to LiveCycle PDF Generator Professional, 
LiveCycle PDF Generator Elements, and LiveCycle PDF Generator for PostScript.

When you run the installation program, you need the following information: 

● The serial number for the product you are installing.

● The type of installation and configuration you are performing. (See “Methods for installing, 
configuring, and deploying LiveCycle products” on page 12.)

Note: To successfully install, you need read and write permissions on the installation directory. The following 
are the default installation directories, although you can specify a different directory as required:

● Windows: C:\Adobe\LiveCycle\

● Linux and UNIX: /opt/adobe/livecycle/
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If you are installing LiveCycle PDF Generator Professional or LiveCycle PDF Generator Elements, ensure 
that Acrobat is not installed on the computer.

When installing on Linux, the installation program uses the logged-in user's home directory as a 
temporary directory for storing files. As a result, messages such as the following may appear in the 
console:

WARNING: could not delete temporary file /home/<username>/ismp001/1556006

When you complete the installation, you must manually delete the temporary files.

Tip: To improve the speed of installation, disable any on-access virus scanning software for the duration of 
the installation.

➤ To install LiveCycle PDF Generator with previously installed LiveCycle products:

If you installed other LiveCycle products previously you must complete these steps before installing 
LiveCycle PDF Generator.

1. From the Windows services panel, select WebLogic for Adobe LiveCycle.

2. Stop the service if it is running.

3. Right-click the service and open the properties.

4. Select the Log On tab.

5. Select This account. 

6. Enter the user name and password used when installing the Microsoft Office and Adobe Acrobat 
applications

7. Start the WebLogic for Adobe LiveCycle service.

➤ To install LiveCycle PDF Generator for manual deployment:

1. At the root level of the installation media, start the installation program: 

● (Windows) Double-click the .exe file.

● (Linux, UNIX) From a command prompt, type: file_name.bin

Note: You may have to change the permissions on the install program under Linux or UNIX. To do so, 
type: chmod +x filename.bin 

2. If prompted, select a language for the installation program and click OK.

3. On the Welcome screen, click Next.

4. Type the serial number in the text box and click Next.

5. (LiveCycle PDF Generator Professional, LiveCycle PDF Generator Elements) On the Adobe 
LiveCycle PDF Generator 7.2 preinstallation requirements screen, review the preinstallation 
requirements and click Next. 

6. If you are prompted to disable on-access virus scanning software, click Next. It is recommended that 
you disable any virus scanning software during the installation process to improve the speed of the 
installation.
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7. Read the Product License Agreement, select I accept the terms of the license agreement, and then 
click Next.

8. Accept the default directory as listed or click Browse and navigate to the directory where you want to 
install the product, and then click Next. 

Note: If you type in the name of a directory that does not exist, it will be created for you.

9. If prompted, select the application server you are deploying the product to and click Next.

10. (LiveCycle PDF Generator Professional, LiveCycle PDF Generator Elements) On the Corel WordPerfect 
screen, browse to the Corel WordPerfect executable file (if installed) and click Next or, if Corel 
WordPerfect is not installed, click Next. 

11. (LiveCycle PDF Generator Professional, LiveCycle PDF Generator Elements) On the Adobe Photoshop 
screen, browse to the Adobe Photoshop executable file (if installed) and click Next or, if Photoshop is 
not installed, click Next. 

12. Review the installation details, and then click Install. The installation program displays the progress of 
the installation. A summary screen appears when the product installation is completed.

13. Ensure that the Start Configuration Manager option is not selected, and then click Finish.

Caution: Do not run Configuration Manager until you have installed all of the products you require and 
have prepared your environment. (See “Preparing Your Environment” on page 26.) After you 
have completed installing all of the products and preparing your environment, you only need to 
run Configuration Manager once to configure and assemble the deployable components. If you 
add another LiveCycle product later, you can run Configuration Manager again to configure, 
assemble and deploy the product modules. (See “Configuring LiveCycle Products for 
Deployment” on page 62.)

Installing LiveCycle products
This section applies only to LiveCycle Assembler, LiveCycle Forms, LiveCycle Form Manager, and 
LiveCycle WorkFlow.

When you run an installation program, you need the following information:

● The serial number for the product you are installing.

● The type of installation and configuration you are performing. (See “Methods for installing, 
configuring, and deploying LiveCycle products” on page 12.)

Note: To successfully install, you need read and write permissions on the installation directory. The 
following are the default installation directories, although you can specify a different directory as 
required:

● Windows: C:\Adobe\LiveCycle\

● Linux and UNIX®: /opt/adobe/livecycle/

Note: If you select Japanese when installing LiveCycle Forms on a Japanese localized computer, the 
character set is not updated. You can change this setting post-deployment by using Administrator 
to access the Internationalization settings. This ensures that Japanese characters render properly. 
(See “Accessing Administrator” on page 53.)
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When installing on Linux, the installation program uses the logged-in user's home directory as a 
temporary directory for storing files. As a result, messages such as the following may appear in the 
console:

WARNING: could not delete temporary file /home/<username>/ismp001/1556006

When you complete the installation, you must manually delete the temporary files.

Caution: Ensure that the temporary directory for your operating system that you are using has a 
minimum of 3 GB of free space available for the installation program:

● (Windows) TMP or TEMP path as set in the Environment Variables

● (Linux) Logged-in user’s home directory

● (Solaris) /var/tmp

➤ To install LiveCycle products for manual deployment:

1. Navigate to the root directory of the installation media. For Workflow navigate to the 
AdobeLiveCycleWorkflow7.2 directory. 

2. Start the installation program: 

● (Windows) Double-click the .exe file.

● (Linux, UNIX) From a command prompt, type: file_name.bin

Caution: When you are installing the product on a Linux or UNIX operating system, you must be logged in 
as the root user to successfully install the product to the default location, /opt/adobe/livecycle/. 
If you are logged in as a non-root user, you must change the installation directory to one for 
which you have permissions (for example, $HOME/adobe/livecycle).

3. If prompted, select a language for the installation program and click OK.

4. On the Welcome screen, click Next.

5. On the Read Before Install screen, if you are upgrading from a previous version, ensure that you have 
complied with the upgrade instructions, and then click Next. If you are not upgrading, click Next.

6. Type the serial number in the text box and click Next.

7. If you are prompted to disable on-access virus scanning, click Next. It is recommended that you disable 
any virus scanning software during the installation process to improve the speed of the installation.

8. Read the Product License Agreement, select I accept the terms of the license agreement, and then 
click Next.

Note: Depending on the product you are installing, the next two steps may appear in reverse order.

9. Select the application server you are deploying the product to and click Next. 

10. Accept the default directory as listed or click Browse and navigate to the directory where you want to 
install the product, and then click Next. 

Note: If you type in the name of a directory that does not exist, it will be created for you. 

Caution: When you install the product, you can specify a different installation location. If you are installing 
on Linux, or UNIX, the directory you specify should not contain any spaces; otherwise, the 
installation program does not install the product. 
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11. Review the installation details, and then click Install. The installation program displays the progress of 
the installation. A summary screen appears when the product installation is completed.

12. Ensure that the Start Configuration Manager option is not selected, and then click Finish.

Caution: Do not run Configuration Manager until you have installed all of the products you require and 
have prepared your environment. (See “Preparing Your Environment” on page 26.) After you 
have completed installing all of the products and preparing your environment, you only need to 
run Configuration Manager once to configure and assemble the deployable components. If you 
add another LiveCycle product later, you can run Configuration Manager again to configure, 
assemble and deploy the product modules. (See “Configuring LiveCycle Products for 
Deployment” on page 62.)

Note: If you installed LiveCycle Workflow, you can now install Watched Folder. (See “Installing Watched 
Folder” on page 24.)

Note: If you installed LiveCycle Forms, you can now install LiveCycle Print. (See “Installing LiveCycle Print” 
on page 23.)

Installing LiveCycle Print
Before installing LiveCycle Print you must first install LiveCycle Forms. (See “Installing LiveCycle Products” 
on page 19.)

➤ To install LiveCycle Print:

1. At the root level of the installation media, start the installation program: 

● (Windows) Double-click the adobe_livecycle_print_7_2.exe file.

● (Linux, UNIX) From a command prompt, type: adobe_livecycle_print_7_2.bin

Note: You may have to change the permissions on the install program under Linux or UNIX. To do so, 
type: chmod +x filename.bin 

2. If prompted, select a language for the install program and click OK.

3. On the Welcome screen, click Next.

4. On the Read Before Install screen, if you are upgrading from a previous version, ensure that you have 
complied with the upgrade instructions, and then click Next. If you are not upgrading, click Next.

5. Type the serial number in the text box and click Next.

6. Read the Product License Agreement, select I accept the terms of the license agreement, and then 
click Next.

7. Accept the default directory as listed or click Browse and navigate to the [LiveCycle root] directory 
where you installed LiveCycle Forms.

Note: You must install LiveCycle Print in the same [LiveCycle root] directory as LiveCycle Forms.

8. Review the installation details, and then click Install. The installation program displays the progress of 
the installation. A summary screen appears when the product installation is completed.
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9. Ensure that the Start Configuration Manager option is not selected, and then click Finish.

Caution: Do not run Configuration Manager until you have installed all of the products you require and 
have prepared your environment. (See “Preparing Your Environment” on page 26.) After you 
have completed installing all of the products and preparing your environment, you only need to 
run Configuration Manager once to configure and assemble the deployable components. If you 
add another LiveCycle product later, you can run Configuration Manager again to configure, 
assemble and deploy the product modules. (See “Configuring LiveCycle Products for 
Deployment” on page 62.)

Note: In order to test your installation with the LiveCycle Print sample applications, you need to deploy 
the adobe-printSubmitter.ear file. (See “Deploying and running the PrintIVS web application” on 
page 56.)

Installing Watched Folder
Installing Watched Folder places the files required for configuration and deployment onto your computer. 
Ensure that you have already installed LiveCycle Workflow and LiveCycle Assembler before performing this 
procedure.

➤ To install Watched Folder:

1. From the Watched Folder directory on the Adobe LiveCycle Assembler installation DVD, start the 
installation program: 

● (Windows) Double-click the setupwin32.exe file.

● (Linux) From a command prompt, type: setupLinux.bin 

● (Solaris) From a command prompt, type: setupSolaris.bin 

2. If prompted, select a language for the installation and click OK.

3. Click Next on the Welcome screen.

4. If you want to increase the speed of the installation, disable any virus scanning software, and then click 
Next. 

5. Read the Product License Agreement, select I accept the terms of the license agreement, and then 
click Next.

6. Accept the default location, or click Browse and navigate to the location where you want to install 
Watched Folder, and then click Next. 

7. Review the installation details, and then click Install. A summary screen appears when the product 
installation is completed.

8. Ensure that the Start Configuration Manager option is not selected, and then click Finish.

Caution: Do not run Configuration Manager until you have installed all of the products you require and 
have prepared your environment. (See “Preparing Your Environment” on page 26.) After you 
have completed installing all of the products and preparing your environment, you only need to 
run Configuration Manager once to configure and assemble the deployable components. If you 
add another LiveCycle product later, you can run Configuration Manager again to configure, 
assemble and deploy the product modules. (See “Configuring LiveCycle Products for 
Deployment” on page 62.)
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Viewing the error log
If any errors occur during the installation, the installation program creates a log file called log.txt, which 
contains the error messages. The log file is located in the [LiveCycle root] directory.

Next steps
You must now prepare your database and application server for hosting LiveCycle products. (See 
“Preparing Your Environment” on page 26.)
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3 Preparing Your Environment

This chapter describes how to prepare your environment for hosting LiveCycle products. You must 
perform the tasks provided in this chapter before you configure LiveCycle products: 

● “Creating the database” on page 26

● “Preparing the application server” on page 28.

Creating the database
This section describes how to set up the database that stores LiveCycle configuration information and 
run-time data. The procedures described in this section apply to all LiveCycle products that use User 
Management. If you previously configured the database for deploying other LiveCycle products, you do 
not need to perform the tasks again. 

Note: User Management is an optional feature for LiveCycle Forms.

If this is the first installation of a LiveCycle product, you must create an empty database. All of the tables 
required to support LiveCycle products will be created by Configuration Manager when you initialize the 
database. (See “Initializing the Database” on page 79.)

Before creating the database, you must ensure that you have read the preinstallation requirements and 
have the required software installed. (See “Before You Install” on page 11.)

For information on creating the BAM metadata database for LiveCycle Workflow Server, see “Creating the 
BAM metadata database” on page 90.

Creating an Oracle database

If you prefer not to use the default database that was created when you installed Oracle 9i or 10g, create a 
new database using the Database Configuration Assistant tool. 

If any of the LDAP directories that the new database will synchronize with for authenticating LiveCycle 
users includes records with UTF-8 characters, you must create a database that uses the UTF-8 character set.

You must also create a new user on the database and assign it the DBA, CONNECT and RESOURCE roles, as 
well as the ACCESS_ANY_WORKSPACE, UNLIMITED TABLESPACE, and CREATE VIEW system privileges. For 
deployments on Linux and UNIX, the user name must not exceed 8 characters and, on Windows, it must 
not exceed 12 characters.

The user name and password of the new user you create on the database is used again when you create 
the data source.

For information about using Oracle 9i or 10g, see the Oracle 9i or 10g user documentation.
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Creating a SQL Server database

You can create a SQL Server database that LiveCycle products will use to store run-time and configuration 
data. For information on creating a SQL Server database, refer to the SQL Server documentation. LiveCycle 
products support SQL Server 2000 SP3a. 

Create a SQL Server database and create a user with DB_OWNER privileges that can be used when 
configuring the data source on the application server. For information about creating the database and 
user, see the SQL Server documentation.

The SQL Server database can be configured with the Windows or SQL Server authentication types.

If the WebLogic host computer belongs to a Windows workgroup, the SQL Server host computer must 
belong to a workgroup and not a domain. 

You must also install JTA stored procedures on SQL Server. (See Installing JTA stored procedures.) If SQL 
Server runs on Windows 2003, you need to enable XA transactions at the operating system level. (See 
“Enabling XA transactions for Windows Server 2003” on page 28.)

Installing JTA stored procedures

The database driver that LiveCycle products deployed to WebLogic use to connect to the SQL Server 
database require stored procedures for JTA on the SQL Server computer. You need to obtain and install 
updated SQL Server install files for JTA stored procedures. 

➤ To install JTA stored procedures:

1. Obtain and install SQL Server 2000 Driver for JDBC SP3 from the www.microsoft.com/sql/downloads 
website.

2. Copy the sqljdbc.dll file from the Microsoft SQL Server 2000 Driver for JDBC\SQLServer JTA directory to 
the [install directory]\Microsoft SQL Server\MSSQL\Binn directory, where [install directory] is the 
location where SQL Server is installed. 

3. Log into SQL Server 2000 Query Analyzer using a user account that is a member of the sysadmin group. 
The default member is sa. 

4. In the menu of available databases, ensure that master is selected. 

5. Open the instjdbc.sql file from the Microsoft SQL Server 2000 Driver for JDBC\SQLServer JTA directory, 
and then execute it. 

If you are running this query for the first time, you will see several messages that indicate “xp_xxx” 
cannot be dropped. These messages are warnings and do not indicate that the installation failed. The 
last message should read “instxa.sql completed successfully”. 

The instjdbc.sql script generates many messages. In general, these messages can be ignored, however, 
the system administrator should scan the output for any messages that may indicate an execution 
error. The last message should indicate that instjdbc.sql ran successfully. The script fails when there is 
insufficient space available in the master database to store the JDBC XA procedures or to log changes 
to existing procedures. 

http://www.microsoft.com/sql/downloads
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6. Ensure that MS DTC is started for SQL Server 2000: 

● Start SQL Server Service Manager. 

● In the Services list, select Distributed Transaction Coordinator. 

● Click Start/Continue. 

● If you want MS DTC to start automatically when the computer starts, select Auto-start service 
when OS starts. 

Enabling XA transactions for Windows Server 2003

If you are running SQL Server 2000 on Windows Server 2003 (Standard Edition or Enterprise Edition), XA 
transactions must be enabled at the operating system level. Before you perform the tasks in this section, 
you must verify whether XA transactions are already enabled for Windows Server 2003.

To enable XA transactions on the operating system, you need to perform the following tasks:

● Enable XA transactions for the MS DTC 

● Create a registry entry for the sqljdbc.dll database drivers file that you are using 

➤ To enable XA transactions for MS DTC:

1. Select Start > Programs > Administrative Tools > Component Services. 

2. Select Component Services > Computers. 

3. Right-click the computer name that you want to support for XA transactions and click Properties. 

4. Click the MSDTC tab and click Security Configuration. 

5. Under Security Settings, select Enable XA Transactions. 

6. Click OK, and then click OK again. 

➤ To create registry entries for the driver file:

1. Use a registry editor (such as regedit) to navigate to the registry key named 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\XADLL. 

2. Create a new String Value registry named value that has the following properties: 

● Name: sqljdbc.dll 

● Type: String (REG_SZ) 

● Value: The full path name (including the file name) of the DLL file:
[install directory]\Microsoft SQL Server\MSSQL\Binn\sqljdbc.dll 

3. Restart the computer so that the changes to the registry take effect.

Preparing the application server
You must install the application server that you will use to run LiveCycle products. You also need to 
perform some preliminary configuration on the application server.
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➤ Installing WebLogic Server

You must install BEA WebLogic Server 8.1, Service Pack 5 for running LiveCycle products. You can obtain 
the service pack at this location:

http://commerce.bea.com/siteinfo/previous_releases.jsp 

Creating the WebLogic Server domain

To develop and deploy applications on WebLogic Server, you must create a WebLogic Server domain. A 
domain is the basic administrative unit for WebLogic Server. WebLogic Server domains consist of one or 
more Managed Servers that can share related resources and services.

You must deploy LiveCycle applications on Managed Servers in a domain; the Administration Server 
should be reserved for management tasks. For information about creating a server domain and about 
Administration and Managed Servers, see the BEA WebLogic product documentation.

Note: For properties that are not provided, accept the existing settings. For more information about these 
screens, see WebLogic Help.

➤ To create a WebLogic domain:

1. From a command prompt, start the WebLogic Configuration Wizard by navigating to the 
[appserver root]/common/bin directory and entering the following command:

● (Windows) .\config.cmd 

● (Linux, UNIX) ./config.sh 

2. On the Create or Extend a Configuration screen, select Create a new WebLogic configuration and 
click Next. 

3. On the Select a Configuration Template screen, select Basic WebLogic Server Domain and click Next.

4. On the Choose Express or Custom Configuration screen, select Express and click Next.

5. Type your user name and password, confirm the password by retyping it, and then click Next. 

6. In the left panel, select Production Mode. 

7. In the right panel, select BEA Supplied SDKs and Sun SDK 1.4.2_08@BEA_HOME/jdk142_08, and 
then click Next.

8. On the Create WebLogic Configuration screen, from the Summary View list, select Deployment and 
click Create.

9. On the Creating Configuration screen, when the configuration creation is 100% complete, do the 
following:

● (Windows) Select Start Admin Server and click Done.

● (Linux, UNIX) Click Done. Start the server by navigating, from a command prompt, to the 
[appserverdomain] and entering ./startWebLogic.sh

10. When prompted, enter the user name and password you entered in step 5.

http://commerce.bea.com/siteinfo/previous_releases.jsp
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➤ To create a new WebLogic Managed Server: 

1. If WebLogic Administration Server is not already running, from a command prompt, navigate to the 
BEA_HOME\user_projects\domains\[domainname] directory, and enter the following command:

● (Windows) startWebLogic.cmd 

● (Linux, UNIX) ./startWebLogic.sh 

2. Start WebLogic Administration Console by typing http://[host name]:7001/console in the 
URL line of a web browser. 

3. Type the user name and password that was used in creating this WebLogic configuration, and then 
click Sign In.

4. Right-click Servers and select Configure a New Server.

5. Name the new server (for example, server1) and, in the Listen Port box, type a different value, such as 
8001. (Port 7001 is already being used by the Administration Server.) 

6. Click Create.

7. From a command prompt, stop WebLogic by navigating to the 
BEA_HOME\user_projects\domains\[domainname] directory, and entering the following command:

● (Windows) stopWebLogic.cmd adminusername 

● (Linux, UNIX) ./stopWebLogic.sh adminusername 

8. When prompted, type the administrator password and press Enter.

9. Start WebLogic Administration Server by entering the following command:

● (Windows) startWebLogic.cmd

● (Linux, UNIX) ./startWebLogic.sh

10. Start Node Manager by navigating to the [appserver root]/server/bin directory and entering the 
following command:

● (Windows) startNodeManager.cmd

● (Linux, UNIX) ./startNodeManager.sh 

11. Start WebLogic Administration Console by typing http://[host name]:7001/console in the 
URL line of a web browser. 

12. In the navigation tree, click Machines. 

13. Click Configure a New Machine.

14. Type a name for the new machine, and then click Create.

15. Select Servers, and then select the WebLogic Managed Server you just created.

16. Click Apply.

17. Start the WebLogic Managed Server by selecting mydomain > Control tab and clicking Start all 
Managed Servers.
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Configuring anonymous admin lookup

You must enable anonymous admin lookup on the application server.

➤ To enable anonymous admin lookup:

1. Start WebLogic Server Administration Console by typing http://[host name]:7001/console in 
the URL line of a web browser. 

2. In the navigation tree, click Security. 

3. On the General tab of the Configuration tab, select Anonymous Admin Lookup Enabled and click 
Apply.

4. Restart the Managed Server.

Configuring the WebLogic transaction time-out

You must increase the WebLogic transaction time-out value. The default value of 30 seconds is insufficient 
for running your applications. This time-out value must be higher than the value configured at the Job 
Source (through Administrator). The recommended value is 84600 seconds.

➤ To set the WebLogic transaction time-out:

1. Start the WebLogic Server Administration Console by typing 
http://[host name]:[port]/console in the URL line of a web browser.

2. Type the user name and password that you created for the WebLogic domain, and then click Sign In.

3. In the navigation tree, select [domain name], click Configuration, and then click the JTA tab.

4. In the Timeout Seconds box, type 84600, and then click Apply.

5. In the navigation tree, select [domain name] > Servers > [servername] and click the Tuning tab.

6. In the Stuck Thread Max Time box, type 1200 and click Apply.

7. Restart WebLogic.

Creating an endorsed directory

You must create an endorsed directory and copy Java library files to the directory. This directory is required 
to ensure that the Java run-time environment (JRE) that runs WebLogic uses the classes from the libraries 
in the endorsed directory instead of the same-named classes that are identified in the system classpath.

➤ To create an endorsed directory:

1. Navigate to the BEA_HOME/jdk142_08/jre/lib directory and create a directory called endorsed. 

2. Copy the following files from the [LiveCycle root]/components/um/endorsed directory to the endorsed 
directory you just created:

● dom3-xercesImpl-2.4.0.jar

● dom3-xml-apis-2.4.0.jar

● xalan-2.4.1.jar
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Copying LiveCycle JAR files

You need to copy one or more LiveCycle JAR files from the LiveCycle installation directories to the 
WebLogic directories.

➤ To copy LiveCycle JAR files:

1. In the [appserverdomain] directory, create a directory called lib.

2. Copy the DocumentServicesLibrary.jar file from the 
[LiveCycle root]/components/csa/weblogic/lib/adobe directory to the [appserverdomain]/lib directory.

Installing database drivers
You must install database drivers to the installation directories of the application server. Drivers are 
required to enable Configuration Manager and the application server to connect to the LiveCycle 
database. You must install the drivers for the type of database that you use for the LiveCycle database.

➤ To install the Oracle driver:

1. From a browser, navigate to 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_10201.html

2. Under Oracle Database 10g Release 2 (10.2.0.1.0) JDBC Drivers, download the ojdbc14.jar file.

3. Replace the ojdbc14.jar file in the [appserver root]/server/lib directory with release 2 driver you just 
downloaded. 

➤ To install the SQL Server driver:

1. Start the WebLogic Server Administration Console by typing:

http://[host name]:[port]/console 

in the URL line of a web browser.

2. Type the user name and password that was used in creating this WebLogic configuration, and then 
click Sign In.

3. In the navigation tree, select [domain name], click Servers, and then click the server you created.

4. Click the Remote Start tab on the Configuration tab.

5. Add the following text to the Class Path box:

● (Windows)

%WL_HOME%\server\lib\wlbase.jar;%WL_HOME%\server\lib\wlsqlserver.jar;
%WL_HOME%\server\lib\wlutil.jar;

● (Linux and UNIX)

${WL_HOME}/server/lib/wlbase.jar:${WL_HOME}/server/lib/wlsqlserver.jar
:${WL_HOME}/server/lib/wlutil.jar:

Note: Use the “;” separator (Windows) or the “:” separator (Linux and UNIX).

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_10201.html
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Registering required JAR files
You must configure WebLogic to use the JAR files that you copied to the WebLogic computer. (See 
“Creating an endorsed directory” on page 31 and “Copying LiveCycle JAR files” on page 32.) The server 
referred to in this section is the Managed Server.

➤ To modify the startManagedWebLogic command:

1. Start the WebLogic Server Administration Console by typing:

http://[host name]:[port]/console 

in the URL line of a web browser.

2. Type the user name and password that was used in creating this WebLogic configuration, and then 
click Sign In.

3. In the navigation tree, select [domain name], click Servers, and then click the server you created.

4. Click the Remote Start tab on the Configuration tab.

5. In the Java Home box, type the path to the jdk142_08 directory.

6. In the BEA Home box, type the path to the WebLogic installation directory.

7. In the Class Path box, type the paths to the DocumentServicesLibrary.jar file and the database drivers. 
For example:

[appserverdomain]/lib/DocumentServicesLibrary.jar;
[appserver root]/server/lib/<database driver>;%CLASSPATH%;

Note: If you receive errors with %CLASSPATH%, type the paths to the jar files. For example: 
BEA_HOME/jdk142_08/lib/tools.jar;[appserver root]/server/lib/weblogic
_sp.jar;[appserver root]/server/lib/weblogic.jar; 

Note: Use the “;” separator (Windows) or the “:” separator (Linux and UNIX).

8. In the Arguments box, type the following text:

-Dweblogic.Name=[servername] -Dweblogic.ProductionModeEnabled=true
-Djava.endorsed.dirs=BEA_HOME/jdk142_08/jre/lib/endorsed
-Dadobeidp.RootDirectory=BEA_HOME/user_projects/domains
/[domainname]
-Djava.security.policy=[appserver_root]/server/lib/weblogic.policy
-Xms512m -Xmx1024m

(LiveCycle Form Manager) Add the following text in the argument just before “-Xms512”:

-Dorg.apache.lucene.writeLockTimeout=10000

(LiveCycle Workflow) Add the following text in the argument just before “-Xms512”:

-Dadobe.workflow.scheduler.java.naming.factory.initial=weblogic.jndi.
WLInitialContextFactory
-Dadobe.workflow.scheduler.java.naming.provider.
url=t3://[host name]:[port] 

(Solaris, LiveCycle Form Manager) Also add the following argument after “-Xmx1024m”: 

-XX:NewRatio=8.

Caution: These commands must all be on one line with one space between them and no other 
separators. If you are copying and pasting text directly from this document, remove any hard 
returns or extraneous text that may get copied along with the required code.
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9. In the User Name box, type the WebLogic user name.

10. In the Password and Confirm Password boxes, type the WebLogic user password.

11. Click Apply.

Note: Ensure that the yellow /!\ icon flashes after you click Apply. This indicates that the changes have 
been applied. If the icon does not flash, click Apply again.

➤ To register LiveCycle JAR files:

1. In the WebLogic Administration Console navigation tree, select [domain name], click Servers, and 
then click the server you created.

2. Click the Remote Start tab on the Configuration tab.

3. Add the following text to the Class Path box:

[appserverdomain]/lib/DocumentServicesLibrary.jar

4. Click Apply.

5. Restart WebLogic.

Next step
You must now configure the product for deployment using the instructions for either an automatic 
configuration or a manual configuration. (See “Automatically Configuring LiveCycle Products” on page 36 
or “Configuring LiveCycle Products for Deployment” on page 62.) 
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Part I: Automatic Configuration and Deployment

This section of the guide describes how to automatically configure and deploy your LiveCycle products.

For information on the manual configuration and deployment of the products, see “Manual Configuration, 
and Deployment” on page 61.
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4 Automatically Configuring LiveCycle Products

This chapter describes how to use Configuration Manager to automatically configure and assemble 
LiveCycle products and deploy the products to the application server, or to manually configure and 
assemble LiveCycle products and automatically perform the remaining tasks of configuring the 
application server and deploying the LiveCycle products.

This chapter assumes that you have prepared your environment for hosting LiveCycle products and 
installed the products. If you have not done this, see “Preparing Your Environment” on page 26 and 
“Installing LiveCycle Products” on page 19.

About Configuration Manager
Configuration Manager is a wizard-like tool that you can use to automatically perform all of the tasks 
required for getting LiveCycle products running on the application server.

Configuration Manager is installed with every LiveCycle product. The instance of Configuration Manager 
installed with a LiveCycle 7.2 product can be used with all other LiveCycle 7.2 products. When you run 
Configuration Manager, you specify the LiveCycle products you are configuring, as well as the type of 
application server that you are leveraging in the solution. 

You can start Configuration Manager from the installation program to configure the products during the 
installation process, or you can start Configuration Manager any time after the installation to configure the 
products. The application server must be started to enable Configuration Manager to perform 
configuration tasks on the application server.

You can configure an application server that is installed on a different computer than the one on which 
you are running Configuration Manager. However, the application server must also be installed on the 
Configuration Manager computer so that Configuration Manager can use the application server library 
files.

Configuration tasks

Configuration Manager provides a wizard-like interface that prompts you for information so that it can 
automatically accomplish the following tasks:

1. Configure and assemble LiveCycle product properties and assemble them in an EAR file for deploying 
to the application server.

2. Configure application server properties so that the application server can run LiveCycle products.

3. Validate that the application server is configured correctly for running LiveCycle products.

4. Deploy LiveCycle products to the application server. 

5. Bootstrap the database so that the database can store the run-time data that deployed LiveCycle 
products generate.

6. Verify that the deployed LiveCycle products are available and operational.
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Optionally, steps 2 (configure application server properties) and 4 (deploy LiveCycle products) can be 
performed manually (without using Configuration Manager). (See “Configuration modes” on page 37.)

Regardless of whether all of the tasks are performed automatically by Configuration Manager or some are 
performed manually, the tasks must be performed in the order in which they are listed.

Configuration modes

Configuration Manager can run in two different modes:

Typical Configuration Wizard: In this mode, Configuration Manager performs all of the tasks required 
to get LiveCycle products running on the application server. When configuring the LiveCycle product 
properties, Configuration Manager uses all of the default values.

Custom Configuration Wizard: In this mode, you can select the tasks that you want Configuration 
Manager to perform automatically. When configuring the LiveCycle product properties, you can use 
the default values or specify custom values.

The Custom Configuration Wizard mode is useful when you want to perform some of the configuration 
steps manually, and some automatically. For example, if you want to configure the application server 
manually and use Configuration Manager to automatically perform the remaining configuration tasks, you 
could follow these steps:

1. Run Configuration Manager in the Custom Configuration Wizard mode and use it to configure and 
assemble LiveCycle products in an EAR file. 

2. Manually configure the application server. 

3. Run Configuration Manager again in the Custom Configuration Wizard mode to validate the 
application server, deploy LiveCycle products, initialize the database, and verify that the products are 
available and operational.

Running Configuration Manager more than once

Configuration Manager stores the values that you enter for configuration properties and lets you skip 
configuration properties. This is useful when you run Configuration Manager more than once.

Stored property values

Configuration Manager stores all of the values (except for passwords) that you enter in its configuration 
screens to prevent you from having to retype the values. When you subsequently run Configuration 
Manager, you can use the previously-entered values as defaults for the configuration properties. 

Do Not Apply option

Some of the Configuration Manager screens have a Do Not Apply option. When you select the Do Not 
Apply option, Configuration Manager does not set the properties that are associated with the screen, and 
preserves the current configuration.

You should only select the Do Not Apply option if you have previously set the properties associated with 
the screen. If some of the properties are not set, subsequent Configuration Manager tasks can fail. 
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For example, when configuring the application server, a Configuration Manager screen collects 
information about the LiveCycle database so that Configuration Manager can configure the data source on 
the application server. Later, when performing the Bootstrap Database task, Configuration Manager uses 
the data source to connect to the database and initialize the database schemas. If the database screen is 
always skipped, the data source is not created and the Bootstrap Database task fails. 

Caution: Selecting Do Not Apply is not the same as not specifying any property values. Selecting Do Not 
Apply does not configure any values and the previous values are retained. 

Performing a typical configuration
In a typical configuration, Configuration Manager automatically performs all of the tasks required to get 
LiveCycle products running on the application server.

If you want Configuration Manager to automatically perform only a subset of the configuration tasks, see 
“Performing a custom configuration” on page 41.

Note: If you have previously performed a typical configuration and deployed LiveCycle.ear, you must first 
uninstall the product EAR files. (See “Uninstalling EAR files” on page 52.)

If you are configuring a remote application server, ensure that the application server is installed on the 
Configuration Manager computer so that Configuration Manager can use the application server library 
files.

Caution: Some of the screens in this procedure have a Do Not Apply option. Selecting Do Not Apply is not 
the same as not specifying any property values. Selecting Do Not Apply does not configure any 
values and the previous values are retained.

Tip: Configuration Manager verifies the values specified on each screen when you click Next. If it cannot 
validate a value, the property on the screen turns red and you cannot proceed until you enter a valid 
value.

Before performing a typical configuration, you must have already created the LiveCycle database and 
prepared the application server. (See “Preparing Your Environment” on page 26.) 

➤ To perform a typical configuration:

1. Start the application server.

2. Start Configuration Manager by navigating to the [LiveCycle root]/configurationManager directory and 
entering the following command:

● (Windows) ConfigurationManager.exe

● (Linux, UNIX) ConfigurationManager.bin

3. On the Welcome screen, click Next.

4. Select Typical Configuration Wizard and click Next.

5. If prompted, on the Configuration Preferences screen, select either Use Previously Entered Values or 
Revert to Default Values, and then click Next. The Configuration Preferences screen only appears if 
you have previously run Configuration Manager.
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6. On the Product Selection screen, select Foundation, select the products that you want to configure 
and deploy, and then click Next.

7. (LiveCycle Forms) On the Adobe User Management Selection screen, select either LiveCycle Forms 
with User Management and Administration or LiveCycle Forms without User Management and 
Administration, and then click Next.

8. On the Configuration and Assemble Products screen, click Next.

9. Review the Application Configuration and Assembly Summary information and click Back to change 
any settings or click Next to continue. When you continue, Configuration Manager configures the 
LiveCycle product properties using the default values and assembles the products into the 
LiveCycle.ear file and, for LiveCycle PDF Generator, the additional pdfg-all.ear or pdfg-ps-all.ear file. 

10. Click Next when the configuration and assembly is complete.

11. On the Java Home Selection screen, type the path or browse to the directory where the JDK is installed, 
and then click Next. For example, the directory is C:\bea\jdk142_08 (Windows) or /opt/bea/jdk142_08 
(Linux and UNIX).

Note: You must use the JDK that is included with the application server.

12. On the Application Server Configuration Details screen, specify values for the following properties, and 
then click Next:

● Deploy Type: Specifies whether you are deploying to a standalone computer or to a cluster. Select 
Standalone.

● Remote Server: Select this option only if the application server is running on a different computer 
than the computer that is running Configuration Manager.

● Hostname: The fully qualified name or IP address of the computer that hosts the application server.

● Admin Port: The port used to provide access to the administration service on the application 
server. The default port is 7001.

● Server Instance Name: The name of the application server that you want to configure. The name of 
the default server instance that is created upon installing the application server is server1.

● Username and Password: (Optional) If the application server requires user credentials to perform 
administration tasks, the user name and password of an application server administration account.

● Local Application Server Root Directory: The root directory of the application server installation 
on the computer that is running Configuration Manager. For example, the directory is 
C:\bea\weblogic81 (Windows) or /opt/bea/weblogic81 (Linux and UNIX).

Caution: The Remote Server property cannot be used to configure LiveCycle PDF Generator Professional 
or LiveCycle PDF Generator Elements because Acrobat cannot be installed remotely. However, 
the property can be used to configure LiveCycle PDF Generator for PostScript.

13. On the Configure Application Server for LiveCycle screen, click Next.

14. On the JVM Settings screen, specify values for the following properties of the JVM that runs the 
application server, and then click Next:

● Do Not Apply: Select this option if you do not want to configure JVM properties at this time. If you 
select this option, you do not need to provide values for the remaining properties on this screen.

● Initial Heap Size: The initial amount of memory allocated for the JVM. Specify 512.
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● Maximum Heap Size: The maximum amount of memory that can be dynamically allocated for the 
JVM. Specify 1024.

● Additional JVM Arguments: Any additional arguments you require.

Note: Initial Heap Size and Maximum Heap Size must not be greater than 2048. For more information 
about setting these values, see “Optimizing inline documents and impact on JVM memory” on 
page 148.

15. (LiveCycle PDF Generator, LiveCycle Form Manager, LiveCycle Workflow) On the JMS settings screen, 
click Next. There are no values that you need to configure on this screen.

16. On the Datasource Creation screen, specify values for the following properties of the LiveCycle 
database so that Configuration Manager can configure the database connection on the application 
server, and then click Next:

● Do Not Apply: Select this option if you do not want to configure the database connection at this 
time. If you select this option, you do not need to provide values for the remaining properties on 
this screen.

● Datasource: The JNDI name of the data source to create on the application server. Select IDP_DS.

● DB Type: The type of database you are using for the LiveCycle database.

● DB Name: The name of the database.

● DB Server Hostname: The name or IP address of the computer that hosts the database server.

● Port: The port used to access the database service.

● DB Username: The name of the user account that you created for LiveCycle products to access the 
LiveCycle database.

● DB Password: The password for the user account specified for DB Username.

● JDBC driver in local application server lib: The name and path of the driver file that the 
application server uses to connect to the database. If the driver consists of more than one file, you 
only need to specify the main file, as specified in the following list:

● (Oracle) [appserver root]/server/lib/ojdbc14.jar

● (SQL Server) [appserver root]/server/lib/wlsqlserver.jar

● JDBC Connection Pool Name: The name to use for the JDBC connection pool that is created for the 
data source. The default value is IDPConnectionPool.

17. On the Database Connection Tester screen, click Test Database Now to verify that Configuration 
Manager can connect to the database and, when the test is successful, click Next.

18. On the Configure Application Server screen, click Apply Settings Now and, when the task is complete, 
click Next.

19. Restart the application server to ensure that the settings are in effect and on the Application 
Server/Cluster Restart screen, click Next.

20. On the Validate Application Server settings screen, click Next.

21. On the Deploy LCM.ear screen, click Execute and, when the deployment is complete, click Next.

22. On the Validate Application Server Settings screen, click Validate Settings Now and, when the task is 
complete, click Next.
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23. On the Deploy LiveCycle screen, click Next.

24. On the Confirm Products to Deploy screen, select the archives that you are deploying and click Next.

25. On the Deploy Products screen, click Deploy Products Now and, when the deployment is complete, 
click Next.

26. On the Application Server URL screen, type the URL that Configuration Manager can use to connect to 
the application server in the Application Server Base URL box, and then click Next. The URL must be 
in the following format:

http://[host name]:[port]

where [host name] is the name or IP address of the computer that hosts the application server, and 
[port] is the HTTP service port that the application server uses (for example, 
http://localhost:8001).

Note: To verify the port number to use for this setting, navigate to Application servers > [server], 
select the Configuration tab, then click Communications > Ports and look for the 
WC_defaulthost value.

27. On the Prepare database for LiveCycle screen, click Next.

28. On the Database Initialization screen, click Initialize Database Now and, when the task is complete, 
click Next.

29. On the Verify the installation screen, click Next.

30. On the Verify Deployed Products screen, click Run Product Tests Now and, when the task is complete, 
click Next.

31. On the Tasks Complete screen, click Finish.

Performing a custom configuration
In a custom configuration, you can select the tasks that you want Configuration Manager to perform 
automatically. If you want Configuration Manager to automatically perform all of the configuration tasks, 
see “Performing a typical configuration” on page 38.

The following procedure explains how to use Configuration Manager to select the tasks that you want to 
perform. After you select the tasks, proceed to the subsequent topics in this chapter for information about 
how to use the screens that appear for completing each task.

Tip: Configuration Manager verifies the values specified on each screen when you click Next. If it cannot 
validate a value, the property on the screen turns red and you cannot proceed until you enter a valid 
value.

➤ To perform a custom configuration:

1. Start the application server. 

2. Start the Configuration Manager by navigating to the [LiveCycle root]/configurationManager directory 
and entering the following command:

● (Windows) ConfigurationManager.exe

● (Linux, UNIX) ConfigurationManager.bin



Adobe LiveCycle Automatically Configuring LiveCycle Products
Installing and Configuring LiveCycle for WebLogic  Configuring and assembling LiveCycle products     42

3. On the Welcome screen, click Next.

4. Select Custom Configuration Wizard and click Next.

5. If prompted, on the Configuration Preferences screen, select either Use Previously Entered Values or 
Revert to Default Values, and then click Next. The Configuration Preferences screen only appears if 
you have previously run Configuration Manager.

6. On the Product Selection screen, select Foundation, select the products that you want to configure 
and deploy, and then click Next.

7. (LiveCycle Forms) On the Adobe User Management Selection screen, select either LiveCycle Forms 
with User Management and Administration or LiveCycle Forms without User Management and 
Administration, and then click Next.

8. On the Task Selection screen, select the tasks that you want Configuration Manager to automatically 
perform, and then click Next.

The screen that appears next depends on the first task that you selected. If you selected more than one 
task, the screens for the next task will appear immediately following the completion of the screens for 
the preceding task. For information on how to complete the Configuration Manager screens for each 
task, see the corresponding section: 

● “Configuring and assembling LiveCycle products” on page 42

● “Changing the application server settings” on page 45

● “Validating application server settings” on page 47

● “Automatically deploying LiveCycle products” on page 48

● “Initializing the database” on page 49

● “Verifying deployed LiveCycle products” on page 50

Configuring and assembling LiveCycle products

The procedure in this section is a continuation of the procedure for performing a custom configuration. 
(See “Performing a custom configuration” on page 41.)

When you select the Configure and Assemble products task for Configuration Manager to perform 
automatically, follow the procedure in this section to complete the Configuration Manager screens that 
appear. 

When Configuration Manager completes the configuration of the product, it places the deployable files 
(LiveCycle.ear and adobe-FontManager.ear, adobe-printSubmitter.ear for LiveCycle Print, and, for 
LiveCycle PDF Generator, pdfg-all.ear or pdfg-ps-all.ear) in the following directory:

● (Windows) [LiveCycle root]\configurationManager\export

● (Linux, UNIX) [LiveCycle root]/configurationManager/export
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➤ To configure and assemble LiveCycle products:

1. On the Configure and Assemble products screen, click Next.

2. (Optional) On the Data Manager Module Configuration screen, if you are using SSL security on your 
application server, select Enable SSL and type the SSL credential password. 

If you have not yet set up your SSL credential, you can type a password here and use it when you create 
an SSL credential. (See “Configuring SSL on WebLogic” on page 87.)

3. Enter a directory to use for Adobe LiveCycle products temp file, and then click Next.

Note: (Linux and UNIX) If you are logged in as a non-root user, specify a directory under your home 
directory.

For more information on the Adobe LiveCycle products temp file, see “Optimizing inline documents 
and impact on JVM memory” on page 148.

4. On the Data Manager Module Configuration continued screen, accept the default values for the 
following properties or specify new values, and then click Next: 

● Local storage sweep interval (in seconds): The amount of time between attempts to delete any 
files that are no longer needed and were used to pass the document data between LiveCycle 
services running on the same computer.

● Global storage sweep interval (in seconds): The amount of time between attempts to delete any 
obsolete files that were used to pass the document data between LiveCycle services running on the 
different computers. Specify this property only when deploying LiveCycle products in a clustered 
environment.

● Default maximum inline size (in bytes): The maximum number of bytes kept in memory when 
passing documents between different LiveCycle components. Documents that exceed this 
maximum are stored on the hard drive. Use this property for performance tuning. (See “Optimizing 
inline documents and impact on JVM memory” on page 148.)

● Default disposal time-out (in seconds): The maximum amount of time during which a document 
being passed between different LiveCycle components is considered active. After this time has 
passed, any files used to store this document are subject to removal. Use this property to control the 
usage of disk space.

● Use NFS protocol (Windows only): Select this option when deploying LiveCycle products in a 
clustered environment. Additional NFS software should be installed on your computer running 
Windows before enabling this option. This option does not affect deployments on Linux or UNIX.

● Global storage directory: A path to a shared directory used to store long-lived documents that are 
passed between LiveCycle products. LiveCycle Workflow uses this directory to share process-related 
files among cluster nodes. LiveCycle Form Manager uses this directory to store index files used for 
full-text searches. Using an NFS shared directory can help to improve performance.

(LiveCycle PDF Generator) When LiveCycle PDF Generator is running as a service, to specify a 
network folder for the Global storage directory property, you must use the network address of the 
folder, and not the path of a mapped drive. For example, \\computer_name\temp is the network 
address of the temp folder on the computer named computer_name.

For more information on the Global storage directory property, see “Optimizing inline documents 
and impact on JVM memory” on page 148.



Adobe LiveCycle Automatically Configuring LiveCycle Products
Installing and Configuring LiveCycle for WebLogic  Configuring and assembling LiveCycle products     44

5. (LiveCycle Forms, LiveCycle Form Manager, LiveCycle Workflow, LiveCycle Assembler) (Optional) On the 
Font Manager Module Configuration screen, select fonts for LiveCycle Forms to use in addition to the 
fonts that are included with the product. In the Fonts directory box, type the path or browse to the 
directory that contains the fonts to add, and then click Next. 

Note: Your right to use fonts provided by parties other than Adobe is governed by the license 
agreements provided to you by such parties in connection with those fonts, and is not covered 
under your license to use Adobe software. Adobe recommends that you review and ensure you 
are in compliance with all applicable non-Adobe license agreements before using non-Adobe 
fonts with Adobe software, particularly with respect to use of fonts in a server environment.

6. (LiveCycle Assembler) (Optional) On the Assembler Security Group configuration screen, specify the 
type of security you want to implement controlling permission to execute Assembler DDX jobs, and 
then click Next. Two types of user authentication are available: 

● Type an asterisk (*) to allow any user with a valid entry in the LDAP system to log in.

● Leave the field blank to allow any user to log in.

7. (LiveCycle Forms, LiveCycle Form Manager, LiveCycle Workflow) (Optional) On the Form Server Module 
Configuration screen, accept the default values for the following properties or specify new values, and 
then click Next:

● Validation UI: The type of UI to use on HTML forms if a validation error occurs. If you select List, all 
validation errors on the form are displayed as links. If you select MessageBox, each error message is 
displayed in a dialog box controlled by clicking next and previous buttons. The location of the list or 
buttons depends on the option selected for Validation Reporting.

● Validation Reporting: The location in which the validation messages are displayed. Select one of 
the following options:

● Frame Left - Displays validation messages within a frame on the left side of the web browser.

● Frame Right - Displays validation messages within a frame on the right side of the web browser. 

● Frame Top - Displays validation messages within a frame at the top of the web browser.

● Frame Bottom - Displays validation messages within a frame at the bottom of the web browser.

● No Frame Left - Displays validation messages in the same window on the left side of the web 
browser.

● No Frame Right - Displays validation messages in the same window on the right side of the web 
browser.

● No Frame Top - Displays validation messages in the same window at the top of the web 
browser.

● No Frame Bottom - Displays validation messages in the same window at the bottom of the web 
browser.

● None - Does not display validation messages.

● No UI - Returns the validation messages through the API (with data). The validation messages 
are not displayed on-screen.

● No UI With Form - Returns the validation messages through the API (with the form). The 
validation messages are not displayed on-screen.

● Validation Border: The frame border size (in pixels) when Validation Reporting is set to Frame Left, 
Frame Right, Frame Top, or Frame Bottom. The frame border size must be equal to or greater than 0.
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● Output Type: The type of HTML output returned to the web browser. Select Full HTML to render 
the form within full HTML tags (a complete HTML page) or select Form Body to render the form 
within div tags (not a complete HTML page).

● Locale: The language to be used for validation messages sent to client devices, such as web 
browsers, as part of HTML transformations. The default value is English (United States). For 
information on applicable values, see “Language and Locale Combinations” in the Developing 
Custom Applications guide that is installed with LiveCycle Forms.

● Charset: The character set used to encode the output byte stream. This property is dependent on 
the sFormPreference parameter specified through the API. For HTML transformations, the Form 
Server Module supports character encoding values defined by the java.nio.charset package. To view 
a list of supported values, go to http://java.sun.com/j2se/1.4.2/docs/guide/intl/encoding.doc.html.

● Cache Enabled: Select this option to optimize performance. This option works with the form 
design’s caching property. For information on configuring this value in the form design, see Adobe 
LiveCycle Designer Help.

8. (LiveCycle Forms, LiveCycle Form Manager, LiveCycle Workflow) (Optional) On the XMLForm Module 
Configuration screen, accept the default values for the following properties or specify new values, and 
then click Next:

● Pool Max: The maximum number of processes that can be running. The recommended value for 
PoolMax is the total number of CPUs * 2 + constant (1 or 2). When the PoolMax limit is reached, 
service instances are created from PoolSize.

● Trace Level: The trace level. The following options are available: 

● None - Tracing is not enabled.

● Enter/Exit - Messages are logged each time a method is entered and exited.

● Parameters - Messages are logged each time a method is entered and exited, and the value of 
all parameters passed into each method is logged.

● Details - Messages are logged each time a method is entered and exited, the value of all 
parameters passed into each method and any extra messages are logged.

● Report timing information: Select this option to monitor the start and end time of calls. You can 
use this information for performance tuning. 

9. On the Application Configuration and Assembly Summary screen, review the configuration details, and 
then click Next.

10. On the Configure and Assemble Products Summary screen, click Next. 

11. On the Tasks Completed screen, click Next (if you selected another task for Configuration Manager to 
perform) or click Finish to close Configuration Manager.

Changing the application server settings

The procedure in this section is a continuation of the procedure for performing a custom configuration. 
(See “Performing a custom configuration” on page 41.)

When you select the Change Application Server settings task for Configuration Manager to perform 
automatically, follow the procedure in this section to complete the Configuration Manager screens that 
appear for the task. 

http://java.sun.com/j2se/1.4.2/docs/guide/intl/encoding.doc.html


Adobe LiveCycle Automatically Configuring LiveCycle Products
Installing and Configuring LiveCycle for WebLogic  Changing the application server settings     46

If you are configuring a remote application server, ensure that the application server is installed on the 
Configuration Manager computer so that Configuration Manager can use the application server library 
files.

Caution: Some of the screens in this procedure have a Do Not Apply option. Selecting Do Not Apply is not 
the same as not specifying any property values. Selecting Do Not Apply does not configure any 
values and the previous values are retained. 

➤ To configure the application server:

1. Specify the home directory of the JDK that is used to run the application server, and then click Next. For 
example, the directory is C:\bea\jdk142_08 (Windows) or /opt/bea/jdk142_08 (Linux and UNIX).

2. On the Application Server Configuration Details screen, specify values for the following properties, and 
then click Next:

● Deploy Type: Specifies whether you are deploying to a standalone computer or to a cluster. Select 
Standalone.

● Remote Server: Select this option only if the application server is running on a different computer 
than the computer that is running Configuration Manager.

● Hostname: The fully qualified name or IP address of the computer that hosts the application server.

● Admin Port: The port used to provide access to the administration service on the application 
server. The default port is 7001.

● Server Instance Name: The name of the application server that you want to configure. The name of 
the default server instance that is created upon installing the application server is server1.

● Username and Password: (Optional) If the application server requires user credentials to perform 
administration tasks, the user name and password of an application server administration account.

● Local Application Server Root Directory: The root directory of the application server installation 
on the computer that is running Configuration Manager. For example, the directory is 
C:\bea\weblogic81 (Windows) or /opt/bea/weblogic81 (Linux and UNIX).

Caution: The Remote Server property cannot be used to configure LiveCycle PDF Generator Professional 
or LiveCycle PDF Generator Elements because Acrobat cannot be installed remotely. However, 
the property can be used to configure LiveCycle PDF Generator for PostScript.

3. On the Change Application Server settings page, click Next.

4. On the Configure Application Server for LiveCycle screen, click Next.

5. On the JVM Settings screen, specify values for the following properties of the JVM that runs the 
application server, and then click Next:

● Do Not Apply: Select this option if you do not want to configure JVM properties at this time. If you 
select this option, you do not need to provide values for the remaining properties on this screen.

● Initial Heap Size: The initial amount of memory allocated for the JVM. Specify 512.

● Maximum Heap Size: The maximum amount of memory that can be dynamically allocated for the 
JVM. Specify 1024.

● Additional JVM Arguments: Any additional arguments you require.

Note: Initial Heap Size and Maximum Heap Size must not be greater than 2048. For more information 
about setting these values, see “Optimizing inline documents and impact on JVM memory” on 
page 148.
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6. (LiveCycle PDF Generator, LiveCycle Form Manager, LiveCycle Workflow) On the JMS settings screen, 
click Next. There are no values that you need to configure on this screen.

7. On the Datasource Creation screen, specify values for the following properties of the LiveCycle 
database so that Configuration Manager can configure the database connection on the application 
server, and then click Next:

● Do Not Apply: Select this option if you do not want to configure the database connection at this 
time. If you select this option, you do not need to provide values for the remaining properties on 
this screen.

● Datasource: The JNDI name of the data source to create on the application server. Select IDP_DS.

● DB Type: The type of database you are using for the LiveCycle database.

● DB Name: The name of the database.

● DB Server Hostname: The name or IP address of the computer that hosts the database server.

● Port: The port used to access the database service.

● DB Username: The name of the user account that you created for LiveCycle products to access the 
LiveCycle database.

● DB Password: The password for the user account specified for DB Username.

● JDBC driver in local application server lib: The name and path of the driver file that the 
application server uses to connect to the database. If the driver consists of more than one file, you 
only need to specify the main file, as specified in the following list:

● (Oracle) [appserver root]/server/lib/ojdbc14.jar

● (SQL Server) [appserver root]/server/lib/wlsqlserver.jar

● JDBC Connection Pool Name: The name to use for the JDBC connection pool that is created for the 
data source. The default value is IDPConnectionPool.

8. On the Database Connection Tester screen, you can click Test Database Now to verify the database 
settings, or click Next to continue.

9. On the Configure Application Server screen, click Apply Settings Now to configure your application 
server, and, when the task is complete, click Next.

10. Restart the application server and, on the Application Server/Cluster Restart screen, click Next (if you 
selected another task for Configuration Manager to perform) or click Finish to close Configuration 
Manager.

Validating application server settings

When you select the Validate Application Server settings task for Configuration Manager to perform, 
follow the procedure in this section to complete the Configuration Manager screens that appear for the 
task.

The procedure in this section is a continuation from the Change Application Server Settings task. If you are 
continuing directly from step 10 in the previous section, the Configuration Manager will jump to step 2 
below. 

Note: If you did not restart the application server after changing the application server settings using 
Configuration Manager, restart it before validating the settings.
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When Configuration Manager validates application server settings, it deploys and communicates with the 
applications in the LCM.ear file.

If you are running Configuration Manager solely to perform the Validate Application Server Settings task, 
you will need to perform steps 2 through 9 in the previous section prior to performing the validation steps 
in this section.

If you are validating a remote application server, ensure that the application server is installed on the 
Configuration Manager computer so that Configuration Manager can use the application server library 
files.

Caution: Some of the screens in this procedure have a Do Not Apply option. Selecting Do Not Apply is not 
the same as not specifying any property values. Selecting Do Not Apply does not configure any 
values and the previous values are retained. 

➤ To validate application server settings:

1. On the Validate Application Server settings screen, click Next.

2. On the Deploy LCM.ear screen, click Execute or click Next.

3. On the Validate Application Server Settings screen, click Validate Settings Now and, when the task is 
complete, click Next (if you selected another task for Configuration Manager to perform) or click Finish 
to close Configuration Manager.

Note: When validating, you must not have any LiveCycle applications running other than the LCM.

Automatically deploying LiveCycle products

The procedure in this section is a continuation of the procedure for performing a custom configuration. 
(See “Performing a custom configuration” on page 41.)

When you select the Deploy Products task for Configuration Manager to perform, follow the procedure in 
this section to complete the Configuration Manager screens that appear for automatically deploying 
LiveCycle products to the application server.

Note: If you are redeploying LiveCycle.ear, you must first uninstall product EAR files. (See “Uninstalling EAR 
files” on page 52.)

If you are continuing directly from a previous task, Configuration Manager will jump to step 3 below. 

If you are running Configuration Manager solely to perform the Deploy products task, you will need to 
perform all of the steps in this section.

Note: Perform this procedure only after you have configured the application server.

If you are deploying to a remote application server, ensure that the application server is installed on the 
Configuration Manager computer so that Configuration Manager can use the application server library 
files.

If you want to deploy LiveCycle products manually, see “Manually Deploying to WebLogic” on page 76.

Note: (LiveCycle Workflow) Configuration Manager does not deploy BAM Server. For information about 
manually deploying BAM Server, see “Deploying BAM Server to WebLogic” on page 96.
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➤ To automatically deploy LiveCycle products:

1. Specify the home directory of the JDK that is used to run the application server, and then click Next. For 
example, the directory is C:\bea\jdk142_08 (Windows) or /opt/bea/jdk142_08 (Linux and UNIX).

2. On the Application Server Configuration Details screen, specify values for the following properties, and 
then click Next:

● Deploy Type: Specifies whether you are deploying to a standalone computer or to a cluster. Select 
Standalone.

● Remote Server: Select this option only if the application server is running on a different computer 
than the computer that is running Configuration Manager.

● Hostname: The fully qualified name or IP address of the computer that hosts the application server.

● Admin Port: The port used to provide access to the administration service on the application 
server. The default port is 7001.

● Server Instance Name: The name of the application server that you want to configure. The name of 
the default server instance that is created upon installing the application server is server1.

● Username and Password: (Optional) If the application server requires user credentials to perform 
administration tasks, the user name and password of an application server administration account.

● Local Application Server Root Directory: The root directory of the application server installation 
on the computer that is running Configuration Manager. For example, the directory is 
C:\bea\weblogic81 (Windows) or /opt/bea/weblogic81 (Linux and UNIX).

Caution: The Remote Server property cannot be used to configure LiveCycle PDF Generator Professional 
or LiveCycle PDF Generator Elements because Acrobat cannot be installed remotely. However, 
the property can be used to configure LiveCycle PDF Generator for PostScript.

3. On the Deploy LiveCycle screen, click Next.

4. On the Confirm Products to Deploy screen, select the archives that you are deploying and click Next.

5. On the Deploy Products screen, click Deploy Products Now, and, when the task is complete, click Next.

6. Click Next (if you selected another task for Configuration Manager to perform) or click Finish to close 
Configuration Manager.

Initializing the database

The procedure in this section is a continuation of the procedure for performing a custom configuration. 
(See “Performing a custom configuration” on page 41.)

When you select the Bootstrap Database task for Configuration Manager to perform, follow the procedure 
in this section to complete the Configuration Manager screens that appear for initializing the LiveCycle 
database.

If you are continuing directly from a previous task, Configuration Manager will jump to step 4 below. 

If you are running Configuration Manager solely to perform the Bootstrap database task, you will need to 
perform all of the steps in this section.

Note: There is no method for manually initializing the database.

If you are using User Management with LiveCycle products, you must run Configuration Manager to 
initialize the database for integration with User Management. When you run Configuration Manager, the 
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application server must be running. Initializing the database is a process that prepares a database for use 
with LiveCycle products by creating tables and optionally adding data to them. You only need to initialize 
the database the first time you deploy the product. 

If you have deployed LiveCycle products to a remote application server, ensure that the application server 
is installed on the Configuration Manager computer so that Configuration Manager can use the 
application server library files.

This section assumes that you have configured the database for integration with the product and have 
deployed the product to the application server. If you have not done this, see “Preparing Your 
Environment” on page 26, and “Manually Deploying to WebLogic” on page 76. 

➤ To initialize the database:

1. Specify the home directory of the JDK that is used to run the application server, and then click Next. For 
example, the directory is C:\bea\jdk142_08 (Windows) or /opt/bea/jdk142_08 (Linux and UNIX).

2. On the Application Server URL screen, type the URL that Configuration Manager can use to connect to 
the application server in the Application Server Base URL box, and then click Next. The URL must be 
in the following format:

http://[host name]:[port]

where [host name] is the name or IP address of the computer that hosts the application server, and 
[port] is the HTTP service port that the application server uses (for example, 
http://localhost:8001). 

3. On the Prepare database for LiveCycle screen, click Next.

4. On the Deploy LCM.ear screen, click Execute or click Next.

5. On the Database Initialization screen, click Initialize Database Now, and, when the task is complete, 
click Next.

6. Click Next (if you selected another task for Configuration Manager to perform) or click Finish to close 
Configuration Manager.

Verifying deployed LiveCycle products

The procedure in this section is a continuation of the procedure for performing a custom configuration. 
(see “Performing a custom configuration” on page 41.)

When you select the Verify Deployed Products task for Configuration Manager to perform, follow the 
procedure in this section to complete the Configuration Manager screens that appear for verifying that the 
LiveCycle services are accessible and functioning.

If you are continuing directly from a previous task, Configuration Manager will jump to step 4 below. 

If you are running Configuration Manager solely to perform the Verify Deployed Products task, you will 
need to perform all of the steps in this section.

If you are verifying the deployment to a remote application server, ensure that the application server is 
installed on the Configuration Manager computer so that Configuration Manager can use the application 
server library files.

Tip: You can perform this procedure if you have deployed LiveCycle products manually or automatically 
with Configuration Manager.
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➤ To verify deployed LiveCycle products:

1. Specify the home directory of the JDK that is used to run the application server, and then click Next. For 
example, the directory is C:\bea\jdk142_08 (Windows) or /opt/bea/jdk142_08 (Linux and UNIX).

2. On the Application Server URL screen, type the URL that Configuration Manager can use to connect to 
the application server in the Application Server Base URL box, and then click Next. The URL must be 
in the following format:

http://[host name]:[port]

where [host name] is the name or IP address of the computer that hosts the application server, and 
[port] is the HTTP service port that the application server uses (for example, 
http://localhost:7001.)

Note: To verify the port number to use for this setting, navigate to Application servers > [server], 
select the Configuration tab, then click Communications > Ports and look for the 
WC_defaulthost value.

3. On the Application Server Configuration Details screen, specify values for the following properties, and 
then click Next:

● Deploy Type: Specifies whether you are deploying to a standalone computer or to a cluster. Select 
Standalone.

● Remote Server: Select this option only if the application server is running on a different computer 
than the computer that is running Configuration Manager.

● Hostname: The fully qualified name or IP address of the computer that hosts the application server.

● Admin Port: The port used to provide access to the administration service on the application 
server. The default port is 7001.

● Server Instance Name: The name of the application server that you want to configure. The name of 
the default server instance that is created upon installing the application server is server1.

● Username and Password: (Optional) If the application server requires user credentials to perform 
administration tasks, the user name and password of an application server administration account.

● Local Application Server Root Directory: The root directory of the application server installation 
on the computer that is running Configuration Manager. For example, the directory is 
C:\bea\weblogic81 (Windows) or /opt/bea/weblogic81 (Linux and UNIX).

Caution: The Remote Server property cannot be used to configure LiveCycle PDF Generator Professional 
or LiveCycle PDF Generator Elements because Acrobat cannot be installed remotely. However, 
the property can be used to configure LiveCycle PDF Generator for PostScript.

4. On the Verify the installation screen, click Next.

5. On the Deploy LCM.4ear screen, click Execute or click Next.

6. On the Verify Deployed Products screen, click Run Product Tests Now, and, when the task is complete, 
click Next.

7. Click Finish.
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Uninstalling EAR files
If you need to redeploy a LiveCycle product, you must first uninstall the LiveCycle, LiveCycle Configuration 
Manager, and Font Manager Module applications from the application server. 

For example, if you have assembled LiveCycle products again to configure product properties differently, 
and the previous LiveCycle.ear file is already deployed, you need to uninstall the LiveCycle, LCM, and Font 
Manager Module applications before deploying the newly assembled EAR file.

➤ To uninstall the ear files:

1. Start the Administration Server and the Managed Server. (See “Starting and Stopping WebLogic” on 
page 67.)

2. Start WebLogic Server Administration Console by typing http://localhost:7001/console in 
the URL line of a web browser. 

3. In the navigation tree, select Deployments and click Applications. 

4. Click the LiveCycle application.

5. On the Deploy tab, click Stop Application.

6. Click the Garbage Can icon for the stopped application, click Yes, and then click Continue.

7. Repeat steps 4 to 6 for the LCM and the Font Manager Module applications.

8. Stop and start the Administration Server and the Managed Server. 

After uninstalling the ear file, you will need to reconfigure your ear file and redeploy, see “Performing a 
typical configuration” on page 38 or “Performing a custom configuration” on page 41.

Next step
You can now access Administrator and User Management. (See “Post-deployment” on page 53, “Accessing 
Administrator” on page 53, and “Accessing User Management” on page 54.) 

You can also now configure LiveCycle products to access LDAP. (See “Configuring LiveCycle Products to 
Access LDAP” on page 82.)

If you are using SSL for authentication, you can configure SSL on the application server. (See “Configuring 
SSL on WebLogic” on page 84.)

If you are using LiveCycle Workflow, you can now install LiveCycle Workflow Designer. (See “Installing 
LiveCycle Workflow Designer” on page 106.)
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5 Post-deployment

This chapter describes how to get started using your LiveCycle products after they have been installed, 
configured, and deployed to your application server:

● “Accessing Administrator” on page 53

● “Accessing User Management” on page 54

● “LiveCycle Assembler post-deployment tasks” on page 54

● “LiveCycle Forms post-deployment tasks” on page 55

● “LiveCycle Print post-deployment tasks” on page 56

● “LiveCycle Form Manager post-deployment tasks” on page 58

● “LiveCycle PDF Generator post-deployment tasks” on page 59

Accessing Administrator
Administrator is the web-based portal for accessing a variety of configuration pages that let you set 
run-time properties that control the way LiveCycle products operate. When you log into Administrator, 
you can access User Management, Adobe JMX Monitor, Watched Folder configuration (installed with 
Watched Folder), Process Manager and server settings (installed with LiveCycle Workflow), and 
administrative configuration options for other LiveCycle products.

The default user name and password for logging into Administrator is administrator and password. After 
you log in the first time, you can access User Management and change the password.

Before you access Administrator, the LiveCycle products must be deployed and running on your 
application server.

For information on using Administrator, see Adobe Administration Help (available from the Help menu of 
the Administrator window).

➤ To access Administrator:

1. Type the following URL in a web browser:

http://[host name]:[port]/adminui

 The default port number for WebLogic is 7001. (When you created a new managed server, you may 
have set a different port.)

2. In the User Name field, type administrator and, in the Password field, type password. 

3. After logging in, you can click Services to access the LiveCycle product Administrator pages, or 
Settings to access the User Management pages. 
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Accessing User Management
User Management allows administrators to maintain a database for all users and groups that are 
synchronized with one or more third-party user directories. User Management provides authentication, 
authorization, and user management for LiveCycle products, including LiveCycle PDF Generator, 
LiveCycle Assembler, LiveCycle Form Manager, LiveCycle Forms, and LiveCycle Workflow. 

User Management allows you to enable single sign-on (SSO) between LiveCycle products and Netegrity 
SiteMinder protected applications using Security Assertion Markup Language (SAML). When SSO is 
implemented, the LiveCycle user login pages are not required and do not appear if the user has already 
been authenticated via their company portal. 

For information about using User Management, see Adobe User Management Administration Help 
(available from the Help menu of the User Management window).

➤ To access User Management:

1. From the home page of Administrator, click Settings. 

2. On the Settings page, click User Management.

Note: For information about configuring users with User Management, click User Management Help 
in the upper right corner of the User Management page.

➤ (LiveCycle Forms) To access Administrator without User Management:

● Type the following URL in a web browser:

http://[host name]:[port]/FormServerAdmin/settings.html

LiveCycle Assembler post-deployment tasks
This section describes the post-deployment tasks specific to LiveCycle Assembler.

Verifying the LiveCycle Assembler deployment

You can verify that LiveCycle Assembler is deployed and running properly by deploying the prebuilt 
sample. (See the Samples Guide for LiveCycle Assembler, located in the 
[LiveCycle root]/Assembler/samples/docs directory.)

➤ To deploy the LiveCycle Assembler sample:

1. Copy the weblogic.sample-assembler7.ear file from the 
[LiveCycle root]/Assembler/samples/build/prebuilt directory to the [appserverdomain]/applications 
directory.

2. In the WebLogic Server Administration Console navigation tree, select Deployments > Application > 
Deploy a New Application. 

3. On the page that appears, click the applications directory, select the weblogic.sample-assembler7.ear 
file, and then click Continue.

4. Under Identity, in the Name box, type _appsdir_weblogic.sample-assembler7_ear and click 
Deploy. A new panel appears displaying the status of the deployment. 
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5. Type the following URL in a web browser:

http://localhost:7001/adobe/livecycle/samples/assembler7/

6. Click About Assembler and confirm that the LiveCycle Assembler information is returned to the Result 
window.

You can now create applications for LiveCycle Assembler. (See the Developing Applications for LiveCycle 
Assembler guide.)

LiveCycle Forms post-deployment tasks
This section describes the post-deployment tasks specific to LiveCycle Forms.

You can now create custom applications for LiveCycle Forms. (See the Developing Custom Applications 
guide.) For details on the Form Server Module, see the Form Server Module API Reference. For details on the 
XML Form Module API, see the XML Form Module API Reference.

You can optionally install LiveCycle Print to enable LiveCycle Forms to output forms as Adobe PostScript, 
Printer Control Language (PCL), and Zebra Programming Language (ZPL) print streams, in addition to PDF 
and HTML forms. Without LiveCycle Print, LiveCycle Forms cannot output forms as print streams. Instead, 
LiveCycle Forms sends forms across a network and renders them to client devices, such as web browsers, 
as PDF or HTML forms.

Verifying the LiveCycle Forms deployment

You can verify that LiveCycle Forms is deployed and running properly by accessing the Installation 
Verification Sample application that is installed with the product.

➤ To access the Installation Verification Sample:

1. Copy the FormsIVS.ear file from the [LiveCycle root]/components/forms/samples/common directory to 
the [appserverdomain]/applications directory.

2. Start WebLogic Server Administration Console by typing http://localhost:7001/console in 
the URL line of a web browser and sign in as an administrator.

3. In the navigation tree, select Deployments > Applications > Deploy a New Application.

4. On the page that appears, click the applications directory, select the FormsIVS.ear module to deploy, 
and then click Target Application.

5. On the Select targets for this application page, select the servers on which this module will be 
deployed and then click Continue.

6. On the page that appears in the Source Accessibility area, select Copy this application onto every 
target for me and click Deploy. A new panel appears displaying the status of the deployment.

7. Type the following URL in a web browser:

http://[host name]:[port]/FormsIVS

where [host name] is the name of the server on which Forms has been deployed. If you are invoking 
FormsIVS on the server itself, provide the server name instead of “localhost”.

Note: For information about using the sample application, click the Help link in the Samples page in 
the web browser.
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LiveCycle Print post-deployment tasks
This section describes the post-deployment tasks specific to LiveCycle Print.

Verifying deployment

You can verify that LiveCycle Print is deployed and running properly using any of the following methods:

● Deploying and running the Print Installation and Verification Sample (PrintIVS) web application.

● Running the Print Submitter console application (you do not have to deploy this application). 

Both of these applications invoke LiveCycle Print by using the LiveCycle Print API (this API consumes 
the LiveCycle Print web service).

● Running the Forms Installation and Verification Sample (FormsIVS) application. If LiveCycle Print is 
deployed, the Output format list contains three additional options: PostScript, ZPL, and PCL. For 
information about the Installation Verification Sample application, see “Verifying the LiveCycle Forms 
deployment” on page 55.

In addition to running the two sample print applications, you can also invoke LiveCycle Print by using the 
Form Server Module API Print application. This sample Print application is a console application that 
invokes LiveCycle Print by using the Form Server Module API. (See “Running the Form Server Module API 
Print application” on page 57.)

Deploying and running the PrintIVS web application

The PrintIVS web application is packaged in the adobe-printSubmitter.ear file, which is located in the 
[LiveCycle root]/components/print/common/ear directory. After you run Configuration Manager, the 
PrintIVS is deployed by default and is located in the [LiveCycle root]/configurationManager/export directory.

To run this application, you must understand the print specification because this application requires the 
same values as the print specification. (See “About the print specification” in the LiveCycle Print Getting 
Started guide.)

➤ To deploy and run the PrintIVS web application:

1. [LiveCycle root]/components/print/common/earStart WebLogic Server Administration Console by 
typing http://localhost:7001/console in the URL line of a web browser and sign in as an 
administrator. 

2. From the Welcome page, select Helpful Tools > Deploy a New Application.

3. Click the Upload your file(s) link and on the page that appears, browse to the 
adobe-printSubmitter.ear file in the [LiveCycle root]/components/print/common/ear or 
[LiveCycle root]/configurationManager/export directory, and then click Upload.

4. On the Deploy an Application page, select the adobe-printSubmitter.ear file, and then click Continue.

5. On the Review your choices and deploy page, click Deploy. A new panel appears displaying the 
status of the deployment.

6. To run the sample application, type http://[host name]:[port]/PrintIVS in the URL line of a 
web browser.

7. Enter the required values and click Print. 
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Running the Print Submitter application

The Print Submitter application consists of the lcprint.bat (Windows) or lcprint.sh (UNIX or Linux) file, 
which is located in the [LiveCycle root]/components/print/samples/common/lcprint directory.

You can run the Print Submitter application from a command prompt to invoke LiveCycle Print.

➤ To run the Print Submitter application:

1. From a command prompt, navigate to the [LiveCycle root]/components/print/samples/common/lcprint 
directory. 

If you have not installed to the default directory, create a new environment variable named 
LiveCycleRoot and set the value to the installation directory used on your system. 

2. Enter the following command:

lcprint <-d,--dataFile filename> <-f,--specFile filename> <-s,--server
server:port>

The first argument, which is optional, is a fully qualified path to the data file. A series of data files 
accompanies LiveCycle Print and are located in the 
[LiveCycle root]/components/print/samples/common/lcprint /data directory.

Most of these files contain multiple records. For example, PurchaseOrder_batch_25.xml contains 25 
records. You can create multiple print streams by using a data file that contains multiple records. (See 
“Working with multiple data records” in the LiveCycle Print Getting Started guide.)

The second argument is a fully qualified path to the print specification that is sent to LiveCycle Print. 
You can amend the PrintSpecTemplate.xml file and use this file. The PrintSpecTemplate.xml file is 
located in the same directory as the lcprint.bat file. (See “About the print specification” in the 
LiveCycle Print Getting Started guide.)

One value that you must specify within the print specification is the location of the form design on 
which a print stream is based. Sample form designs are located in the 
[LiveCycle root]/components/print/samples/common/lcprint /forms directory.

The third argument, which is required, specifies the server name and port.

You can also use the Print Submitter console application to retrieve information about a previous 
request. To perform this task, use the following command:

lcprint <-r,--result requestId>

where requestId is a string value, such as 59572cd82, that specifies a request identifier. This 
command returns result data that specifies the status of a request. (See “About result data” in the 
LiveCycle Print Getting Started guide.)

Running the Form Server Module API Print application

The Form Server Module API Print application uses the Form Server Module API to invoke LiveCycle Print 
from a command prompt. (See “Working with the Form Server Module” in the LiveCycle Print Getting 
Started guide.)
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The Form Server Module API Print application consists of a Java file named FsPrint.java, which is located in 
the [LiveCycle root]/components/print/samples/common/fsprint directory. If you are using Windows, you 
must run the fsprint.bat file located in this directory. If you are using UNIX or Linux, you must run the 
fsprint.sh file.

Note: The Form Server Module API Print application creates a SOAPClient object that specifies a valid 
SOAP endpoint. The default SOAP endpoint in the FsPrint.java file is configured for the default SOAP 
endpoint that JBoss uses. If LiveCycle Forms is deployed on a different J2EE application server, you 
must edit the FsPrint.java file by commenting and uncommenting the appropriate SOAP endpoint. 
For more information about using a SOAPClient object, see the LiveCycle Forms Developing 
Custom Applications guide.

➤ To run the Form Server Module API Print application:

1. From a command prompt, navigate to the application 
[LiveCycle root]/components/print/samples/common/fsprint directory.

If you have not installed to the default directory, create a new environment variable named 
LiveCycleRoot and set the value to the installation directory used on your system.

2. Enter the following command:

fsprint <-argument 1> <-argument2>

The first argument is a fully qualified path to the form design (an XDP file). You can use a sample form 
design that is located in the [LiveCycle root]/components/print/samples/common/lcprint/forms 
directory.

The second argument, which is optional, defines the print stream destination. For example, you can 
define a file URI to a PostScript file. If this value is not specified, output is written to the standard output. 
This value is similar to the PrintURI element that is located in the print specification. (See “About the 
print specification” in the LiveCycle Print Getting Started guide.) 

Tip: The source code for the Form Server Module API Print application is located in the FsPrint.java file. You 
can open this file to see the application logic that invokes LiveCycle Print by using the Form Server 
Module API.

LiveCycle Form Manager post-deployment tasks
This section describes the post-deployment tasks specific to LiveCycle Form Manager.

Accessing the LiveCycle Form Manager end-user pages

After you configure User Management to connect to your organization’s LDAP server, users can access the 
LiveCycle Form Manager end-user pages by going to the following URL:

http://[host name]:[port]/fm

The default port number for WebLogic is 7001. 

You can also access the end-user pages using the default administration user name (Administrator) 
and password (password).

For information about using the LiveCycle Form Manager end-user pages, see LiveCycle Form Manager Help 
(available from the Help menu of the LiveCycle Form Manager window).
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LiveCycle PDF Generator post-deployment tasks
This section describes the post-deployment tasks specific to LiveCycle PDF Generator. 

Setting up job sources

You can configure LiveCycle PDF Generator to accept jobs from watched folders, email, and the web UI 
(sample code). (See LiveCycle PDF Generator Administration Help.)

Additionally, LiveCycle PDF Generator can accept jobs submitted with the LiveCycle PDF Generator web 
services interface. To enable this, the sample web services client application installed with 
LiveCycle PDF Generator requires developer modifications before it can be used for job submission. For 
more information on configuring these job sources, see the LiveCycle PDF Generator Developing Custom 
Applications guide.

Setting Adobe PDF Printer as the default printer

This section applies to LiveCycle PDF Generator Professional and Elements only. 

You must set up the Adobe PDF Printer as the default printer on the server.

➤ To set up Adobe PDF Printer as the default printer:

1. Navigate to the printer panel in your operating system.

2. Set Adobe PDF as the default printer.

Installing fonts

You can install the fonts that are used in documents converted by LiveCycle PDF Generator. Fonts may be 
referenced by PostScript or EPS documents, or they may be referenced by native file formats, such as those 
used by Microsoft Word or Microsoft Excel. 

To make additional fonts available to any application, install the fonts using one of these methods:

● Install the fonts in the appropriate folder:

● (Windows) C:\Windows\Fonts

● (Solaris) /usr/openwin/lib/X11/fonts

● (Linux) /usr/X11R6/lib/X11/fonts

● Using Configuration Manager, on the Font Manager Module Configuration screen, browse to the 
directory that contains the fonts and then redeploy the Font Manager Module. For information about 
deploying the Font Manager Module, see “Configuring LiveCycle Products for Deployment” on page 62.

For a list of fonts installed with the Font Manager Module, see “Fonts Installed with the Font Manager 
Module” on page 112.

Note: Fonts in the Font Manager Module are not available to the native applications that 
LiveCycle PDF Generator uses to convert native file formats. Such native applications include 
Microsoft Word and Acrobat. To make a font available to native applications, you must install it in 
the system font folder. If your LiveCycle PDF Generator server is clustered, the font must be installed 
on each computer used to host native applications. 
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Satisfying font references 

This section applies to LiveCycle PDF Generator Elements and LiveCycle PDF Generator Professional only.

For font references in a native file, LiveCycle PDF Generator Elements and 
LiveCycle PDF Generator Professional use the native application with the Adobe PDF printer to convert a 
native file format to PDF. The native application satisfies font references from the C:\Windows\Fonts 
directory. 

For font references in a PDF document, these products attempt to satisfy the font references from the 
following sources in the following order:

● Fonts embedded in the PDF document 

● Font Manager Module

● C:\WINDOWS\Fonts

Setting the LiveCycle PDF Generator conversion time-out

You can configure LiveCycle PDF Generator conversion time-out settings at the application server level or 
job source level. If the time-out setting is configured at more than one level, the lowest level is applicable.

For details about configuring the setting at the application server level, see “Manually Configuring 
WebLogic” on page 66.

➤ To set the conversion time-out settings at the job source level:

● In Administrator, select Create PDF and, in the Specify a timeout box, type a value in seconds. By 
default, this value is read from the server.aes.properties file.

➤ To set the conversion time-out settings for watched folders and email sources:

1. In Administrator, select Services > Adobe LiveCycle PDF Generator > Configuration Files > Export 
Configuration.

2. Select Download entire configuration and click Download. By default, this value is read from the 
server.aes.properties file.

3. Edit the native2pdfconfig.xml file in a text editor and set the <timeout> level.

4. Upload your changes by selecting Import Configuration, browsing to the location of the 
native2pdfconfig.xml file, and then clicking Import.

Note: The time-out level for the web services APIs is read from the server.aes.properties file.

Next Step
If you have installed and configured LiveCycle Workflow, you must now configure the JBoss application 
server for BAM Server. (See “Manually Configuring BAM Server for WebLogic” on page 90.)
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Part II: Manual Configuration, and Deployment

This section of the guide describes how to manually configure and deploy your LiveCycle products.

For information on the automatic configuration and deployment of the products, see “Automatic 
Configuration and Deployment” on page 35.
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6 Configuring LiveCycle Products for Deployment

This chapter describes how to configure LiveCycle products for deployment. 

This chapter assumes that you have installed LiveCycle products. If you have not installed the products, see 
“Installing LiveCycle Products” on page 19. 

The instance of Configuration Manager that is installed with one LiveCycle product can be used with all 
LiveCycle products. When you run Configuration Manager, you can specify the LiveCycle products that you 
are configuring as well as the type of application server that you are leveraging in the solution. You can 
also set run-time properties for LiveCycle products and enable or disable security.

If you are already running one or more LiveCycle products, you must configure and assemble those 
existing products with the new one that you want to configure. To do this, you must undeploy the 
previously deployed products and select all of the products that you want to assemble during 
configuration. The previously deployed products are then included in the LiveCycle.ear file and deployed 
with the new product when you deploy the file to the application server. 

Note: To assemble multiple LiveCycle products, each product must be installed in the same 
[LiveCycle root] directory.

When Configuration Manager completes the configuration of the products, it places the files to be 
deployed to the application server (LiveCycle.ear, adobe-FontManager.ear, and the product-related ear 
files) in the following directory:

● (Windows) [LiveCycle root]\configurationManager\export

● (Linux, UNIX) [LiveCycle root]/configurationManager/export

➤ To configure the products for deployment:

1. Navigate to the [LiveCycle root]/configurationManager directory and start Configuration Manager: 

● (Windows) Double-click ConfigurationManager.exe.

● (Linux, UNIX) From a command prompt, type: ConfigurationManager.bin

2. If prompted, select a language for Configuration Manager and click OK.

3. On the Configuration Manager Welcome screen, click Next. 

4. Select Custom Configuration Wizard and click Next.

5. If prompted, on the Configuration Preferences screen, select either Use Previously Entered Values or 
Revert to Default Values, and then click Next.

6. Select the application server you have installed, select Foundation and the products that you want to 
configure, and then click Next.

7. (LiveCycle Forms) On the Adobe User Management Selection screen, select either LiveCycle Forms 
with User Management and Administration or LiveCycle Forms without User Management and 
Administration, and then click Next.
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8. Ensure that only Configure and assemble LiveCycle products is selected, and then click Next.

9. On the Configure and Assemble products screen, click Next.

10. (Optional) On the Data Manager Module Configuration screen, if you are using SSL security on your 
application server, select Enable SSL and type the SSL credential password. 

If you have not yet set up your SSL credential, you can type a password here and use it when you create 
an SSL credential. (See “Configuring SSL on WebLogic” on page 87.)

11. Enter a directory to use for Adobe LiveCycle products temp file, and then click Next.

Note: (Linux and UNIX) If you are logged in as a non-root user, specify a directory under your home 
directory.

For more information on the Adobe LiveCycle products temp file, see “Optimizing inline documents 
and impact on JVM memory” on page 148.

12. On the Data Manager Module Configuration continued screen, accept the default values for the 
following properties or specify new values, and then click Next: 

● Local storage sweep interval (in seconds): The amount of time between attempts to delete any 
files that are no longer needed and were used to pass the document data between LiveCycle 
services running on the same computer.

● Global storage sweep interval (in seconds): The amount of time between attempts to delete any 
obsolete files that were used to pass the document data between LiveCycle services running on the 
different computers. Specify this property only when deploying LiveCycle products in a clustered 
environment.

● Default maximum inline size (in bytes): The maximum number of bytes kept in memory when 
passing documents between different LiveCycle components. Documents that exceed this 
maximum are stored on the hard drive. Use this property for performance tuning. (See “Optimizing 
inline documents and impact on JVM memory” on page 148.)

● Default disposal time-out (in seconds): The maximum amount of time during which a document 
being passed between different LiveCycle components is considered active. After this time has 
passed, any files used to store this document are subject to removal. Use this property to control the 
usage of disk space.

● Use NFS protocol (Windows only): Select this option when deploying LiveCycle products in a 
clustered environment. Additional NFS software should be installed on your computer running 
Windows before enabling this option. This option does not affect deployments on Linux or UNIX.

● Global storage directory: A path to a shared directory used to store long-lived documents that are 
passed between LiveCycle products. LiveCycle Workflow uses this directory to share process-related 
files among cluster nodes. LiveCycle Form Manager uses this directory to store index files used for 
full-text searches. Using an NFS shared directory can help to improve performance.

(LiveCycle PDF Generator) When LiveCycle PDF Generator is running as a service, to specify a 
network folder for the Global storage directory property, you must use the network address of the 
folder, and not the path of a mapped drive. For example, \\computer_name\temp is the network 
address of the temp folder on the computer named computer_name.

For more information on the Global storage directory property, see “Optimizing inline documents 
and impact on JVM memory” on page 148.
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13. (LiveCycle Forms, LiveCycle Form Manager, LiveCycle Workflow, LiveCycle Assembler) (Optional) On the 
Font Manager Module Configuration screen, select fonts for LiveCycle Forms to use in addition to the 
fonts that are included with the product. In the Fonts directory box, type the path or browse to the 
directory that contains the fonts to add, and then click Next. 

Note: Your right to use fonts provided by parties other than Adobe is governed by the license 
agreements provided to you by such parties in connection with those fonts, and is not covered 
under your license to use Adobe software. Adobe recommends that you review and ensure you 
are in compliance with all applicable non-Adobe license agreements before using non-Adobe 
fonts with Adobe software, particularly with respect to use of fonts in a server environment.

14. (LiveCycle Assembler) (Optional) On the Assembler Security Group configuration screen, specify the 
type of security you want to implement controlling permission to execute Assembler DDX jobs, and 
then click Next. Two types of user authentication are available: 

● Type an asterisk (*) to allow any user with a valid entry in the LDAP system to log in.

● Leave the field blank to allow any user to log in.

15. (LiveCycle Forms, LiveCycle Form Manager, LiveCycle Workflow) (Optional) On the Form Server Module 
Configuration screen, accept the default values for the following properties or specify new values, and 
then click Next:

● Validation UI: The type of UI to use on HTML forms if a validation error occurs. If you select List, all 
validation errors on the form are displayed as links. If you select MessageBox, each error message is 
displayed in a dialog box controlled by clicking next and previous buttons. The location of the list or 
buttons depends on the option selected for Validation Reporting.

● Validation Reporting: The location in which the validation messages are displayed. Select one of 
the following options:

● Frame Left - Displays validation messages within a frame on the left side of the web browser.

● Frame Right - Displays validation messages within a frame on the right side of the web browser. 

● Frame Top - Displays validation messages within a frame at the top of the web browser.

● Frame Bottom - Displays validation messages within a frame at the bottom of the web browser.

● No Frame Left - Displays validation messages in the same window on the left side of the web 
browser.

● No Frame Right - Displays validation messages in the same window on the right side of the web 
browser.

● No Frame Top - Displays validation messages in the same window at the top of the web 
browser.

● No Frame Bottom - Displays validation messages in the same window at the bottom of the web 
browser.

● None - Does not display validation messages.

● No UI - Returns the validation messages through the API (with data). The validation messages 
are not displayed on-screen.

● No UI With Form - Returns the validation messages through the API (with the form). The 
validation messages are not displayed on-screen.

● Validation Border: The frame border size (in pixels) when Validation Reporting is set to Frame Left, 
Frame Right, Frame Top, or Frame Bottom. The frame border size must be equal to or greater than 0.
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● Output Type: The type of HTML output returned to the web browser. Select Full HTML to render 
the form within full HTML tags (a complete HTML page) or select Form Body to render the form 
within div tags (not a complete HTML page).

● Locale: The language to be used for validation messages sent to client devices, such as web 
browsers, as part of HTML transformations. The default value is English (United States). For 
information on applicable values, see “Language and Locale Combinations” in the Developing 
Custom Applications guide that is installed with LiveCycle Forms.

● Charset: The character set used to encode the output byte stream. This property is dependent on 
the sFormPreference parameter specified through the API. For HTML transformations, the Form 
Server Module supports character encoding values defined by the java.nio.charset package. To view 
a list of supported values, go to http://java.sun.com/j2se/1.4.2/docs/guide/intl/encoding.doc.html.

● Cache Enabled: Select this option to optimize performance. This option works with the form 
design’s caching property. For information on configuring this value in the form design, see Adobe 
LiveCycle Designer Help.

16. (LiveCycle Forms, LiveCycle Form Manager, LiveCycle Workflow) (Optional) On the XMLForm Module 
Configuration screen, accept the default values for the following properties or specify new values, and 
then click Next:

● Pool Max: The maximum number of processes that can be running. The recommended value for 
PoolMax is the total number of CPUs * 2 + constant (1 or 2). When the PoolMax limit is reached, 
service instances are created from PoolSize.

● Trace Level: The trace level. The following options are available: 

● None - Tracing is not enabled.

● Enter/Exit - Messages are logged each time a method is entered and exited.

● Parameters - Messages are logged each time a method is entered and exited, and the value of 
all parameters passed into each method is logged.

● Details - Messages are logged each time a method is entered and exited, the value of all 
parameters passed into each method and any extra messages are logged.

● Report timing information: Select this option to monitor the start and end time of calls. You can 
use this information for performance tuning. 

17. On the Application Configuration and Assembly Summary screen, review the configuration details, and 
then click Next.

18. On the Configure and Assemble Products Summary screen, click Next. 

19. On the Tasks Completed screen, click Next (if you selected another task for Configuration Manager to 
perform) or click Finish to close Configuration Manager.

Next step
You must now configure your application server. (See “Manually Configuring WebLogic” on page 66.)

http://java.sun.com/j2se/1.4.2/docs/guide/intl/encoding.doc.html
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7 Manually Configuring WebLogic

This chapter describes how to manually configure the WebLogic application server to prepare for the 
manual deployment of LiveCycle products. For information on how to automatically configure your 
application server, see “Automatically Configuring LiveCycle Products” on page 36.

You must perform the following tasks to configure WebLogic so that LiveCycle products run correctly:

● Point WebLogic to the LiveCycle JAR files and the endorsed directory that you created and configure 
JVM arguments. (See “Creating an endorsed directory” on page 31 and “Registering required JAR files” 
on page 33.)

● Increase the WebLogic Server thread count from the default value. (See “Increasing the WebLogic 
Server thread count” on page 68.)

● Increase the WebLogic transaction time-out value. (See “Configuring the Oracle database connectivity” 
on page 69.)

● Configure various WebLogic and database settings on the instance of WebLogic that hosts LiveCycle 
products. (See “Configuring the Oracle database connectivity” on page 69, or “Configuring the SQL 
database connectivity” on page 70.)

● Configure Java Message Service (JMS) resources for WebLogic. (See “Configuring JMS Resources for 
WebLogic” on page 71.)

● Ensure that WebLogic is stopped or running, depending on the task you are performing.

Note: If you are running WebLogic Server on Red Hat Enterprise Linux Advanced Server 3.0, you must set 
the environment variable LD_ASSUME_KERNEL to 2.4.19 using the 
export LD_ASSUME_KERNEL=2.4.19 command. You must then run WebLogic Sever from the 
same shell in which you set this environment variable.

The procedures in this chapter are for configuring the application server for all LiveCycle products. If a 
specific product requires a different process, the steps are highlighted. If you previously configured your 
application server for deploying other LiveCycle products, you do not need to perform the procedures in 
this chapter again.

This chapter assumes that you have installed your LiveCycle products, configured your database, and 
created a database user account. If you have not done this, see “Preparing Your Environment” on page 26.

Before deploying to WebLogic, you must ensure that the application server is preconfigured according to 
your needs. You must create a domain and, if you are deploying in a run-time environment, create at least 
one Managed Server within the domain. (See “Creating the WebLogic Server domain” on page 29.)

Activity Required WebLogic state

Creating a new WebLogic domain Stopped

Creating a new WebLogic managed server Running

Increasing the server thread count Running

Deploying LiveCycle products Running
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This chapter uses the following naming conventions for common file paths:

● BEA_HOME - Refers to the BEA install directory. For example, the directory is “C:\bea” (Windows) or 
“opt/bea” (Linux and UNIX).

● [appserver root] - Refers to the WebLogic Server home directory, “BEA_HOME/weblogic81”.

● [appserverdomain] - Refers to the configured domain. The default domain is 
BEA_HOME/user_projects/domains/mydomain.

● [LiveCycle root] - Refers to the location where LiveCycle products and components are installed.

Starting and Stopping WebLogic
Several procedures in this chapter require you to stop and start the instance of WebLogic where you want 
to deploy LiveCycle products.

➤ To start WebLogic Server Administration Console:

1. From a command prompt, navigate to BEA_HOME/user_projects/domains/[appserverdomain].

2. Enter the following command:

● (Windows) startWebLogic.cmd

● (Linux, UNIX) ./startWebLogic.sh

➤ To start Node Manager:

1. Ensure that the WebLogic Server Administration Console is running.

2. From a command prompt, navigate to [appserver root]/server/bin.

3. Enter the following command:

● (Windows) startNodeManager.cmd

● (Linux, UNIX) ./startNodeManager.sh

➤ To start a WebLogic Managed Server:

1. Ensure that the WebLogic Server Administration Console and Node Manager are running.

2. Select the Managed Server in the navigation tree, and select the Control tab.

3. Click Start this server.

➤ To stop WebLogic Server Administration Console:

1. From a command prompt, navigate to BEA_HOME/user_projects/domains/[appserverdomain].

2. Enter the following command:

● (Windows) stopWebLogic.cmd adminusername

● (Linux, UNIX) ./stopWebLogic.sh adminusername

3. When prompted, type the administrator password and click Enter.



Adobe LiveCycle Manually Configuring WebLogic
Installing and Configuring LiveCycle for WebLogic  Increasing the WebLogic Server thread count     68

➤ To stop a WebLogic Managed Server:

1. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console 
in the URL line of a web browser.

2. From the Domain Configurations, click [domain_name].

3. Select the Control tab.

4. Click the Start/Stop button next to the managed server you want to stop.

5. Select one of the following options: 

● Graceful shutdown of all Managed Servers 

This option initiates a graceful shutdown of the selected server, causing the Managed Server to 
notify its subsystems to complete all in-work requests. A graceful shutdown gives the WebLogic 
Server subsystems time to complete certain application processing currently in progress.

● Force shutdown of all Managed Servers.

This option initiates a forced shut down causing the Managed Server to instruct subsystems to 
immediately drop in-work requests.

6. At the WebLogic Server Administration Console prompt, click Yes to confirm the command. 

Tip: You can verify that the Managed Server has been shut down by viewing the table at the bottom of the 
Control tab. The table displays a list of all of the servers and indicates their current state. 

Increasing the WebLogic Server thread count
Before deploying LiveCycle products to WebLogic Server, you must increase the server thread count. The 
default value of 25 may be insufficient for running your applications. 

➤ To increase the WebLogic Server thread count:

1. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console 
in the URL line of a web browser. 

2. Type the user name and password that you created for the WebLogic domain, and then click Sign In.

3. Select Servers, right-click the server name, and select View Execute Queues.

4. Click weblogic.kernel.Default.

5. In the Thread Count box, type a new value (for example, 40) and, on the lower right, click Apply.

6. Restart WebLogic. 
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Configuring the Oracle database connectivity
To enable WebLogic and your LiveCycle deployment to connect to the Oracle 9i or 10g database, you must 
create a database connection for WebLogic by setting up a connection pool and a data source.

Before performing the following procedures, you must have already created an Oracle database and a user 
on the database. (See “Creating an Oracle database” on page 26.) Ensure that you have installed the 
correct database drivers. (See “Installing database drivers” on page 32.)

➤ To set up a connection pool:

1. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console 
in the URL line of a web browser. 

2. Type the user name and password that you created for the WebLogic domain, and then click Sign In.

3. In the navigation tree, select Services > JDBC > Connection Pools.

4. Click Configure a new JDBC Connection Pool.

5. Under Database Type, select Oracle and, under Database Driver, select either Oracle’s Driver (Thin) 
Versions: 8.1.7 or Oracle’s Driver (Thin) Versions: 9.0.1,9.2.0,10, and then click Continue. 

6. On the Define Connection Properties screen, type a name for the connection pool.

7. In the Database Name box, type the name of the database you have created. 

8. In the Host Name box, type the name or IP address of the computer on which Oracle is running. 

Note: Do not edit the Port value. 

9. In the Database User box, type the name of the user you created on the Oracle database and, in the 
Password box and the Confirm Password box, type the associated password, and then click 
Continue.

10. On the Test Database Connection screen, click Test Driver Configuration. 

11. On the Create and Deploy screen, in the Independent Servers table, select the server and click Create 
and deploy. 

12. (All products except LiveCycle PDF Generator or LiveCycle Assembler) Perform the following additional 
steps: 

● In the navigation tree, select the connection pool you created.

● Click the Configuration tab, and then click the Connections tab.

● In the Maximum Capacity box, type 100 and, in the Statement Cache Size box, type 80, and then 
click Apply.

● Click Show Advanced Options, select Test Reserved Connections, Test Created Connections, 
and Test Released Connections, and then click Apply.

● In the Test Frequency box, set the test frequency to more than 0 seconds, and then click Apply.

● Click the Testing tab and click Test Pool.
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➤ To set up a data source:

1. In the navigation tree, select Services > JDBC > Data Sources and select Configure a new JDBC Data 
Source.

2. In the Name box, type a name for the JDBC data source and, in the JNDI Name box, type: IDP_DS

3. (All products except LiveCycle PDF Generator and LiveCycle Forms) Select Honour Global 
Transactions, select Emulate Two-Phase Commit for non-XA Driver, and then click Continue.

4. On the Connect to Connection Pool screen, select the pool you created and click Continue.

5. On the Target the Data Source screen, select the server on which to deploy the JDBC data source and 
click Create.

6. Restart WebLogic.

Configuring the SQL database connectivity
To enable WebLogic and your LiveCycle deployment to connect to the SQL Server database, you must 
create a database connection for WebLogic by setting up a connection pool and data source. 

Before performing the following procedures, you must have already created the SQL Server database. (See 
“Creating a SQL Server database” on page 27.)

Connect JDBC drivers have the XA DLL sqljdbc.dll file that is normally installed under 
[SQLServer_Install_Root]\MSSQL\Binn (for example, c:\Program Files\Microsoft SQL Server\MSSQL\Binn). 
The registry values required for XA transactions are not created automatically. You must create the values 
manually.

➤ To set up a connection pool:

1. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console 
in the URL line of a web browser.

2. Type the user name and password that you created for the WebLogic domain, and then click Sign In.

3. In the navigation tree, select Services > JDBC > Connection Pools.

4. Click Configure a new JDBC Connection Pool.

5. Under Database Type, select MS SQL Server and, under Database Driver, select BEA’s MS SQL 
Server Driver (Type 4) Versions: 7.0.2000, and then click Continue.

6. Specify values for the following properties, and then click Continue:

● Name: A name for the pool.

● Database Name: The name of the database you created to store LiveCycle data.

● Host Name: The name of the computer that hosts SQL Server.

● Port: The port that SQL server uses for connections. The default is 1433. 

● Database User Name: The user name of an account that has the DBOwner role of the LiveCycle 
database.

● Password and Confirm Password: The password for the database user account.
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7. Ensure that the following properties have the specified values:

● Driver Classname: weblogic.jdbcx.sqlserver.SQLServerDriver 

● URL: jdbc:microsoft:sqlserver://[host name]:[port] 

8. Click Test Driver Configuration.

9. On the Create and Deploy screen, in the Independent Servers table, select the target server (if more 
than one server is defined) and click Create and deploy. 

10. (All products except LiveCycle PDF Generator) Perform the following additional steps:

● In the table of JDBC connection pools, click the pool that you just created.

● Click the Configuration tab, and then click the Connections tab.

● Click Show Advanced Options and select Test Reserved Connections, Test Created 
Connections, and Test Released Connections.

● In the Test Frequency box, set the test frequency to more than 0 seconds.

● In the Test Table Name box, type: SQL SELECT 1

11. Click Apply.

12. Click the Testing tab and click Test Pools.

➤ To set up a data source:

1. In the navigation tree, select Services > JDBC > Data Sources and select Configure a new JDBC Data 
Source.

2. Type name for the JDBC data source and, in the JNDI Name box: type IDP_DS

3. Select Honor Global Transactions, select Emulate Two-Phase Commit for non-XA Driver, and then 
click Continue.

4. On the Connect to Connection Pool screen, select the pool you created and click Continue.

5. On the Target the Data Source screen, select the server on which to deploy the JDBC data source and 
click Create.

6. On the JDBC Data Sources screen, select the data source you created.

7. Click the Target and Deploy tab and click Apply.

8. Restart WebLogic.

Configuring JMS Resources for WebLogic
This section applies to LiveCycle Form Manager, LiveCycle PDF Generator, LiveCycle Workflow, or 
Watched Folder only. 

You must configure JMS Resources for WebLogic by performing the following tasks:

● Configure JMS connection factories. 

● Configure a persistent JMS store

● Configure a JMS server

● Set up JMS queues

● Set up JMS topics
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➤ To configure JMS connection factories:

1. In the WebLogic Server Administration Console navigation tree, select Services > JMS > Connection 
Factories and select Configure a new JMS Connection Factory.

2. On the JMS Connection Factory screen, type a Name and JNDI Name for the JMS connection factories 
listed in the table below. 

(LiveCycle Workflow, Watched Folder, LiveCycle Form Manager)

(LiveCycle PDF Generator)

3. Accept the defaults for the remaining settings on the screen, and then click Create. 

4. Click the Configuration tab, click the Transactions tab, select XA Connection Factory Enabled, and 
then click Apply.

5. Click the Target and Deploy tab, select the server to deploy the connection factory to, and then click 
Apply.

6. Restart the application server.

➤ To configure a persistent store:

1. In the navigation tree, select Services > JMS > Stores and select Configure a New JMS JDBC Store. 

2. On the screen that appears, type in the Name box the name of the JMS JDBC Store, for example 
IDP_JMSStore. 

3. From the Connection Pool list, select the connection pool you created earlier.

4. In the Prefix Name box, type jms, and then click Create.

Topic connection factory JNDI name

IDPQueueConnectionFactory IDPQueueConnectionFactory

IDPTopicConnectionFactory IDPTopicConnectionFactory

RegistryConnectionFactory RegistryConnectionFactory

AdobeQueueConnectionFactory QueueConnectionFactory

(Watched Folder only) 
WFTopicConnectionFactory

(Watched Folder only) 
WFTopicConnectionFactory

Topic connection factory JNDI name

AESQueueConnectionFactory jms/QueueConnectionFactory

AESTopicConnectionFactory jms/TopicConnectionFactory



Adobe LiveCycle Manually Configuring WebLogic
Installing and Configuring LiveCycle for WebLogic  Configuring JMS Resources for WebLogic     73

➤ To configure a paging store:

1. Create a physical directory on your server and name it PagingFileStore.

2. In the navigation tree, select Services > JMS > Stores and select Configure a New JMS File Store.

3. On the Create a New JMS File Store screen, type in the Name box a name for the JMS file store.

4. In the Directory box, type the full path to the paging directory you created in step 1 and then click 
Create.

➤ To configure a JMS server:

1. In the navigation tree, select Services > JMS > Servers and select Configure a New JMS Server. 

2. On the screen that appears, type in the Name box the name of the JMS Server, for example 
IDP_JMSServer.

3. From the Persistent Store list, select the persistent store you created in step 4 above.

4. From the Paging Store list, select the paging store you created in step 4, and then click Create. 

5. Click the Target and Deploy tab, select the server and click Apply. 

➤ To set up JMS queues:

1. In the navigation tree, select Services > JMS > Servers > [new_server] > Configure Destinations and 
select Configure a new JMS Queue. ([new_server] is the JMS server you just created.)

Note: For LiveCycle PDF Generator, [new_server] is WSStoreForwardInternalJMSServermyserver. 

2. Create the following JMS queues by completing steps 3 for each queue.

(LiveCycle Workflow, LiveCycle Form Manager)

(LiveCycle PDF Generator)

JMS queue name JNDI name

adobe_ObjectDeletionQueue adobe_ObjectDeletionQueue

adobe_PEDCommandQueue adobe_PEDCommandQueue

adobe_PECommandQueue adobe_PECommandQueue

adobe_PEDLongLivedQueue adobe_PEDLongLivedQueue

adobe_PELongLivedQueue adobe_PELongLivedQueue

adobe_PEScheduledMsgQueue adobe_PEScheduledMsgQueue

JMS queue name JNDI name

AESJobQueue queue/AESJobQueue

PDFGCompletedJobsQueue queue/PDFGCompletedJobsQueue
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3. On the Create a new JMS Queue screen, type one of the queue names listed in step 2 in the Name and 
JNDI Name boxes, accept the defaults for all of the remaining options on the screen, and then click 
Create.

4. In the navigation tree, select Services > JMS > Servers > [new_server] > Configure Destinations and 
click adobe_PECommandQueue.

5. Click the Redelivery tab and, in the Redelivery Limit box, type: 5

6. In the Error Destination menu, select adobe_PEDCommandQueue and click Apply.

7. In the navigation tree, select Services > JMS > Servers > [new_server] > Destinations and click 
adobe_PELongLivedQueue.

8. Click the Redelivery tab and, in the Redelivery Limit box, type: 5

9. In the Error Destination menu, select adobe_PEDLongLivedQueue and click Apply.

10. (LiveCycle PDF Generator) In the navigation tree, select Services > JMS > Servers > [new_server] > 
Configure Destinations > AESJobQueue.

11. (LiveCycle PDF Generator) Click the Redelivery tab, and in the Redelivery Limit box, type 0 and click 
Apply.

12. Restart the application server.

➤ To set up JMS topics:

1. In the navigation tree, select Services > JMS > Servers > [new_server] > Configure Destinations and 
select Configure a new JMS Topic.

2. Create the following JMS topics by completing steps 3 to 5 for each topic.

(LiveCycle Workflow, Watched Folder, LiveCycle Form Manager)

(LiveCycle PDF Generator)

JMS topic name JNDI name

adobe_RegistryCacheMonitorTopic topic/adobe_RegistryCacheMonitorTopic

adobe_POFObjectTopic adobe_POFObjectTopic

adobe_POFSchemaTopic adobe_POFSchemaTopic

adobe_ProcessEventTopic adobe_ProcessEventTopic

adobe_TaskEventTopic adobe_TaskEventTopic

adobe_TemplateEventTopic adobe_TemplateEventTopic

(for Watched Folder only) 
WatchedFolderConfigManagerTopic

(for Watched Folder only) 
topic/WatchedFolderConfigManagerTopic

JMS topic name JNDI name

AESConfigUpdatesTopic topic/AesConfigUpdatesTopic
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3. On the Create a new JMS Topic screen, type one of the topic names listed in step 2 in the Name and 
JNDI Name boxes, accept the defaults for all of the remaining options, and then click Create.

4. (All products except LiveCycle PDF Generator) Configure the queue and topic throttling by clicking the 
Thresholds & Quotas tab and ensuring the following properties have the specified values:

● Messages Threshold High: 2000 

● Messages Threshold Low: 500 

● Messages Paging Enabled: true 

5. Click Apply and save your changes.

6. Restart the application server.

Next step
If you are installing and configuring LiveCycle Workflow and plan to install and configure BAM Server as 
well, you must now manually configure WebLogic for use with BAM Server. (See “Manually Configuring 
BAM Server for WebLogic” on page 90.)

If you are not installing LiveCycle Workflow, you must now deploy the products to the application server 
database. (See “Deploying to WebLogic” on page 77.)
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8 Manually Deploying to WebLogic

This chapter describes how to configure the WebLogic Server for LiveCycle products and deploy the 
LiveCycle applications:

● “About deploying LiveCycle products” on page 76

● “Deploying to WebLogic” on page 77

● “Viewing log files” on page 78

About deploying LiveCycle products
Before you deploy LiveCycle products, ensure that you have met the following requirements:

● You have installed the required software and files and know the location of the directories you will be 
working with. (See “System requirements” on page 13.)

● You have run Configuration Manager to configure and assemble the products according to your 
system and application server requirements. If you need to make any further changes to the properties 
after deployment, you can run Configuration Manager to make the changes, and then redeploy the 
updated EAR file. (See “Configuring LiveCycle Products for Deployment” on page 62.)

If you are deploying the products for the first time, you must initialize the database after you deploy the 
product. (See “Initializing the Database” on page 79.)

If you have a web server installed, see your web server documentation for information on the 
configuration required to allow access to the application server.

This chapter uses the following naming conventions for common file paths.

● BEA_HOME - Refers to the BEA install directory. For example, the directory is C:\bea (Windows) or 
opt/bea (Linux and UNIX).

● [appserver root] - Refers to the WebLogic Server home directory, BEA_HOME/weblogic81.

● [appserverdomain] - Refers to the configured domain. The default domain is 
BEA_HOME/user_projects/domains/mydomain.

● [LiveCycle root] - Refers to the location where LiveCycle products and components are installed.

Summary of deployable components

This table lists the deployable components for LiveCycle products.

Component LiveCycle product

adobe-FontManager.ear All

LCM.ear All

LiveCycle.ear All

adobe-printSubmitter.ear LiveCycle Print



Adobe LiveCycle Manually Deploying to WebLogic
Installing and Configuring LiveCycle for WebLogic  Deploying to WebLogic     77

Note: For information about deploying FormsIVS.ear, see “Verifying the LiveCycle Forms deployment” on 
page 55.

Deploying to WebLogic
Before deploying LiveCycle products to WebLogic, ensure that the application server is preconfigured 
based on your requirements. You must create a domain and, if you are deploying in a run-time 
environment, create at least one Managed Server within the domain. 

➤ To deploy LiveCycle products to WebLogic:

1. Start the Administration Server and the Managed Server.

2. Copy the following modules from the [LiveCycle root]/configurationManager/export directory to the 
[appserverdomain]/applications directory:

● adobe-FontManager.ear

● LiveCycle.ear

● (LiveCycle Print) adobe-printSubmitter.ear 

● (LiveCycle Assembler) adobe-Assembler7.ear 

● (LiveCycle PDF Generator Professional, LiveCycle PDF Generator Elements) pdfg-all.ear 

● (LiveCycle PDF Generator for PostScript) pdfg-ps-all.ear

3. Copy the LCM.ear file from the [LiveCycle root]/configurationManager/deploy/weblogic directory to the 
[appserverdomain]/applications directory.

4. Start WebLogic Server Administration Console by typing http://localhost:7001/console in 
the URL line of a web browser. 

5. In the navigation tree, select Deployments > Applications > Deploy a New Application.

6. On the page that appears, click the applications directory, select the module to deploy (for example, 
adobe-FontManager.ear or LCM.ear), and then click Target Application. 

7. On the Select targets for this application page, select the servers on which this module will be 
deployed, and then click Continue.

8. On the page that appears, in the Source Accessibility area, select Copy this application onto every 
target for me.

adobe-Assembler7.ear LiveCycle Assembler

FormsIVS.ear LiveCycle Forms

pdfg-all.ear LiveCycle PDF Generator Professional 
and LiveCycle PDF Generator Elements

pdfg-ps-all.ear LiveCycle PDF Generator for PostScript

Component LiveCycle product
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9. Under Identity in the Name box, type _appsdir_defaultname_ear and click Deploy. The 
defaultnames are listed below. A new panel appears displaying the status of the deployment.

● adobe-FontManager.ear: Font_Manager_Module

● LiveCycle.ear: LiveCycle

● adobe-printSubmitter.ear: Adobe_LiveCycle_Print

● adobe-Assembler7.ear: adobe-Assembler7

● pdfg-all.ear: pdfg-all

● pdfg-ps-all.ear: pdfg-ps-all

● LCM.ear: LCM

10. Complete steps 5 to 8 for each deployable component for your installed products. (See “Summary of 
deployable components” on page 76.)

11. In the navigation tree, select Deployments > Applications. 

12. On the Configuration screen, click the name of each file, and then set the Load Order for the file as 
follows: 

● LiveCycle.ear = 10

● LCM.ear = 20

● adobe-FontManager.ear = 30

● adobe-printSubmitter.ear = 30

● adobe-Assembler7.ear = 40

● pdfg-ps-all.ear = 40

● pdfg-all.ear = 40

Note: For LiveCycle Assembler, you must set the Load Order value for each file to 100.

13. (Solaris) Edit the config.xml file in the [appserverdomain] directory by adding a forward slash (/) to the 
application path:

/home/aes/bea/user_projects/.... 

14. Restart WebLogic.

Viewing log files
Events, such as run-time or startup errors, are recorded to the application server log files. If you have any 
problems deploying to the application server, you can use the log files to help you find the problem. You 
can open the log files using any text editor.

Domain log files are located in the [appserverdomain] directory, and server log files are located in the 
[appserverdomain]/[appserver name] directory.

Next step
You must now initialize the database using Configuration Manager. (See “Initializing the Database” on 
page 79.)
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9 Initializing the Database

This chapter describes how to manually initialize the LiveCycle database. 

If you are using User Management with LiveCycle products, you must run Configuration Manager to 
initialize the database for integration with User Management. When you run Configuration Manager, the 
application server must be running. Initializing the database is a process that prepares a database for use 
with LiveCycle products by creating tables and optionally adding data to them. You only need to initialize 
the database the first time you deploy the product. 

During database initialization, provide an SSL-enabled port only if the application server has trusted SSL 
certificates. If the application server does not have trusted SSL certificates, a non-SSL enabled port must be 
provided to complete database initialization. (See “Configuring SSL on WebLogic” on page 84.)

This chapter assumes that you have configured the Livecycle database for integration with the product 
and have deployed the product to the application server. If you have not done this, see “Preparing Your 
Environment” on page 26 and “Manually Deploying to WebLogic” on page 76. 

➤ To initialize the database:

1. Start the application server.

2. Start Configuration Manager by navigating to the [LiveCycle root]/configurationManager directory and 
entering the following command:

● (Windows) ConfigurationManager.exe

● (Linux, UNIX) ConfigurationManager.bin

3. On the Welcome screen, click Next.

4. On the Configuration Mode screen, select Custom Configuration Wizard and click Next.

5. If prompted, on the Configuration Preferences screen, select either Use Previously Entered Values or 
Revert to Default Values, and then click Next.

6. On the Product Selection screen, select Foundation, select the products that you want to configure 
and deploy, and then click Next.

7. On the Task Selection screen, select Bootstrap database and click Next.

Note: You must only select the Bootstrap database; no other options are required.

8. On the Java Home Selection screen, specify the home directory of the Java Development Kit (JDK) that 
is used to run the application server, and then click Next. 

For example, the directory is C:\bea\jdk142_08 on Windows and /opt/bea/jdk142_08 on Linux and 
UNIX.
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9. On the Application Server Configuration Details screen, specify values for the following properties, and 
then click Next:

● Deploy Type: Specifies whether you are deploying to a standalone computer or to a cluster. Select 
Standalone.

● Remote Server: Select this option only if the application server is running on a different computer 
than the computer that is running Configuration Manager.

● Hostname: The fully qualified name or IP address of the computer that hosts the application server.

● Admin Port: The port used to provide access to the administration service on the application 
server. The default port is 7001.

● Server Instance Name: The name of the application server that you want to configure. The name of 
the default server instance that is created upon installing the application server is server1.

● Username and Password: (Optional) If the application server requires user credentials to perform 
administration tasks, the user name and password of an application server administration account.

● Local Application Server Root Directory: The root directory of the application server installation 
on the computer that is running Configuration Manager. For example, the directory is 
C:\bea\weblogic81 (Windows) or /opt/bea/weblogic81 (Linux and UNIX).

Caution: The Remote Server property cannot be used to configure LiveCycle PDF Generator Professional 
or LiveCycle PDF Generator Elements because Acrobat cannot be installed remotely. However, 
the property can be used to configure LiveCycle PDF Generator for PostScript.

10. On the Application Server URL screen, type the URL that Configuration Manager can use to connect to 
the application server in the Application Server Base URL box, and then click Next. The URL must be 
in the following format:

http://[host name]:[port]

where [host name] is the fully qualified domain name or IP address of the computer that hosts the 
application server, and [port] is the HTTP service port that the application server uses. (for example, 
http://localhost:8001). 

11. On the Prepare database for LiveCycle screen, click Next.

12. On the Deploy LCM.ear screen, click Next.

13. On the Database Initialization screen, click Initialize Database Now and, when the task is complete, 
click Next.

14. On the Tasks Completed screen, click Finish.

Next step
You can now access User Management and Administrator. (See “Post-deployment” on page 53.) 

You can also configure LiveCycle products to access LDAP. (See “Configuring LiveCycle Products to Access 
LDAP” on page 82.)

If you are using LiveCycle Workflow, you can now install LiveCycle Workflow Designer. (See “Installing 
LiveCycle Workflow Designer” on page 106.)
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Part III: Post-Deployment Configuration

This section of the guide describes the additional configuration tasks that you need to perform after 
LiveCycle products are deployed to the application server and the LiveCycle database is initialized.
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10 Configuring LiveCycle Products to Access LDAP

This chapter describes how to configure LiveCycle products with LDAP or LDAP over SSL (LDAPS).

● “Configuring LiveCycle products with LDAP” on page 82

● “Configuring LiveCycle products with LDAPS” on page 83

Caution: If you are installing and deploying more than one LiveCycle product, you must consult the 
appropriate Installing and Configuring guide to obtain specific SSL and security settings for each 
of the LiveCycle products you have installed.

Configuring LiveCycle products with LDAP
Use the following procedure as a guideline when configuring User Management to support 
authentication using LDAP.

➤ To configure User Management with LDAP:

1. Open a web browser, navigate to http://[host name]:[port]/adminui, and log in. (See 
“Accessing Administrator” on page 53.)

2. Select Settings > User Management > Domain Management and click New Domain.

3. In the ID box, type a unique identifier for the domain. 

4. In the Name box, type a descriptive name for the domain. 

5. Click Add Authentication and, in the Authentication Provider list, select LDAP.

Note: JAAS has been deprecated for User Management in LiveCycle 7.2.

6. Click OK.

7. Click Add Directory.

8. Under Populate Page With, select a directory settings option such as Default Sun ONE values.

9. Specify values in the Server, Port, SSL and Binding boxes as required. For details on the settings, see 
Directory settings in the online help. 

10. Configure the User Settings and Group Settings as required. For details on the settings, see Directory 
settings in the online help.

11. (Optional) Test your configuration:

● Click Test.

● On the Test Directory pane, in the Find box, enter an object name and, in the using box, select the 
object’s type, such as Login ID. 

● Click Test. If successful, your object’s details will be displayed, then click Back.

12. Click OK to exit the Add Directory page, and click OK again to exit.
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Configuring LiveCycle products with LDAPS
Use the following procedure as a guideline when configuring User Management to support 
authentication using LDAPS.

➤ To configure User Management with LDAPS:

1. Enable SSL on the directory server. For details, see the documentation provided by your directory 
vendor.

2. Export a client certificate from the directory server.

3. Use the keytool program to import the client certificate file into the default JVM certificate store. The 
procedure for this varies depending on your JVM and client install paths. For example, if you are using 
JDK 1.4.2, from a command prompt, type the following code:

keytool -import -file client_certificate -alias myalias -keystore
BEA_HOME/jdk142_08/jre/lib/security/cacerts

When prompted, enter the password (for Java, the default password is changeit). You will receive a 
message stating that the certificate was imported successfully.

4. Enable SSL in User Management. To access the User Management settings, select Settings > User 
Management in the Administrator pages. When configuring the directory settings, select Yes for the 
SSL property, and change the Port property accordingly. The default port number is 636.

Troubleshooting

If you experience problems when using SSL, use an LDAP browser to check whether it can access the LDAP 
system when using SSL. If the LDAP browser cannot access the LDAP system, the issue is related to the 
configuration of your certificate and application server. If the LDAP browser can access the LDAP system, 
User Management is not configured properly. 
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11 Configuring SSL on WebLogic

This chapter describes how to create SSL credentials and configure SSL on the application server to 
enhance the security of communication with your application server.

Note: It is recommended that you complete the installation, configuration and deployment of your 
LiveCycle products and ensure that the products are running correctly before configuring SSL on 
the application server. 

It is important to ensure that the security settings configured on the application server and in the 
LiveCycle.ear file are consistent.

Caution: If you are installing and deploying more than one LiveCycle product, you must consult the 
appropriate Installing and Configuring guide to obtain specific SSL and security settings for each 
of the LiveCycle products you have installed.

If you have not already enabled SSL in the Data Manager Module (assembled as part of the LiveCycle.ear 
file), run Configuration Manager to reconfigure and reassemble the products with SSL enabled, and then 
redeploy the LiveCycle.ear file. The SSL password that you specify in Configuration Manager must match 
the password that you provide when configuring SSL on the application server. (See “Configuring 
LiveCycle Products for Deployment” on page 62.)

To configure SSL on the application server, you must perform the following tasks:

● “Creating an SSL Credential” on page 84

● “Configuring SSL on WebLogic” on page 87

Creating an SSL Credential
To configure SSL on WebLogic, you need an SSL credential for authentication. You can use the IBM Key 
Management tool that is installed with Java keytool to perform the following tasks to create a credential:

● Create a public/private key pair, wrap the public key in an X.509 v1 self-signed certificate that is stored 
as a single-element certificate chain, and then store the certificate chain and the private key in a new 
keystore. This is the application server’s Custom Identity keystore.

● Extract the certificate and insert it into a new keystore. This is the application server’s Custom Trust 
keystore.

The keytool command is typically located in the Java jre/bin directory and must include several options 
and option values, which are listed in the following table.

Keytool option Description Option value

-alias The alias of the keystore. ● Custom Identity keystore: ads-credentials

● Custom Trust keystore: bedrock

-keyalg The algorithm to use to 
generate the key pair.

RSA

You can use a different algorithm, depending on 
your company’s policy.
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 For more information about using the keytool command, see the keytool.html file that is part of your JDK 
documentation.

-keystore The location and name of the 
keystore file.

The location can include the 
absolute path of the file, or can 
be relative to the current 
directory of the command 
prompt where the keytool 
command is entered.

● Custom Identity keystore: 
[appserverdomain]/adobe/[server 
name]/ads-ssl.jks

● Custom Trust keystore: 
[appserverdomain]/adobe/[server 
name]/ads-ca.jks

-file The location and name of the 
certificate file.

ads-ca.cer

-validity The number of days that the 
certificate is considered valid.

3650

You can use a different value, depending on your 
company’s policy.

-storepass The password that protects the 
contents of the keystore. 

Custom Identity keystore: The keystore password 
must correspond with the SSL credential password 
that was specified for the Data Manager Module 
using Configuration Manager.

Custom Trust keystore: Use the same password that 
you used for the Custom Identity keystore.

-keypass The password that protects the 
private key of the key pair.

Use the same password that you used for the 
-storepass option. The key password must be at 
least 6 characters in length.

-dname The distinguished name that 
identifies the person who owns 
the keystore.

"CN=[User name],OU=[Group Name], 
O=[Company Name], L=[City Name], 
S=[State or province], C=[Country 
Code]"

● [User name] is the identification of the user 
who owns the keystore.

● [Group Name] is the identification of the 
corporate group to which the keystore owner 
belongs.

● [Company Name] is your organization’s name.

● [City Name] is the city in which your 
organization is located.

● [State or province] is the state or 
province in which your organization is located.

● [Country Code] is the two-letter code for the 
country in which your organization is located.

Keytool option Description Option value
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➤ To create the Custom Identity and Trust keystores: 

1. From a command prompt, navigate to [appserverdomain]/adobe/[server name].

2. Enter the following command:

[JAVA_HOME]/bin/keytool -genkey -v -alias ads-credentials -keyalg RSA
-keystore "ads-credentials.jks" -validity 3650 -storepass store_password
-keypass key_password -dname "CN=User ID, OU=Group Name, O=Company Name,
L=City Name, S=State,C=Country Code"

Note: You must replace [JAVA_HOME] with the directory where the JDK is installed, and replace the 
text in bold with values that correspond with your environment.

The keystore file is created in the [appserverdomain]/adobe/[server name] directory. 

3. Extract the certificate from the ads-credentials keystore by entering the following command:

[JAVA_HOME]/bin/keytool -export -v -alias ads-credentials 
-file "ads-ca.cer" -keystore "ads-credentials.jks" 
-storepass store_password

Note: You must replace [JAVA_HOME] with the directory where the JDK is installed, and replace 
store_password with the password for the Custom Identity keystore.

The certificate file is created in the [appserverdomain]/adobe/[server name] directory. 

4. Copy the ads-ca.cer file to any host computers that need secure communication with the application 
server.

5. Navigate to the directory where you created ads-ca.cer and enter the following commands:

[JAVA_HOME]bin>keytool -import -file ads-ca.cer -keystore 
[JAVA_HOME]\jr e\lib\security\cacerts

Note: You must replace [JAVA_HOME] with the directory where the JDK is installed.

6. Enter changeit when prompted for a password.

7. Enter yes when prompted to trust the certificate. A response confirms successful addition of the 
certificate.

8. Insert the certificate into a new keystore file (the Custom Trust keystore) by entering the following 
command:

[JAVA_HOME]/bin/keytool -import -v -noprompt -alias bedrock 
-file "ads-ca.cer" -keystore "ads-ca.jks" -storepass store_password
-keypass key_password

Note: You must replace [JAVA_HOME] with the directory where the JDK is installed and replace 
store_password and key_password with your own passwords.

The keystore file is created in the [appserverdomain]/adobe/[server] directory.
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 Configuring SSL on WebLogic
You need to configure WebLogic so that it uses the Custom Identity keystore and Custom Trust keystore 
that you created. You also need to disable the WebLogic Hostname Verification feature because the 
distinguished name used to create the keystore files did not include the name of the computer that hosts 
WebLogic.

Note: You must configure SSL on the Managed Server, Node Manager, and Administrative Server. Use the 
same identity and trust store for each server.

➤ To configure WebLogic to use SSL:

1. Start the WebLogic Server Administration Console by typing 
http://[host name]:7001/console in the URL line of a web browser. 

2. In the navigation tree, select Servers > [server] > Configuration > General.

3. Ensure that Listen Port Enabled and SSL Listen Port Enabled are selected. 

4. If this server is a Managed Server, change Listen Port to an unused port value (such as 8001) and 
SSL Listen Port to an unused port value (such as 8002). On a stand-alone server, the default SSL port is 
7002.

5. Click Apply on the lower right. 

6. Select Configuration > Keystores & SSL.

7. On the Keystore Configuration page, click Change, select Custom Identity And Custom Trust in the 
list, and then click Continue.

8. Under Custom Identity, specify the following values as:

● Custom Identity Key Store File Name: [appserverdomain]/adobe/[server name]/ads-credentials.jks, 
where [appserverdomain] is the actual path and [server name] is the name of the application server.

● Custom Identity Key Store Type: JKS

● Custom Identity Key Store Pass Phrase: mypassword

● Confirm Custom Identity Key Store Pass Phrase: mypassword

9. Under Custom Trust, specify the following values as:

● Custom Trust Key Store File Name: [appserverdomain]/adobe/[server]/ads-ca.jks, where 
[appserverdomain] is the actual path

● Custom Trust Key Store Type: JKS

● Custom Trust Key Store Pass Phrase: mypassword

● Confirm Custom Trust Key Store Pass Phrase: mypassword

10. Click Continue and specify the following values as:

● Private Key Alias: ads-credentials

● Passphrase: mypassword

● Confirm Passphrase: mypassword

11. Click Continue, and then click Finish.
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➤ To disable the Hostname Verification feature:

1. In Advanced Options on the Keystore & SSL page, click the Show link and set Hostname Verification 
to None. 

If Hostname Verification is not disabled, the CN must contain the server host name.

2. Click Apply to save your changes.

3. Stop the application server.

4. Open a command prompt window on the application server and navigate to the [appserver root]/
weblogic81/common/nodemanager directory. 

5. Open the nodemanager.properties file and add (or modify if already present) the following entries:

CustomTrustKeyStorePassPhrase: <password> 

KeyStores: CustomIdentityAndCustomTrust 

CustomIdentityKeyStoreFileName: [appserver root]/user_projects/domains/
mydomain/adobe/Server1/ads-credentials.jks 

CustomIdentityKeyStorePassPhrase: <password> 

CustomTrustKeyStoreType: JKS 

CustomIdentityAlias: ads-credentials 

CustomTrustKeyStoreFileName: [appserver root]/user_projects/domains/
mydomain/adobe/Server1/ads-ca.jks 

CustomIdentityPrivateKeyPassPhrase: <password> 

CustomIdentityKeyStoreType: JKS 

6. Save the nodemanager.properties file.

7. Open the startWebLogic.sh file and append the following line to the JAVA OPTIONS:

-Dweblogic.webservice.client.ssl.strictcertchecking=false

8. Save the startWebLogic.sh file.

9. Restart the application server.

Next step
If you are installing LiveCycle Workflow Business Activity Monitor, you can now configure an application 
server for hosting BAM Server. (See “Manually Configuring BAM Server for WebLogic” on page 90.) You can 
also install LiveCycle Workflow Designer. (See “Installing LiveCycle Workflow Designer” on page 106.)



     89

Part IV: Additional LiveCycle Workflow Configuration

This section of the guide describes the additional configuration required for LiveCycle Workflow 
installations.
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12 Manually Configuring BAM Server for WebLogic

This chapter only applies to LiveCycle Workflow licenses that permit the use of 
Business Activity Monitor. 

This chapter describes how to create the BAM metadata database, configure a WebLogic application 
server for BAM Server, and deploy BAM Server. BAM Server is a component of LiveCycle Workflow. 

This chapter assumes that you have configured the LiveCycle database. If you have not done this, see 
“Preparing Your Environment” on page 26.

Creating the BAM metadata database
You must create a LiveCycle Workflow Business Activity Monitor metadata database to store the 
definitions of the process metrics that BAM Server monitors, as well as the details of any alerts and object 
run-time data that need to be persisted to disk.

Because Business Activity Monitor metadata can grow quite large, you must allocate at least 50 MB for the 
BAM metadata database. For production deployments, allocate at least 200 MB.

BAM Server can require specific settings for some aspects of the Business Activity Monitor metadata 
database configuration. The settings depend on the type of application server that is hosting BAM Server 
and the type of database server used to store the Business Activity Monitor metadata.

User accounts

You must also create a user account that BAM Server can use to connect to the Business Activity Monitor 
metadata database. The user account must have create, modify, and update privileges on the database.

For Oracle, the database user account must be associated with a tablespace that you create specifically for 
Business Activity Monitor metadata.

Configuring WebLogic for BAM Server
If you are installing LiveCycle Workflow and manually deploying to WebLogic, you must manually 
configure a separate WebLogic Server so that BAM Server runs correctly. You must perform the following 
tasks:

● If you have not already done so, create a separate WebLogic domain for hosting BAM Server. (See 
“Creating the WebLogic Server domain” on page 29.)

● Install the database driver files that you require to communicate with the BAM metadata database and 
the LiveCycle database. (See Installing database drivers for BAM Server.)

● Configure the connection to the BAM metadata database. (See “Configuring the connection to the 
BAM metadata database” on page 91.)

● Configure the connection to the LiveCycle database. (See “Configuring the connection to the LiveCycle 
database” on page 93.)

● Modify the WebLogic JVM. (See “Configuring the WebLogic JVM” on page 94.)
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Installing database drivers for BAM Server

You must install the database drivers that BAM Server requires to communicate with the BAM metadata 
database and the LiveCycle database:

● For connecting to the BAM metadata database for SQL Server, you must install the Microsoft drivers. 
For other database types, BAM Server uses the default drivers that you installed for WebLogic in 
“Installing database drivers” on page 32.

● For connecting to the LiveCycle database, you must install the driver for the type of database that 
stores LiveCycle data. 

Note: LiveCycle Workflow Server and BAM Server use the Oracle 10g driver. You may have already 
installed the Oracle driver when you configured WebLogic for LiveCycle Workflow Server. (See 
“Installing database drivers” on page 32.)

➤ To install the Oracle database driver file:

1. From a browser, navigate to 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_10201.html

2. Under Oracle Database 10g Release 2 (10.2.0.1.0) JDBC Drivers, download the ojdbc14.jar file.

3. Replace the ojdbc14.jar file in the [appserver root]/server/lib directory with release 2 driver you just 
downloaded. 

➤ To install the SQL Server database driver files:

1. Download SQL Server 2000 Driver for JDBC for SQL Server 2000 SP3a from www.microsoft.com, and 
install the driver on the computer that runs the application server.

2. Copy the msbase.jar, mssqlserver.jar, and msutil.jar files from where you installed SQL Server 2000 
Driver for JDBC to the [appserver root]/server/lib directory.

3. Navigate to the BEA_HOME\user_projects\domains\[bam_domain_name] directory and open the 
WebLogic startup script file in a text editor:

● (Windows) startWebLogic.cmd

● (Linux and UNIX) startWebLogic.sh

4. (Windows) Add the following text to the set CLASSPATH command:

%WL_HOME%\server\lib\msbase.jar;%WL_HOME%\server\lib\mssqlserver.jar;
%WL_HOME%\server\lib\msutil.jar;

5. (Linux, UNIX) Add the following text to the CLASSPATH command:

${WL_HOME}/server/lib/msbase.jar:${WL_HOME}/server/lib/mssqlserver.jar:
${WL_HOME}/server/lib/msutil.jar:

6. Save and close the file.

Configuring the connection to the BAM metadata database

You must configure a data source on WebLogic for the BAM metadata database so that BAM Server can 
retrieve information about process metrics that it needs to monitor.

http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc_10201.html
http://www.microsoft.com
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➤ To create the connection to the BAM metadata database:

1. If WebLogic is not running, from a command prompt, navigate to the 
BEA_HOME\user_projects\domains\[domain_name] directory and enter the following command:

● (Windows) startWebLogic.cmd

● (Linux, UNIX) startWebLogic.sh

2. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console 
in the URL line of a web browser (for example, http://localhost:8001/console).

3. In the navigation tree, select Services > JDBC > Connection Pools and click Configure a New JDBC 
Connection Pool.

4. Under Database Type, select the type of database you are using to store BAM metadata.

5. Under Database Driver, select the appropriate database driver, and then click Continue: 

● (MS SQL Server) Microsoft MS SQL Server Driver (Type 4)

● (Oracle) Oracle’s Driver (Thin) versions 9.x, 10

6. Specify values for the following properties, and then click Continue:

● Name: A name for the pool.

● Database Name: The name of the database (SQL Server) or database instance (Oracle).

● Host Name: The network name or IP address of the database host computer.

● Database User Name: The name of a user account that can access the database.

● Password/Confirm Password: The password that corresponds with the user name you provided.

7. Click Test Driver Configuration.

8. On the Create and Deploy screen, click Create and deploy. 

9. In the navigation tree, select Services > JDBC > Connection Pools and select the connection pool you 
created.

10. Select Configuration > Connection and, in the Maximum Capacity box, type 200. Accept the default 
values for all of the remaining properties, and then click Apply.

11. Click Target and Deploy, select the appropriate server, and then click Apply.

12. In the navigation tree, select Services > JDBC > Data Sources and select Configure a new JDBC Data 
Source.

13. Specify the following values for the properties, and then click Continue:

● Name: com.celequest.metadata.metaDatasource 

● JNDI Name: com.celequest.metadata.metaDatasource

● Honour Global Transactions: Deselect this option

14. From the Pool Name list, select the connection pool you created for the BAM metadata database and 
click Continue.

15. Select the appropriate server and click Create.
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Configuring the connection to the LiveCycle database

You must configure a data source on WebLogic for the LiveCycle database so that BAM Server can retrieve 
LiveCycle Workflow run-time data.

➤ To create the connection to the LiveCycle database:

1. If WebLogic is not running, from a command prompt, navigate to the 
BEA_HOME\user_projects\domains\domain_name directory and enter the following command:

● (Windows) startWebLogic.cmd

● (Linux and UNIX) startWebLogic.sh

2. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console in 
the URL line of a web browser (for example, http://localhost:8001/console).

3. In the navigation tree, select Services > JDBC > Connection Pools and click Configure a New JDBC 
Connection Pool.

4. Under Database Type, select the type of database you are using to store LiveCycle data.

5. Under Database Driver, select the appropriate database driver, and then click Continue: 

● (MS SQL Server) Microsoft MS SQL Server Driver (Type 4)

● (Oracle) Oracle’s Driver (Thin) versions 9.x, 10

6. On the Define Connection Properties screen, specify values for the following properties, and then click 
Continue:

● Name: A name for the pool.

● Database Name: The name of the database (SQL Server) or database instance (Oracle).

● Host Name: The network name or IP address of the database host computer.

● Database User Name: The name of an administrator account that can access the database.

● Password/Confirm Password: The administrator’s password.

7. Click Test Driver Configuration.

8. On the Create and Deploy screen, click Create and deploy. 

9. In the navigation tree, select Services > JDBC > Connection Pools and select the connection pool you 
created.

10. Navigate to Configuration > Connection and, in the Maximum Capacity box, type 200. Accept the 
default values for all of the remaining attributes, and then click Apply.

11. Click Target and Deploy, select the appropriate server, and then click Apply.

12. In the navigation tree, select Services > JDBC > Data Sources and select Configure a new JDBC Data 
Source.

13. Specify the following values for the properties, and then click Continue:

● Name: com.celequest.adobe 

● JNDI Name: com.celequest.adobe

● Honour Global Transactions: Deselect
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14. Under Pool Name, select the connection pool you created for the LiveCycle database and click 
Continue.

15. Select the appropriate server and click Create.

Configuring the WebLogic JVM

You must configure the JVM properties to support BAM Server:

● For information about the JVM properties that you must set, see “Configuring required JVM properties” 
on page 94.

● For information about the JVM properties that you can set but are not mandatory, see “Optional JVM 
properties for BAM metadata properties” on page 95.

Configuring required JVM properties

You must configure the WebLogic JVM so that it can support BAM Server.

➤ To configure the WebLogic JVM:

1. If WebLogic is running, shut down the server:

● In the WebLogic Server Administration Console navigation tree, select Servers.

● Click the targeted server name in the right panel. This server is the same server domain created for 
this installation and deployment.

● On the page that appears, click the Control tab.

● Click Graceful shutdown of this server.

2. Navigate to the BEA_HOME/user_projects/domains/[domain_name] directory and open the WebLogic 
startup script file in a text editor by entering the following command: 

● (Windows) StartWebLogic.cmd

● (UNIX) StartWebLogic.sh

3. Locate and modify the set JAVA_HOME command and change the location to where the current Sun 
JDK is installed. By default, JAVA_HOME is set to the JDK that is installed with WebLogic (such as set 
JAVA_HOME=C:\bea\jdk142_05). 

The following is an example of the changed command in a Windows environment:

set JAVA_HOME=C:\j2sdk1.4.2_08

4. Add the following command to set the memory parameters:

● Windows:

set MEM_ARGS=-XX:MaxPermSize=128M -Xms96m -Xmx512m

● Linux and UNIX:

MEM_ARGS=-XX:MaxPermSize=128M -Xms96m -Xmx512m

Note: The memory settings used in the set MEM_ARGS command are recommended minimum values. 
You can set them to a higher value according to your system’s capacity.

5. Add the following line to the JAVA_OPTIONS environment variable to enable UTF-8 character support:

-Dfile.encoding=utf8
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6. Locate the JAVA_OPTIONS environment variable and add the commands to set the optional BAM 
metadata properties that you want to use. (See “Optional JVM properties for BAM metadata properties” 
on page 95.)

7. Save and close the startup script file.

Optional JVM properties for BAM metadata properties

You can set several optional JVM parameters that are related to the Business Activity Monitor metadata 
database, including language, country, and collation strength. These JVM parameters are expressed using 
commands in the following format:

-Dcom.celequest.property.[PARAMETER]=[VALUE]

This table provides valid values for [PARAMETER] and [VALUE].

To set multiple properties, separate each command with a space. For example, the following commands 
set the language to Portuguese and the locale to Brazil:

-Dcom.celequest.property.LANGUAGE=PT -Dcom.celequest.property.LOCALE=BR

Parameter Description 

LANGUAGE The ISO language code for the server. 

For example, the following command sets the LANGUAGE parameter to 
Portuguese:

-Dcom.celequest.property.LANGUAGE=PT

COUNTRY The ISO country code for the server. 

LOCALESORT This option specifies whether locale-sensitive string comparisons are performed. 
Valid values are true and false:

● Specify true if you want locale-sensitive string comparisons performed.

● Specify false if you do not want locale-sensitive string comparisons 
performed. 

The default value is false. 

STRENGTH The level of collation strength, which is the extent to which non-English 
characters are compared and collated. 

Valid values (in order of least discriminating to most discriminating) are primary, 
secondary, tertiary, and identical. The default value is tertiary.

For more information about collation parameters, see the Sun Java 
documentation at http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html.

Note: This setting is functional only if LOCALESORT is set to true. 

DECOMPOSITION The mode of collation decomposition. Valid values are none, canonical, and 
full. The default value is canonical.

For more information about collation parameters, see the Sun Java 
documentation at http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html 

Note: This setting is functional only if LOCALESORT is set to true. 

http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html
http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html
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Deploying BAM Server to WebLogic
You use WebLogic Server Administration Console to deploy the BAM Server EAR file to WebLogic. The 
BAM Server EAR file (CAS_Adobe.ear) file you need to deploy is installed in the 
[LiveCycle root]/components/bam/common directory.

After you deploy the BAM Server EAR file, you need to modify the configuration of the JDBC connection 
pool to increase its maximum capacity.

Note: Ensure that you deploy the EAR file to the WebLogic application server that you configured for 
BAM Server.

➤ To deploy BAM Server to WebLogic:

1. Start the Administration Server and, if applicable, the Managed Server. 

2. Start WebLogic Server Administration Console by typing http://[host name]:[port]/console in 
the URL line of a web browser (for example, http://localhost:8001/console).

3. In the navigation tree, select Deployments > Applications and click Deploy a new Application.

4. Click Upload your files, browse to the [LiveCycle root]/components/bam/common directory, select the 
CAS_Adobe.ear file, and then click Upload.

5. If more than one valid file path is displayed, select the most appropriate path.

6. Click Continue, and then click Deploy.

➤ To deploy the CQIntegration.ear file to WebLogic:

Note: The CQIntegration.ear is deployed to the server where LiveCycle is running.

1. Copy the CQIntegration.ear file from the [LiveCycle root]/components/bam/common directory to the 
[appserverdomain]/applications directory.

2. In the navigation tree, select Deployments > Applications and click Deploy a New Application.

3. On the page that appears, click applications, select CQIntegration.ear, and then click Target Application.

4. On the page that appears, select the server on which to deploy the module and click Continue.

5. The Review your choices and deploy panel appears, click Deploy.

6. In the navigation tree, select Deployments > Applications. On the Configuration screen, click the 
name of the file, and then set the Load Order for each file as follows: 

● LiveCycle.ear = 10

● LCM.ear = 20

● adobe-FontManager.ear = 30

● adobe-printSubmitter.ear = 30

● adobe-Assembler7.ear = 40

● pdfg-ps-all.ear = 40

● pdfg-all.ear = 40

● CQIntegration.ear = 50

Note: For LiveCycle Assembler, you must set the Load Order for each file to 100.
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7. (Solaris) Edit the config.xml file in the [appserverdomain] directory by adding a forward slash (/) to the 
application path:

/home/aes/bea/user_projects/.... 

8. Restart the application server.

Next step
You must now configure the BAM properties on LiveCycle Workflow Server and BAM Server. (See “Getting 
Started with BAM Server” on page 98.)
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13 Getting Started with BAM Server

This chapter describes how to perform the initial configuration of LiveCycle Workflow Server to enable 
BAM Server to monitor process activity. You must configure settings on both LiveCycle Workflow Server 
and BAM Server:

● “Configuring LiveCycle Workflow Server for BAM Server” on page 98 

● “Configuring BAM Server” on page 99 

Configuring LiveCycle Workflow Server for BAM Server
You can configure LiveCycle Workflow Server to connect to BAM Server using Administrator. You must 
specify the server on which BAM Server is running and the user account information with which to access 
BAM Server.

➤ To configure LiveCycle Workflow Server for BAM Server:

1. Log into Administrator. (See “Accessing Administrator” on page 53.)

2. Click Services, and then click Adobe LiveCycle Workflow.

3. Click Server Settings, and then click BAM Configuration Settings.

4. Specify values for the following properties:

● Host: The host name or IP address of the server on which BAM Server is running. The default value is 
localhost.

● Port: The service port of the application server on which BAM Server is running. The default value is 
the default port of the application server for which LiveCycle Workflow was installed. 

● User Name: (Optional) The user name of the administrator user account that LiveCycle Workflow 
Server uses to access BAM Server. The default user name is system. 

Note: If you specify the user name for a different user account, you must ensure that the user has 
complete administrative privileges for BAM Server. For information about administering BAM 
user accounts, see BAM Workbench Help or the Using LiveCycle Workflow Workbench guide.

● Password: (Optional) A valid password for the user name specified above. The default password is 
manager.

5. Click Save and restart the LiveCycle.ear.
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Accessing BAM Workbench and BAM Dashboard 
After BAM Server is deployed and running on the application server, you can access BAM Workbench and 
Business Activity Monitor (BAM) Dashboard through a web browser. BAM Workbench includes tools for 
administering BAM Server and for setting up reports that users view in BAM Dashboard.

A user name and password are required to log into the Business Activity Monitor pages. When you deploy 
BAM Server, a default administration account is created with the user name system and password 
manager.

Tip: You can create a different user for administration or modify the existing one using BAM Workbench. If 
you modify the existing one, you must change the corresponding properties on LiveCycle Workflow 
Server. (See “Configuring LiveCycle Workflow Server for BAM Server” on page 98.)

For information on using the tools provided with the administration framework, log into BAM Workbench 
and see the Help.

➤ To access BAM Workbench:

1. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser.

2. In the User Name box, type a valid user name, and in the Password box, type the associated password. 
You can use the default user name system, and the default password manager. 

➤ To access BAM Dashboard:

1. Start BAM Dashboard by typing http://[host name]:[port]/celequest/dashboard in the 
URL line of a web browser.

2. In the User Name box, type a valid user name, and in the Password box, type the associated password. 
You can use the default user name system, and the default password manager. 

Configuring BAM Server
You can configure BAM Server to monitor LiveCycle Workflow processes using BAM Workbench. (See 
“Accessing BAM Workbench and BAM Dashboard” on page 99.)

You need to use BAM Workbench to perform the following tasks:

● Configure the SMTP server settings for sending email messages.

● Import the metadata definitions used for monitoring LiveCycle Workflow processes.

● Start the JDBC agent.

● Configure the LDAP settings for BAM Server. 

Configuring the SMTP settings

BAM Server uses an SMTP server to send email messages to Business Activity Monitor users. You must 
specify the server on which the SMTP server is running and the user account information with which the 
BAM Server can access the SMTP server. 
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➤ To configure the SMTP settings:

1. Ensure that the LiveCycle Workflow Server and the BAM Server applications are started. 

2. Ensure that your BAM metadata database is started. 

3. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser. 

4. Log in using the user name and password that is configured for Business Activity Monitor 
administration. You can use the default user name system, and the default password manager. 

5. If this is your first time logging into BAM Workbench, the First Time Setup dialog box appears. If the 
dialog box appears, click Open System Settings, and then click the SMTP Configuration tab. 

6. Specify values for the following properties: 

● SMTP Host: The network name or IP address of the SMTP server that BAM Server uses to send email 
messages. 

● SMTP From Address: The email address that BAM Server uses to receive email messages. 

● SMTP User: The user name for the email account that BAM Server uses. 

● SMTP Password: The password that corresponds with the SMTP user. 

7. Select the Checkpoint Configuration tab, and in the Recovery Log Directory box, type the location 
of the recovery log directory.

8. Select the Logging tab, and in the Logging Directory box, type the location of the logging directory.

9. Click OK.

Importing LiveCycle Workflow metadata definitions

You must import LiveCycle Workflow metadata definitions to configure the process metrics that 
BAM Server monitors. Importing the LiveCycle Workflow metadata file creates the Adobe JDBC agent.

➤ To import LiveCycle Workflow metadata definitions:

1. Ensure that the LiveCycle Workflow Server and the BAM Server applications are running.

2. Ensure that the BAM metadata database is started.

3. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser.

4. Click the Administration Console tab, and then click Import/Export.

5. Select Import Metadata from a JAR file (upload) and type the full path to the location of the 
LiveCycle Workflow BAM metadata template that is appropriate for the type of database that you are 
using for the LiveCycle database:

● (SQL Server) adobeimport_SQLServer.jar

● (Oracle) adobeimport_Oracle.jar

These files are installed in the [LiveCycle root]/Workflow/bam/BAMAppTemplate directory.

6. Click OK.
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Starting the JDBC agent

You must start the JDBC agent named adobe.

➤ To start the JDBC agent:

1. Ensure that the LiveCycle Workflow Server and BAM Server applications are started.

2. Open BAM Workbench in a web browser. (See “Accessing BAM Workbench and BAM Dashboard” on 
page 99.)

3. Click the Administration Console tab and, in the left panel, select Agents.

4. In the Agents table, click the icon in the Status column to enable the agent called adobe.

5. When prompted, click Enable All to enable all dependent objects. The status should change to 
enabled.

Configuring LDAP settings for BAM Server

In addition to manually creating users and user permissions, Business Activity Monitor lets you to import 
user information from supported LDAP providers. You can schedule automatic synchronizations or 
perform manual synchronizations with the LDAP server to automatically update the existing users and 
roles.

When synchronizing with the LDAP server, the user base DN, login identification and password, full name, 
description, and email address properties are cached in the BAM metadata database.

When BAM Server imports users from the LDAP server, LDAP groups are converted to Business Activity 
Monitor roles. Users are assigned roles according to the group they belong to in LDAP. For more 
information, see “Limitations of BAM Server LDAP connectivity” on page 101.

Note: BAM Server integrates with any LDAP provider that supports LDAP version 3 protocol. 

Limitations of BAM Server LDAP connectivity

The following limitations apply to the BAM Server connectivity with the LDAP server: 

● You can configure a connection to only one LDAP server.

● BAM Server creates roles based on groups that are defined on the LDAP server. When BAM Server 
encounters a group for which a role is not yet created, it creates the role and assigns it a set of zero 
permissions. You can later modify the permissions as required. (See “Configuring LDAP role mapping” 
on page 104.)

● If BAM Server imports a user and the user does not belong to a group to which a Business Activity 
Monitor role corresponds, the user is created but remains unassigned to any roles. 

● You cannot change the role that a user is assigned to if the user is imported from the LDAP server. Role 
assignments for imported users can be accomplished by making changes to the LDAP server. However, 
you can assign manually-created users to roles that are created based on LDAP groups. 
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Best practices for BAM Server LDAP connectivity

When setting up the BAM Server connectivity with the LDAP server, it is strongly recommended you 
adhere to the following best practices: 

● If the connection to the LDAP server is not secure, you should use SSL.

● For authentication, Simple Authentication and Security Layer (SASL) is the recommended method and 
is well supported by LDAP. 

● For security reasons, the access permissions of the LDAP synchronization user should be limited to 
querying the LDAP server. For more information on the synchronization user, see “Configuring 
automatic LDAP synchronization” on page 102.

Caution: The password for this user is stored in the BAM Server metadata using reversible symmetric 
encryption. Therefore, anyone with access to the metadata can obtain this password. 

Configuring automatic LDAP synchronization 

You can schedule the automatic synchronization of BAM Server with the LDAP server. Synchronization 
ensures that the user accounts and role definitions that BAM Server caches in the BAM metadata database 
are up to date with the content of the LDAP server.

During synchronization, BAM Server creates new roles based on any new groups in the LDAP server and 
removes existing roles based on any groups that have been removed from the LDAP server since the 
previous synchronization. 

Note: Roles are removed even if users that were created manually are assigned to the roles. For these 
users, if the roles are removed due to synchronization, the user accounts still exist but are no longer 
assigned to the roles. 

➤ To configure automatic LDAP synchronization: 

1. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser.

2. Click the Administration Console tab, and then click System Settings.

3. Click the LDAP Synchronization tab. 

4. Select the LDAP Enabled option, if it is not already selected. 

5. Specify values for the following properties: 

● Initial Context Factory: The JNDI name through which BAM Server connects to the LDAP server. 
The default value is com.sun.jndi.ldap.LdapCtxFactory. You probably do not need to 
change this value.

● LDAP Server: The DNS name or IP address of the LDAP server.

● LDAP Port: The port on which the LDAP server is running. The default port is typically 389. 
However, if you select the SSL option, the default port is typically 636. You must confirm with your 
LDAP administrator which port to specify.

● LDAP SSL: Select this option if the LDAP server is configured to use SSL. Selecting this option may 
affect the LDAP Port setting. 
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● LDAP Authentication: The authentication method used by the LDAP server. Select one of the 
following options: 

● Simple

● SASL (Simple Authentication and Security Layer). Select this option for Sun ONE.

● Compare Encrypted Password 

● LDAP Principal DN Prefix: For the simple authentication method, the text you specify will be 
inserted before the user's login name:

● For LDAP servers that require DN login, set this to the appropriate property value followed by an 
equal sign (for example, cn= or uid=).

● For ActiveDirectory, leave this value blank.

● LDAP Principal DN Suffix: For the simple authentication method, the text you specify will be 
inserted after the user's login name:

● For LDAP servers that require DN login, set this to the appropriate chain of values. The first 
character of the suffix must be a comma (","). For example:

,ou=Users,dc=domain,dc=name

● For ActiveDirectory, which requires a simple login with an email address, set this to an at symbol 
(@) followed by the domain name that is set for ActiveDirectory.

● LDAP Synchronization User: The user that binds to the server and reads the lists of users and roles. 
For security purposes, you must specify a user account that can only read the LDAP directory.

● LDAP Synchronization Password: The password associated with the user specified for the LDAP 
Synchronization User option.

6. Click Test Connection. The connection and the user mapping and role mapping configuration are 
tested. If the connection settings are correct, a message will indicate that the connection was 
successful. If you have not yet configured LDAP User Mapping and LDAP Role Mapping, the message 
returns an error.

7. To set the LDAP Synchronization Schedule, use the Add Schedule, Edit Schedule, and Remove 
Schedule buttons to create the desired schedule. 

Note: You should set synchronization for a time when the fewest number of users are likely to be 
logged in. 

8. Click OK. 

Configuring LDAP user mapping 

You can configure the user mapping parameters that determine which users are imported and 
synchronized from the LDAP server. The parameters you specify depend on the LDAP server provider that 
you are using. 

➤ To configure the LDAP user mapping parameters:

1. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser.

2. Click the Administration Console tab, and then click System Settings.

3. Click the LDAP User Mapping tab. 
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4. Specify values for the following parameters: 

● LDAP User Base DN: The root of the tree that will be searched for users. For example: 

● (Sun ONE) OU=people,DC=your domain,DC=com 

● (Active Directory) CN=Users,DC=yourdomain,DC=com 

● LDAP User Search Filter: The format that is appropriate for the type of LDAP server you are using. 
For example, your LDAP server could have a special group for Business Activity Monitor users. This 
filter could then ensure that only users with this group membership are imported. 

● LDAP User LoginID: The login ID of the indicated provider. This value will become the user’s login 
ID in Business Activity Monitor. 

● LDAP User Full Name: Enter cn if you are using either Sun ONE or Active Directory. 

● LDAP User Description: Enter description if you are using either Sun ONE or Active Directory. 

● LDAP User PrimaryEmail: Enter userPrincipalName. This refers to the user’s email address in 
the LDAP directory. 

● LDAP User EncryptedPassword: Enter the password associated with the specified user if you are 
using either Sun ONE or Tivolie. Leave blank for Active Directory. 

5. Click the LDAP Synchronization tab and click Test Connection to see if the users are imported 
successfully.

6. Click OK. 

Configuring LDAP role mapping 

You can configure the role mapping parameters that determine which groups or roles are imported or 
synchronized, or both. The parameters you specify depend on the LDAP server provider that you are using. 

➤ To configure the LDAP role mapping parameters: 

1. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser.

2. Click the Administration Console tab, and then click System Settings. 

3. Click the LDAP Role Mapping tab. 

4. Specify values for the following parameters: 

● LDAP Role Base DN: The format that is appropriate for the type of LDAP server you are using: 

● (Sun ONE) OU=Groups,DC=your domain,DC=com 

● (Active Directory) CN=Users,DC=yourdomain,DC=com 

● LDAP Role Search Filter: The format that is appropriate for the type of LDAP server you are using: 

● (Sun ONE) (&(objectclass=groupOfUniqueNames))

● (Active Directory) (&(objectclass=group))

● LDAP Role LoginID: Enter cn if you are using either Sun ONE or Active Directory. 

● LDAP Role Full Name: Enter displayname if you are using either Sun ONE or Active Directory. 

● LDAP Role Description: Enter description if you are using either Sun ONE or Active Directory. 
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● LDAP Role Member: The name of the multivalued property that contains role members:

● (Sun ONE) uniqueMember 

● (Active Directory) member 

● LDAP Role Member is: Use one of the following options: 

● Distinguished Name, if the role member properties identify users by distinguished names, 
such as cn=jadmin,ou=people,dc=your domain,dc=com.

● Login identification, if the role member properties identify users by the value of the 
property used as the Business Activity Monitor login ID.

5. Click the LDAP Synchronization tab and click Test Connection to see if the users are imported 
successfully.

6. Click OK. 

Manually synchronizing with the LDAP server 

You can manually synchronize BAM Server with the LDAP server at any time. Synchronization requests are 
queued to prevent concurrent synchronizations. 

➤ To manually synchronize with the LDAP server: 

1. Start BAM Workbench by typing http://[host name]:[port]/celequest/workbench in the 
URL line of a web browser.

2. Click the Administration Console tab, and then click System Settings. 

3. Click the LDAP Synchronization tab. 

4. Click Synchronize Now. The time required to synchronize depends on your environment. A message 
appears when the synchronization is complete.

5. Click OK.

Next steps
You can now install LiveCycle Workflow Designer. (See “Installing LiveCycle Workflow Designer” on 
page 106.)
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14 Installing LiveCycle Workflow Designer

This chapter describes how to install LiveCycle Workflow Designer.

Installing LiveCycle Workflow Designer 
You must run an installation program to install LiveCycle Workflow Designer and to configure a connection 
to LiveCycle Workflow Server. When you run the installation program, you need to provide the name of the 
server where LiveCycle Workflow Server is deployed. 

Before you install LiveCycle Workflow Designer, you must have J2SDK version 1.4.2_05, or a later release of 
1.4.2 installed (version 1.4.2_10 is not supported).

When LiveCycle Workflow Server is deployed to WebLogic, you must copy the weblogic.jar file from the 
[appserver root]/server/lib directory to the computer on which you are installing LiveCycle Workflow 
Designer. During the installation, you are prompted to navigate to the weblogic.jar file. For more 
information, see the WebLogic documentation.

LiveCycle Workflow Designer is installed in the following location by default: 

● (Windows) C:\Adobe\LiveCycle\WorkflowDesigner

● (Linux) /opt/adobe/livecycle/workflow_designer 

➤ To install LiveCycle Workflow Designer:

1. At the root level of the installation media, run the installation program by entering the following 
command:

● (Windows) adobe_lc_workflow_721_des.exe

● (Linux) adobe_lc_workflow_721_des.bin

2. On the Welcome screen, click Next.

3. Read the license agreement, select I accept the terms of the license agreement, and then click Next.

4. Accept the default installation directory or click Browse and navigate to the directory where you want 
to install the product, and then click Next.

Note: If you type in the name of a directory that does not exist, it will be created for you.

5. Select BEA WebLogic as the type of application server that hosts LiveCycle Workflow Server and click 
Next.

6. Navigate to the weblogic.jar file.

7. In the text box, type the name of the computer running LiveCycle Workflow Server, and then click 
Next.

8. Review the installation details, and then click Back to change any settings or click Install to continue.
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9. Click Finish.

10. If you are not installing LiveCycle Workflow Designer on the same computer as where LiveCycle 
Workflow Server is deployed, ensure that the system clock is set to the correct time.

If the system clock is not within two hours of the correct time for the current time zone, LiveCycle 
Workflow Designer will not be able to connect to the application server. The system clock of the 
application server must also be set to the correct time.

Connecting to application servers using non-default ports
The default configuration of LiveCycle Workflow Designer uses default JNDI and HTTP ports to connect to 
the application server. If the application server uses non-default port numbers, you must manually modify 
the LiveCycle Workflow Designer configuration file. 

➤ To change the port used for JNDI and HTTP connections:

1. Open the qlc-config.xml file in a text editor from the following location: 

● (Windows) [LiveCycle root]/WorkflowDesigner/qlc/ 

● (Linux) [LiveCycle root]/workflow_designer/qlc/ 

2. Locate the property element with the name attribute of java.naming.provider.url, and 
change the URL in the value attribute so that it includes the port that you use for JNDI connections.

For example, the following property element configures the port to use for JNDI connections to 
7001: <property name="java.naming.provider.url" 
value="t3://localhost:7001/"/>

3. Locate the application-services element and change the value of the port attribute to the port 
that your application server uses for HTTP connections.

For example, the following application-services element configures the port to use for HTTP 
connections to 7001: <application-services host="localhost" port="7001" 
context="adobe-services"/>

4. Save and close the file.

Uninstalling LiveCycle Workflow Designer
LiveCycle Workflow Designer includes an uninstall program that is created during installation. The 
uninstall program removes the product files.

➤ To remove LiveCycle Workflow Designer:

1. Start the uninstall program:

● (Windows) Navigate to [LiveCycle root]/WorkflowDesigner/_uninst/ and double-click uninstall.exe. 

● (Linux) Navigate to [LiveCycle root]/workflow_designer/_uninst/ and run uninstall.bin.

2. If prompted, select a language for the uninstall program and click OK.

3. On the Welcome screen, click Next.
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4. Review the summary information and click Uninstall.

5. If a Remove Existing File dialog box appears, select Yes To All. 

6. Click Finish.

Next steps
You can now deploy QPACs. (See the Creating Workflows guide or LiveCycle Workflow Designer Help.)

If you have installed Watched Folder and LiveCycle Assembler, you can create workflows that involve 
Watched Folder using the LiveCycle Assembler QPACs. (See “Invoking LiveCycle Assembler Using 
LiveCycle Workflow and Watched Folder” on page 113.)
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A Supported Platform and Software Combinations

This appendix provides the supported platforms and software combinations for LiveCycle products. For a 
summary of the platforms combinations, see “Before You Install” on page 11.

Note: LiveCycle PDF Generator Elements and LiveCycle PDF Generator Professional run only on the 
Windows Server 2003 Enterprise Edition platform.

Platform Application server JDK Database

Windows Server 
2003, Standard 
Edition

Windows Server 
2003, Enterprise 
Edition

JBoss® 3.2.5 J2SDK version 1.4.2_04 MS SQL Server 2000 SP3

JBoss 3.2.5 J2SDK version 1.4.2_04 MySQL 4.1

JBoss 3.2.5 J2SDK version 1.4.2_04 IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 9i

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 10g

IBM WebSphere® 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 9i

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

MS SQL Server 2000 SP3
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Red Hat Linux 
Advanced Server 
2.1 Update 3

JBoss 3.2.5 J2SDK version 1.4.2_04 MS SQL Server 2000 SP3

JBoss 3.2.5 J2SDK version 1.4.2_04 MySQL 4.1

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 9i

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 10g

JBoss 3.2.5 J2SDK version 1.4.2_04 IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 9i

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

Red Hat Linux 
Advanced Server 
3.0

JBoss 3.2.5 J2SDK version 1.4.2_04 MySQL 4.1

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 9i

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 10g

JBoss 3.2.5 J2SDK version 1.4.2_04 IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 9i

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

IBM AIX® 5.2 IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

Platform Application server JDK Database
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IBM AIX 5.3 IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

Sun Solaris 8 BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 9i

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 10g

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

IBM DB2 8.2 
(Version 8.1 Fix Pack 7)

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

Sun Solaris 9 BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

SUSE Linux ES 9.0 JBoss 3.2.5 J2SDK version 1.4.2_04 MS SQL Server 2000 SP3

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 9i

JBoss 3.2.5 J2SDK version 1.4.2_04 Oracle 10g

JBoss 3.2.5 J2SDK version 1.4.2_04 MySQL 4.1

BEA WebLogic Server 8.1 
SP5

J2SDK version 1.4.2_08 Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 9i

IBM WebSphere 5.1.1.5 IBM JDK installed with 
WebSphere

Oracle 10g

Platform Application server JDK Database
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B Fonts Installed with the Font Manager Module

Some modules require access to fonts that are installed with the Font Manager Module. The Font Manager 
Module contains a number of bundled fonts that you can use in your custom applications. 

The Font Manager Module is not used when converting native documents into PDF documents or when 
converting PDF documents into some other format.

You can add fonts to the Font Manager Module, which is subsequently packaged in the LiveCycle.ear file. 
For information about adding your own fonts, see “Configuring LiveCycle Products for Deployment” on 
page 62.

The following fonts are installed with the Font Manager Module:

● Adobe Serif MM

● Adobe Sans MM

● Adobe Ming Std Light

● Adobe Song Std Light

● Adobe Myungjo Std Medium

● Adobe Pi Std

● Bell Gothic Std Light

● Bell Gothic Std Bold

● Bell Gothic Std Black

● Courier Std

● Courier Std Bold

● Courier Std Bold Oblique

● Courier Std Oblique

● EuroSign (TTF)

● Kozuka Gothic® Std Extra Light

● Kozuka Gothic Std Light

● Kozuka Gothic Std Regular

● Kozuka Gothic Std Medium

● Kozuka Gothic Std Bold

● Kozuka Gothic Std Heavy

● Kozuka Gothic Pro Medium

● Kozuka Mincho® Std Extra Light

● Kozuka Mincho Std Light

● Kozuka Mincho Std Regular

● Kozuka Mincho Std Medium

● Kozuka Mincho Std Bold

● Kozuka Mincho Std Heavy

● Kozuka Mincho Pro-VI Regular

● Letter Gothic Std Medium 

● Letter Gothic Std Slanted

● Letter Gothic Std Bold

● Letter Gothic Std Bold Slanted

● Minion® Pro Italic

● Minion Pro Semibold

● Minion Pro Semibold Italic

● Minion Pro Bold

● Minion Pro Bold Italic

● Minion Pro Regular

● Myriad® Pro Light

● Myriad Pro Light Italic

● Myriad Pro Regular

● Myriad Pro Italic

● Myriad Pro Bold

● Myriad Pro Semibold

● Myriad Pro Semibold Italic

● Myriad Pro Bold Italic

● Myriad Pro Black

● Myriad Pro Black Italic

● Symbol
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C Invoking LiveCycle Assembler Using 
LiveCycle Workflow and Watched Folder

This appendix describes how to invoke LiveCycle Assembler through LiveCycle Workflow, using the 
LiveCycle Assembler QPACs and Watched Folder. 

This appendix assumes that you have installed, configured, and deployed LiveCycle Assembler, 
LiveCycle Workflow, and Watched Folder.

Note: Watched folders can be implemented for use with LiveCycle PDF Generator, but need to be 
configured separately. The contents of this chapter refer only to the Watched Folder service that 
integrates LiveCycle Workflow and LiveCycle Assembler. For information on setting up watched 
folders for LiveCycle PDF Generator, see LiveCycle PDF Generator Administration Help, available from 
the LiveCycle PDF Generator web interface.

Summary of tasks
Using either Watched Folder or a client application you developed, you can direct LiveCycle Workflow to 
initiate a workflow that activates a LiveCycle Assembler QPAC.

This section outlines the tasks required to set up a workflow that completes a LiveCycle Assembler process 
that is invoked by Watched Folder. The detailed steps required to complete the tasks are located in the 
section or document indicated. You must perform the tasks in the order that they are listed in the table. 

Note: Do not run Configuration Manager until you have completed installing the files for each of the 
products.

Step Task See

1 Deploy LiveCycle Assembler QPACs to 
LiveCycle Workflow Designer. 

Using LiveCycle Assembler QPACs (available 
on the LiveCycle Assembler installation DVD 
or on the LiveCycle Workflow SDK website)

2 Create and deploy a workflow that includes a 
LiveCycle Assembler QPAC. 

“Deploying QPACs and creating a workflow 
process” on page 114 

LiveCycle Workflow Creating Workflows

LiveCycle Workflow Designer Help 

3 Create a watched folder on the file system. “Creating and configuring a watched folder” 
on page 117

4 Log into Administrator and create and configure 
a watched folder. 

“Creating and configuring a watched folder” 
on page 117

Watched Folder Administration Help

5 Create a JobConfig.xml file. “Creating a JobConfig.xml file” on page 118

Watched Folder Administration Help
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Deploying QPACs and creating a workflow process
There are two QPACs used to create workflows for LiveCycle Assembler: the Assembler QPAC and the 
CreateDocumentList QPAC. The Assembler QPAC is used for all LiveCycle Assembler workflows, whether 
you are using Watched Folder or another method of initiating the process (for example, client applications 
or web services). 

This section describes how to create a workflow process that uses the Assembler QPAC, including how to 
create the required variables and action properties in LiveCycle Workflow Designer. For information on 
creating a workflow process that uses the CreateDocumentList QPAC, see the Using LiveCycle Assembler 
QPACs guide.

The steps for creating a workflow process that includes an Assembler QPAC are similar to those for creating 
any workflow process using LiveCycle Workflow Designer. The procedure here provides details specific to 
the Assembler QPAC. For more information on creating workflows, setting up variables, and setting action 
properties in a QPAC, see the Creating Workflows and Using LiveCycle Assembler QPACs guides.

Using dynamic or static DDX files

When you submit jobs to Watched Folder for processing by LiveCycle Workflow and LiveCycle Assembler, 
you can use a dynamic or a static DDX file. When you create or use an application to submit jobs to 
LiveCycle Assembler that uses only the QPAC workflow (without Watched Folder), you must use a static 
DDX file. 

A workflow that uses a dynamic DDX file processes the DDX file that is included in the input folder in a 
watched folder. To use a dynamic DDX file in your workflow process, you must create an <inputddx> 
variable and specify it in the action properties of the QPAC. 

A workflow that uses a static DDX file processes a particular DDX file that is loaded into the QPAC and used 
every time that the process is called by the JobConfig.xml file. To use a static DDX file in your workflow 
process, you must browse to the DDX file and load it into the QPAC when you set the action properties for 
the workflow. You can use a static DDX if you are using a watched folder, or if you are running the process 
using only the QPACs.

6 Prepare the test or production collateral, which 
includes input PDF files and a DDX file.

“Preparing PDF and DDX files” on page 120

Developing Applications for LiveCycle 
Assembler 

Document Description XML Reference 

7 Submit the LiveCycle Assembler job for 
processing.

“Submitting the LiveCycle Assembler job for 
processing” on page 120

Developing Custom Applications for 
LiveCycle Workflow 

Step Task See
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Configuring an Assembler QPAC in a workflow process

When you create a new workflow process in LiveCycle Workflow Designer, you must create variables that 
will be used by the workflow process. When you add the Assembler QPAC to the workflow, you must set 
the action properties for the QPAC. The action properties use the variables that you created.

The selections you make on the Action Properties dialog box depend on whether you are using a dynamic 
or static DDX file.

Note: The variable names used in this chapter, such as <inputddx> and <inputdocmap>, are 
user-defined in LiveCycle Workflow Designer; you can use any name when you create the variable. 

Variables for the Assembler QPAC

Action properties for the Assembler QPAC

Variable Property values

<inputdocmap> Type: map of document
in: selected
out: not selected
required: not selected

<inputddx> 
(required for dynamic 
DDX file only)

Type: document
in: selected
out: not selected
required: not selected

<outputmap> Type: map and document
in: not selected
out: selected
required: not selected

<joblog>
(not required when 
Logging Level is set to Off )

Type: Document
in: not selected
out: selected
required: not selected

Type of workflow Select on Input tab Select on Output tab

Using Watched Folder with 
a dynamic DDX file

Use a Document Variable to load the 
DDX file: Click the ellipsis button and 
select the <inputddx> variable.

Input Document Map Variable:
Select the <inputdocmap> variable.

Output Document Map: Click 
the ellipsis button and select the 
<outputmap> variable.

Using Watched Folder with 
a static DDX file

Use the Browse button to locate the 
DDX file: Browse to the DDX file that 
you want to use.

Input Document Map Variable:
Select the <inputdocmap> variable.

Output Document Map: Click 
the ellipsis button and select the 
<outputmap> variable.
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Note: For information about selecting options on the Configuration tab, see the next section, Error 
logging and fail modes in the Assembler QPAC workflows.

Error logging and fail modes in the Assembler QPAC workflows

When you set up a workflow using the Assembler QPAC, you can select the error logging level and the fail 
mode that LiveCycle Workflow uses when exceptions occur. 

You can set the error logging level to Off (no logging), Normal (brief messages), or Debug (detailed 
descriptions of errors). You can associate a process variable (for example, <joblog>) of type Document to 
the Output Log Document field in order to store the log messages.

You can set the fail mode to Stall Process or Terminate Process to direct the Assembler QPAC to stall or 
terminate a process when an exception occurs in LiveCycle Assembler.

When a job fails with Stall Process selected, the workflow process stalls, but is not terminated. If logging is 
set to Normal or Debug, information about the exception appears on the LiveCycle Workflow Stalled 
Action page in Administrator. Component administrators should search for the process and terminate it, 
and then return to Administrator and delete the stalled action if desired. The logged messages are 
displayed on the stalled action page, but not on the process page.

When a job fails with Terminate Process selected, the workflow process terminates when an exception is 
thrown. If logging is set to Normal or Debug, information about the exception is written to the log file for 
the component for which the exception was thrown. For Watched Folder, the log file is the activity.log file 
that is placed in the /failure subdirectory of the configured watched folder.

If you are configuring an Assembler QPAC for use with Watched Folder, you should set the fail mode to 
Terminate Process. Watched Folder users may not have access to Administrator, so if processes stall but are 
not terminated, users do not receive messages about the exception until the process is terminated. Setting 
the fail mode to Terminate Process ensures that error messages are logged to the activity.log file, which is 
available in the [watchedfolder]/failure directory (when the logging level is set to Normal or Debug).

For information on setting error logging and fail modes, see Using LiveCycle Assembler QPACs. 

➤ To create a workflow that includes an Assembler QPAC:

1. Deploy the Assembler QPAC to LiveCycle Workflow Designer. (See Using LiveCycle Assembler QPACs.)

2. In LiveCycle Workflow Designer, select File > New > Process Category.

3. Select the new process category and select File > New > Process Type.

4. Right-click the new process type and select New Workflow.

5. Name the workflow and use the default values for the remaining options (synchronous is selected 
and the other options are unchecked).

Using QPAC only (with a 
static DDX file)

Input Document Map: Do not select

Use the Browse button to locate the 
DDX file: Browse to the DDX file that 
you want to use.

Output Document Map: Click 
the ellipsis button and select the 
<outputmap> variable.

Type of workflow Select on Input tab Select on Output tab
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6. Create the variables for the workflow, as described in the “Variables for the Assembler QPAC” on 
page 115 table, by clicking the green plus (+) button on the Variables palette. For more information on 
creating variables, see LiveCycle Workflow Designer Help.

7. Create a new component category. (See Creating Workflows.)

8. Add the Assembler QPAC (deploy the component) to the new component category, and set the action 
properties for the workflow, as described in the “Action properties for the Assembler QPAC” on 
page 115 table.

9. Save and deploy the workflow process.

Creating and configuring a watched folder
You must create a directory on your file system that you can configure as a watched folder. After you have 
configured the watched folder using the Watched Folder configuration interface, the watched folder 
contains the following subdirectories:

/[watchedfolder]

/input

/stage

/failure

/result

/preserve

For information on the subdirectories, see Watched Folder Administration Help.

To submit files for processing, you place them in the /[watched folder]/input directory.

When multiple files need to be included in the LiveCycle Assembler process, do not transfer the individual 
files to the input directory; instead, create a separate collection directory, place all of the required files in it 
(that is, the input PDF files and, if required, the DDX file), and then place the collection directory in the 
input directory of the watched folder. 

➤ To create and configure a watched folder:

1. Create a directory to be a watched folder on your file system on your server. 

2. Log into Administrator.

3. Click Services, click Watched Folder, and then click Watched Folder Management and Status.

4. Click New Watched Folder.

5. In the Watched Folder Name box, type a name for the watched folder. (This does not have to match 
the name of the directory you created on the file system in step 1, but it is recommended for tracking 
purposes.)

6. In the Watched Folder Path box, type the full path to the directory you created on the file system.

7. In the Include File Pattern(s) box, type the name of the directory you created to contain the input PDF 
files (that you will place in the input directory of the watched folder). You can specify more than one file 
or name, if you intend to place multiple files and folders in the watched folder.
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8. Set the other options according to your requirements. For information on the options available, see 
Watched Folder Administration Help.

9. Click OK.

Tip: If you are transferring a large number of source files to the watched folder, it may take several minutes 
or longer. It is possible that Watched Folder might scan the watched folder, recognize a new 
collection directory, and initiate a workflow process before all of the files in the directory have been 
copied over. To avoid this, you must name the collection directory something other than the name 
that Watched Folder is scanning for while you copy the directory to the input directory. When all of 
the input files have been copied over, you must rename the collection directory to the name specified 
in the Watched Folder configuration (the Include File Pattern(s) value).

Creating a JobConfig.xml file
The JobConfig.xml file can be placed at the root of the input directory or inside the collection directory 
together with the other collateral files.

If you plan to place multiple jobs (collection directories) in the watched folder for different workflows that 
use dynamic DDX files, the JobConfig.xml file must be placed in the individual collection directories that 
are submitted to the input directory in the watched folder. 

If you plan to submit multiple jobs for the same workflow that uses a static DDX file, you can place the 
JobConfig.xml at the root of the input directory. Subsequent incoming jobs use this same JobConfig.xml 
file.

To create a JobConfig.xml file, create an XML file similar to the following examples.

Example C.1 A JobConfig.xml file for a dynamic DDX file

<?xml version="1.0" encoding="UTF-8"?>
<process-config xmlns="http://adobe.com/watchedfolder" 
xmlns:xsi="http://www.w3.org/2001/ XMLSchema-instance" 
xsi:schemaLocation="http://adobe.com/watchedfolder 
C:\WatchedFolder\schemas\JobConfiguration.xsd">

<process-type>myworkflow</process-type>
<process-variables>

<process-variable>
<filter-pattern>*.pdf</filter-pattern>
<process-variable-type>map</process-variable-type>
<process-variable-name>inputdocmap</process-variable-name>
<process-variable-datatype>document</process-variable-datatype>
<process-input>true</process-input>

</process-variable>
<process-variable>

<filter-pattern>*.ddx</filter-pattern>
<process-variable-type>single</process-variable-type>
<process-variable-name>inputddx</process-variable-name>
<process-variable-datatype>document</process-variable-datatype>
<process-input>true</process-input>

</process-variable>
</process-variables>

</process-config>
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Example C.2 A JobConfig.xml file for a static DDX file

Use the same JobConfig.xml described previously, but omit the <inputddx> process variable.

<?xml version="1.0" encoding="UTF-8"?>
<process-config xmlns="http://adobe.com/watchedfolder" 
xmlns:xsi="http://www.w3.org/2001/ XMLSchema-instance" 
xsi:schemaLocation="http://adobe.com/watchedfolder 
C:\WatchedFolder\schemas\JobConfiguration.xsd">

<process-type>myworkflow</process-type>
<process-variables>

<process-variable>
<filter-pattern>*.pdf</filter-pattern>
<process-variable-type>map</process-variable-type>
<process-variable-name>inputdocmap</process-variable-name>
<process-variable-datatype>document</process-variable-datatype>
<process-input>true</process-input>

</process-variable>
</process-variables>
</process-config>

The content of the JobConfig.xml file maps to the variables and actions defined in the workflow process 
described in “Configuring an Assembler QPAC in a workflow process” on page 115.

Node Description

process-config The root of the job configuration file.

process-type The name of the workflow process type. This value must match the 
value specified in the workflow process in 
LiveCycle Workflow Designer.

process-variables Contains multiple process-variable nodes.

process-variable Each process-variable node maps to a variable included in the 
workflow process. Its subelements specify property values for each 
process variable. 

filter-pattern The pattern used to filter all of the files from the input set that will 
be set for the process variable. This pattern matches the type of 
files to be processed in relation to the variable.

process-variable-type The type of input variable: single, list, or map. 

In the example above, list is used for the <inputdocmap> 
variable, because the variable specified a series of documents (all 
of the files that will be placed in the watched folder). For the 
<inputddx> variable, single is specified, because only one file 
will be included.

process-variable-name The name of the workflow variable as defined in the workflow. In 
the example above, the variable names match those created in 
“Configuring an Assembler QPAC in a workflow process” on 
page 115: inputdocmap and inputddx
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For more information on creating the JobConfig.xml file, see Watched Folder Administration Help.

Preparing PDF and DDX files
The PDF files included in the input directory or defined by the Assembler QPAC must correspond to the file 
pattern value defined for the source element in the DDX file. 

When using Watched Folder with LiveCycle Assembler, you must specify the Input Document Map 
variable (as described in “Configuring an Assembler QPAC in a workflow process” on page 115). You must 
use the sourceMatch attribute for the source element to define the file pattern. For information on 
setting the regular expression pattern for the sourceMatch attribute, see the Document Description XML 
Reference.

For example, in the DDX file, the PDF source can be specified in the following ways:

● Pattern matching for specific file names: 
<PDF source="mysource" sourceMatch="appendix[\d]+[.]pdf" select="1-last"/>

● Pattern matching with wildcard value: 
<PDF source="mysource" sourceMatch=".+[.]pdf" select="1-last"/>

In the examples above, pattern-matching matches any input PDF files that begin with the characters 
appendix followed by a digit, and then followed with the file name extension .pdf. The wildcard value 
matches at least one input PDF file with any characters that include digits and end with .pdf.

For more information on setting the source element in the DDX file, see “Specifying multiple input 
streams” in the Developing Applications for LiveCycle Assembler guide and the Document Description XML 
Reference.

Submitting the LiveCycle Assembler job for processing
You can submit a LiveCycle Assembler job to Watched Folder programmatically using a batch file that 
transfers the package containing the required files to the configured watched folder. (Instructions for 
creating a batch file or script to complete this action is beyond the scope of this guide.) You can also 
submit a job manually by dragging or copying the package of files to Watched Folder. 

If you have created a LiveCycle Assembler workflow in LiveCycle Workflow Designer that does not use 
Watched Folder, you can submit the job for processing using a client application that you create using the 
LiveCycle Workflow Java API. For information on developing custom client applications for 
LiveCycle Workflow, see the Developing Custom Applications for LiveCycle Workflow guide, available with 
the LiveCycle Workflow SDK.

process-variable-datatype The type of workflow variable. Two types of variables are 
supported: document and xml. This matches the 
containedtype attribute of the variable (not the 
collectiontype attribute).

process-input Watched Folder does not currently use this setting. Leave the value 
set to true.

Node Description
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You can also submit jobs for processing using a variety of other mechanisms available with 
LiveCycle Workflow, such as web services, email, and messaging queues, as well by using online forms. For 
more information, see the Developing Custom Applications for LiveCycle Workflow and Developing Custom 
QPACs guides.

Note: When NFS sharing is set up for Watched Folder, temporary files and directories related to Watched 
Folder jobs are placed in the Global storage directory, but are not automatically deleted when the 
job processing is complete. To prevent performance issues, you should regularly remove files with 
name Session[NNNN], where NNNN is the workflow process ID from the Global storage directory.

The default location of the Global storage directory is {TempDir]/AdobeDocumentStorage/global. If 
[TempDir] is not specified by the user in Configuration Manager, the default location is 
java.io.tmpdir. 
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D Developing Forms for LiveCycle

This appendix provides information that is useful for form developers, including how to use WebDAV with 
LiveCycle Form Manager and which items LiveCycle products require for different types of forms.

Publishing files from client software
Form developers and form owners can use WebDAV-enabled client software to publish and access their 
files in the LiveCycle products repository used by LiveCycle Form Manager. 

To use WebDAV, your computer must be running file management software (such as Microsoft Windows 
Explorer) that can connect to WebDAV servers.

To create a connection to a WebDAV directory, you must specify the URL of the directory. The following 
URL is the default URL of the LiveCycle Form Manager repository:

http://[host name]:[port]/appstore/Forms

where[host name] is the name of the computer that is running LiveCycle products and [port] is the port 
being used for LiveCycle products.

For example, the form developers in your company use LiveCycle Designer to create forms. The form 
developers want to use the Publish menu command in LiveCycle Designer to copy forms and their 
supporting files to the LiveCycle products repository. However, they first use Windows Explorer to add a 
network place, which creates a connection to the URL of the LiveCycle products repository. The 
connection appears as a folder in My Network Places. After adding the network place, the form developers 
can use the folder to publish files to the repository. 

Designing forms for LiveCycle products
To use forms with LiveCycle products, there may be requirements for the design of the form, the 
configuration of LiveCycle products, or both. The following types of forms have special requirements for 
use with LiveCycle products: 

● Dynamic forms

● PDF/A-compliant forms

● Forms that include subform objects

● PDF forms created with Acrobat

For information on designing forms for use with LiveCycle Workflow, see the Creating Workflows guide, 
which is installed with LiveCycle Workflow.
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Using dynamic forms with LiveCycle products

Dynamic forms can expand or shrink to accommodate the amount of incoming data. Dynamic forms 
typically include buttons that request form data from LiveCycle Forms. LiveCycle Forms renders the form 
with the data and returns it to the client. The client’s browser is refreshed with the form, which has been 
expanded or contracted, depending on the amount of new data. 

For example, some forms enable users to query a database by specifying search criteria. The returned data 
appears on the same form (a subform) in a table. The returned data determines the number of rows in the 
table. To submit the query, the user clicks a button, which sends the request to LiveCycle Forms. 

LiveCycle products support the use of the following types of buttons for dynamic forms: 

● One that updates the data on a dynamic form

● One that returns a PDF document to a client, who can then can save a local copy of the document or 
print the document

LiveCycle products use specific button names to recognize these buttons. Dynamic forms must use these 
button names. You can use the default names, or you can go to the Administrator pages and configure 
LiveCycle products to use different names.

Embedding fonts in PDF/A-compliant forms

When creating a form design that is intended for the creation of a PDF/A Level 1B-compliant form when 
rendered by LiveCycle Forms, all of the fonts used must be embedded in the form design. If the fonts are 
not embedded, the rendered form is not PDF/A Level 1B-compliant, although it is a valid PDF form.

Only fonts licensed for a minimum of View and Print usage can be embedded in the form design. The fonts 
included in the Font Manager Module meet this criteria.

Property Default Description and options

Re-render 
Button name

RENDERAGAIN The button name that indicates to LiveCycle products that this 
button sends a request to LiveCycle Forms to render the current 
form again with updated data.

Print 
Button Name

PRINTFORM The button name that indicates to LiveCycle products that this 
button creates a PDF document from the current form and returns 
it to the end user.
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E Uninstalling LiveCycle Products

This chapter describe how to uninstall the LiveCycle product files.

Removing the product files
The uninstall program located in the [product root] directory does not remove any files that you deployed 
to your application server or modules that are shared with other LiveCycle products. 

Caution: By running the uninstall program, all of the contents within the product installation directory are 
subject to removal without further warning. Before proceeding, back up any data you do not 
want to lose.

➤ To remove the files from your computer:

1. Navigate to the [product root]/_uninst/ directory and start the unstall program:

● (Windows) Double-click the .exe file. Alternatively, you can use the Add or Remove Programs 
function.

● (Linux, UNIX) From a command prompt, type: file_name.bin 

2. If prompted, select a language for the uninstall program and click OK.

3. Follow the on-screen instructions, and then click Finish.
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F Upgrading LiveCycle Products to Version 7.2 
or 7.2.1

This chapter describes the tasks required to upgrade your current LiveCycle products to version 7.2, or to 
version 7.2.1 for LiveCycle Assembler and LiveCycle Workflow.

This document should be used in conjunction with the Installing and Configuring LiveCycle guide or the 
Installing and Configuring LiveCycle Security Products guide for your application server. Throughout this 
document, specific sections in these installing and configuring guides are listed when more detailed 
information is available. 

For a complete list of the supported platforms and system requirements for LiveCycle 7.2 products, see the 
“Before You Install” chapter in this guide.

This chapter uses the following naming conventions for common file paths:

[LiveCycle root] Refers to the location where LiveCycle products and components earlier than versions 
7.2 or 7.2.1 are installed.

[LiveCycle72 root] Refers to the location where LiveCycle products and components with versions 7.2 
and 7.2.1 are installed.

The Installing and Configuring LiveCycle guides apply to the following products:

● LiveCycle Assembler 7.2.1

● Adobe LiveCycle Forms 7.2

● Adobe LiveCycle Form Manager 7.2

● Adobe LiveCycle PDF Generator 7.2

● Adobe LiveCycle Print 7.2

● Adobe LiveCycle Workflow 7.2.1

● Adobe LiveCycle Workflow Designer 7.2.1

● Watched Folder 1.1

The Installing and Configuring LiveCycle Security Products guides apply to the following products:

● Adobe LiveCycle Document Security 7.2

● Adobe LiveCycle Reader Extensions 7.2

● Adobe LiveCycle Policy Server 7.2

Upgrade guidelines
This section describes guidelines you must follow when upgrading LiveCycle products to version 7.2 or 
version 7.2.1.

Updating your application server

Ensure that you apply the required patches and fix packs to the application server on which you are 
running LiveCycle products, and obtain the updated database drivers. Your environment must meet the 
system requirements described in the “Support software” chapter in this guide.
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Using automatic or turnkey installations for upgrading

For installations for deployment to WebSphere or WebLogic, you can use Configuration Manager to 
configure and deploy the product, initialize the database, and verify the deployment.

Before using Configuration Manager to automatically configure LiveCycle products, the existing LiveCycle 
components must be undeployed and the application server restarted.

For installations for deployment to JBoss, you can configure the products for deployment and initialize the 
database using Configuration Manager, but you must deploy the product components manually. The 
turnkey installation option is only supported for upgrading LiveCycle Reader Extensions.

If you are running LiveCycle products that were originally installed using the turnkey installation option, 
you can upgrade to version 7.2 or 7.2.1 by following the manual or the auto-configuration upgrade 
instructions that are included in this guide. Instructions for upgrading LiveCycle Reader Extensions using 
the turnkey installation option are also included in this chapter.

Configuring using Configuration Manager during the upgrade process

It is recommended that you do not automatically configure the WebSphere or WebLogic application 
server using Configuration Manager because current configuration settings on your application server 
may be overwritten.

During the upgrade process, you will configure some product and application server run-time properties 
using Configuration Manager. For upgrades from 7.x versions, you should configure the upgraded product 
using the same property values. The “Configuring LiveCycle Products for Deployment” chapter in the 
Installing and Configuring guides provides information about the properties that you will configure when 
you upgrade the product.

Summary of manual upgrade process
This checklist describes the high-level tasks that you must perform to upgrade from a LiveCycle 7.x 
product to a LiveCycle 7.2 or 7.2.1 product. For detailed information, see the specific upgrade procedures 
for the product you are upgrading. 

The sections referenced in the “See” column are in the Installing and Configuring guides for your 
application server, depending on the product you are installing.

Task See

Back up the database that contains the current 
LiveCycle configuration and run-time data.

The database server documentation.

Back up copies of the currently deployed LiveCycle 
EAR and WAR files to a separate directory.

(JBoss) Stop services, if applicable (JBoss for Adobe 
LiveCycle, MySQL for Adobe LiveCycle, JBoss for 
Workflow BAM, AdobeDocumentSecurity, or 
AdobeReaderExtensions).
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LiveCycle Forms and LiveCycle Print
This section provides upgrading instructions for LiveCycle Forms 7.2 and LiveCycle Print 7.2.

Note: You must install LiveCycle Forms 7.2 before installing LiveCycle Print 7.2.

Upgrading from Adobe Form Server 6.0 to LiveCycle Forms 7.2

This procedure describes how to upgrade from Adobe Form Server 6.0 to LiveCycle Forms 7.2. 

➤ To upgrade from Form Server 6.0 to LiveCycle Forms 7.2:

1. Undeploy the earlier product from the application server. (For information, see your application server 
documentation.)

2. Uninstall the earlier product using the uninstaller program. (For information, see the Form Server 6.0 
Installation and Configuration Guide.)

3. Upgrade the application server and database to ensure that they meet the system and software 
requirements for LiveCycle 7.2 products.

Undeploy LiveCycle components from the application 
server.

Refer to the application server documentation.

Uninstall the previous version of LiveCycle products 
using the uninstaller program.

The “Uninstalling LiveCycle Products” chapter

Apply the required patches and fix packs to the 
application server and obtain the updated database 
drivers.

The “Supported software” section of the 
“Before You Install” chapter

Install the LiveCycle 7.2 or 7.2.1 product to a new 
(non-default) location on your file system. Do not 
install to the same directory where your previous 
LiveCycle products are installed.

The “Installing LiveCycle Products” chapter

Run Configuration Manager to configure the product. 
Apply the configuration data that you used in the 
original installation. For WebSphere and WebLogic, 
you can automatically deploy the product, initialize 
the database, and verify the deployment using 
Configuration Manager.

(JBoss) The “Configuring LiveCycle Products 
for Deployment” chapter

(WebLogic, WebSphere) The “Automatically 
Configuring LiveCycle Products” or 
“Configuring LiveCycle Products for 
Deployment” chapter

(JBoss) Deploy the product components to the 
application server.

The “Manually deploying to JBoss” chapter

(JBoss) Run Configuration Manager to initialize the 
database.

The “Initializing the Database” chapter

Task See
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4. Install and deploy LiveCycle Forms 7.2, and initialize the database using the instructions in this 
document for the manual installation and deployment option. For WebSphere and WebLogic, you can 
automatically deploy the product, initialize the database, and verify the deployment using 
Configuration Manager. 

Note: If you did not include User Management with the installation and configuration of LiveCycle Forms, 
you do not need to connect to a database, and you do not need to follow steps to initialize the 
database.

LiveCycle Forms and LiveCycle Print 7.x to LiveCycle Forms and 
LiveCycle Print 7.2

This procedure describes how to upgrade from LiveCycle Forms 7.0 or 7.1 to LiveCycle Forms 7.2, and from 
LiveCycle Print 7.1 to LiveCycle Print 7.2. 

It is recommended that you install LiveCycle Forms 7.2 to a new directory so that you do not overwrite the 
previously installed version.

➤ To retrieve form configuration properties (for LiveCycle Forms 7.0 or 7.1 configured without User 
Management):

1. Type the following URL in a web browser:

http://[host_name]:[port]/FormServerAdmin/settings.html

The default port number for WebLogic is 7001. If you are running a Managed Server, you may have 
configured the application server to use a different port number, such as 8001. The default port for 
WebSphere is 9080; the default port for JBoss is 8080.

2. Record the settings that appear on this page.

➤ To retrieve form configuration properties (for LiveCycle Forms 7.0 or 7.1 configured with User 
Management):

1. Type the following URL in a web browser:

http://[host_name]:[port]/adminui

The default port number for WebLogic is 7001. If you are running a Managed Server, you may have 
configured the application server to use a different port number, such as 8001. The default port for 
WebSphere is 9080; the default port for JBoss is 8080.

2.  Log into Administrator. 

3. Click Services, and then click Adobe LiveCycle Forms. 

4. Record the settings that appear on this page.

5. These properties must be set for the new installation on the Form Server Module Configuration screen 
on Configuration Manager when you install and configure LiveCycle Forms 7.2.
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➤ To upgrade to LiveCycle Forms 7.2 and LiveCycle Print 7.2:

1. Back up the database that currently contains the LiveCycle Forms 7.0 or 7.1 configuration and run-time 
data.

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. Back up the XDC files from LiveCycle Print 7.1. 

4. (JBoss) If your LiveCycle deployment is running on a JBoss Application Server with a MySQL database 
that you installed using the turnkey option, stop the JBoss for Adobe LiveCycle service and the MySQL 
for Adobe LiveCycle service.

5. Undeploy the following files from your application server:

● LiveCycle.ear

● FormsIVS.ear

● adobe-FontManager.war

● LCMBootstrapper.war

● adobe-printSubmitter.ear (LiveCycle Print only)

For information about undeploying from WebLogic or WebSphere, see “Uninstalling EAR files” in the 
Installing and Configuring LiveCycle guide.

Note: When the Livecycle.ear file is undeployed, LiveCycle Print 7.1 does not work.

6. Stop the WebLogic Server or WebSphere Application Server. 

7. Uninstall the previous versions of LiveCycle products using the uninstaller program. (See “Uninstalling 
LiveCycle Products” in the related Installing and Configuring LiveCycle guide.)

8. Upgrade the application server and database to ensure that they meet the system and software 
requirements for LiveCycle Forms 7.2.

9. Install LiveCycle Forms 7.2 to a new (non-default) directory (for example, C:\Adobe\LiveCycle72\ or 
/opt/adobe/livecycle72/). Follow the instructions in “Installing LiveCycle Products” in the Installing and 
Configuring LiveCycle guide.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same root [LiveCycle72 root] directory.

10. Copy the DocumentServicesLibrary.jar file, according to your application server: 

● (WebLogic) From the [LiveCycle72 root]/components/csa/weblogic/lib/adobe directory to the 
[appserverdomain]/lib directory.

● (WebSphere) From the [LiveCycle72 root]/components/csa/websphere/lib/adobe directory to the 
[appserver root]/optionalLibraries. 

● (JBoss) From the [LiveCycle72 root]/components/csa/jboss/lib/adobe directory to the 
[appserver root]/server/all/lib directory.

Note: Modify the XDC files installed with LiveCycle Print 7.2 to match those that you are using with 
version 7.1, and use these modified files. For information about the XDC files included with 
LiveCycle Print, see the Getting Started guide and the Editing XDC Files to Customize Printing 
Workflows guide for LiveCycle Print.
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11. Start the application server.

12. Configure LiveCycle Forms 7.2 using Configuration Manager. (See the “Configuring LiveCycle Products 
for Deployment” chapter in the Installing and Configuring LiveCycle guide.) As you proceed through the 
Configuration Manager screens, choose the following options:

● Configuration Mode: Select Custom Configuration Wizard.

● Product Selection: Select the application server you are using, as well as Foundation, LiveCycle 
Forms, and LiveCycle Print (if applicable). 

● Adobe User Management Selection: Select one of the following options:

● LiveCycle Forms with User Management and Administrator if you used LiveCycle Forms with 
User Management in the previous deployment

● LiveCycle Forms without User Management and Administrator if you did not previously use 
LiveCycle Forms with User Management

● Task Selection: Select the following options: 

● Configure and Assemble products 

● Bootstrap Database (only if you are including User Management in the configuration)

For WebSphere and WebLogic, also select these options: 

● Deploy products 

● Verify deployed products 

13. Follow the instructions on the remaining Configuration Manager screens. Accept the default values in 
Configuration Manager whether you are configuring with User Management and Administrator or 
without User Management and Administrator. 

Note: When prompted to specify the Global Storage Directory location, specify the same location that 
you currently use for this directory.

If you are deploying to WebSphere or WebLogic, complete steps 14 and 15. If you are deploying to 
JBoss, complete steps 16 and 17.

14. (WebSphere and WebLogic) On the Confirm Products to Deploy screen, select these EAR files:

● LiveCycle.ear

● adobe-FontManager.ear.

● adobe-printSubmitter.ear (LiveCycle Print only)

15. (WebSphere and WebLogic) Follow the instructions on the Configuration Manager screens to initialize 
the database and verify the deployed products. 

16. (JBoss) Deploy LiveCycle Forms 7.2. (See “Manually Deploying to JBoss” in the Installing and Configuring 
LiveCycle guide.)

17. (JBoss) (User Management configuration) Run Configuration Manager to initialize the database. Select 
Custom Configuration Wizard, and then select Bootstrap database.

Note: Initializing the database is necessary to add new table columns to the database schema. 
Initializing the database does not alter existing data.

18. Deploy the FormsIVS.ear files according to the steps required for your application server. (See 
“LiveCycle Forms post-deployment tasks” in the Installing and Configuring LiveCycle guide.)
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19. Verify the deployment by following the instructions in “LiveCycle Forms post-deployment tasks” in the 
Installing and Configuring LiveCycle guide.

20. Update your application’s class path with the location of these JAR files: formserver-client.jar, 
adobe-common.jar, datamanager-client.jar, and AdobeCSAUtils.jar. Add the um-client.jar file to the 
application class path if the application passes an InvocationContext object in the Form Server 
Module API. For details about these files, see Developing Custom Applications located in the 
[LiveCycle72 root]/forms/documentation directory.

➤ To configure LiveCycle Forms (when not using User Management):

1. Type the following URL in a web browser:

http://[host_name]:[port]/FormServerAdmin/settings.html

The default port number for WebLogic is 7001. If you are running a Managed Server, you may have 
configured the application server to use a different port number, such as 8001. The default port for 
WebSphere is 9080; the default port for JBoss is 8080.

2. Enter the settings that you recorded when you retrieved the LiveCycle Forms configuration settings 
from the previous LiveCycle.ear file. (See “To retrieve form configuration properties (for LiveCycle 
Forms 7.0 or 7.1 configured without User Management):” on page 128.)

3. Click Save.

Note: The settings modified here are not retained when the application server is restarted.

➤ To configure LiveCycle Forms (when using User Management):

1. Type the following URL in a web browser:

http://[host_name]:[port]/adminui

2. The default port number for WebLogic is 7001. If you are running a Managed Server, you may have 
configured the application server to use a different port number, such as 8001. The default port for 
WebSphere is 9080; the default port for JBoss is 8080.

3. Log into Administrator.

4. Click Services, and then click Adobe LiveCycle Forms.

5. Enter the settings you recorded when you retrieved the LiveCycle Forms configuration settings from 
the previous LiveCycle.ear file. (See “To retrieve form configuration properties (for LiveCycle Forms 7.0 
or 7.1 configured with User Management):” on page 128.)

6. Click Save.

LiveCycle Form Manager
This section provides instructions for upgrading from LiveCycle Form Manager 7.0.1 to LiveCycle Form 
Manager 7.2. To perform this upgrade, you must update the server components that are deployed to the 
application server and initialize the database.

It is recommended that you install LiveCycle Form Manager 7.2 to a new directory so that you do not 
overwrite the previously installed version.
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➤ To upgrade LiveCycle Form Manager 7.0.1 to 7.2:

1. Back up the database that currently contains the LiveCycle Form Manager 7.0.1 configuration and 
run-time data.

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. (JBoss) If your LiveCycle deployment is running on a JBoss Application Server with a MySQL database 
that you installed using the turnkey option, stop the JBoss for Adobe LiveCycle service and the MySQL 
for Adobe LiveCycle service.

4. Undeploy the following LiveCycle Form Manager 7.0.1 components by following the instructions in the 
Installing and Configuring guide for LiveCycle Form Manager 7.0.1:

● adobe-FontManager.war

● LiveCycle.ear

● LCMBootstrapper.war

For information about undeploying from WebLogic or WebSphere, see “Uninstalling EAR files” in this 
Installing and Configuring LiveCycle guide.

5. Stop the WebLogic Server or WebSphere Application Server. 

6. Uninstall the previous version of LiveCycle products using the uninstaller program. (See “Uninstalling 
LiveCycle Products” in the related Installing and Configuring LiveCycle guide.)

7. Upgrade the application server and database to ensure that they meet the system and software 
requirements for LiveCycle 7.2 products.

8. Install LiveCycle Form Manager 7.2 to a new (non-default) directory (for example, 
C:\Adobe\LiveCycle72\ or /opt/adobe/livecycle72/). Follow the instructions in “Installing LiveCycle 
Products” in the Installing and Configuring LiveCycle guide.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same [LiveCycle72 root] directory.

9. Copy the DocumentServicesLibrary.jar file, according to your application server:

● (WebLogic) From the [LiveCycle72 root]/components/csa/weblogic/lib/adobe directory to the 
[appserverdomain root]/lib directory

● (WebSphere) From the [LiveCycle72 root]/components/csa/websphere/lib/adobe directory to the 
[appserver root]/optionalLibraries directory

● (JBoss) From the [LiveCycle72 root]/components/csa/jboss/lib/adobe directory to the 
[appserver root]/server/all/lib directory

10. Start the application server.
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11. Configure LiveCycle Form Manager 7.2 using Configuration Manager. (See “Configuring LiveCycle 
Products for Deployment” in the Installing and Configuring LiveCycle guide.) As you proceed through 
the Configuration Manager screens, choose the following options:

● Configuration Mode: Select Custom Configuration Wizard.

● Product Selection: Select the application server you are using, as well as Foundation and the 
product you are configuring.

● Task Selection: Select the following options:

● Configure and Assemble products 

● Bootstrap Database 

For WebSphere and WebLogic, also select these options:

● Deploy products 

● Verify deployed products 

12. Follow the instructions on the Configuration Manager screens to configure the LiveCycle.ear file. 
Ensure that you configure your LiveCycle 7.2 EAR file with the same settings that you chose for version 
7.0.1. If you are deploying to WebSphere or WebLogic, complete steps 13 and 14. If you are deploying 
to JBoss, complete steps 15 and 16.

Note: When prompted to specify the Global Storage Directory location, specify the same location that 
you currently use for this directory.

13. (WebSphere and WebLogic) On the Confirm Products to Deploy screen, select these EAR files:

● LiveCycle.ear

● adobe-FontManager.ear

14. (WebSphere and WebLogic) Follow the instructions on the Configuration Manager screens to initialize 
the database and verify the deployed products.

15. (JBoss) Deploy LiveCycle Form Manager 7.2 components. (See “Manually Deploying to JBoss” in the 
Installing and Configuring LiveCycle guide.)

16. (JBoss) Run Configuration Manager to initialize the database. Select Custom Configuration Wizard, 
and then select Bootstrap database. (See “Initializing the Database” in the Installing and Configuring 
LiveCycle guide.)

Note: Initializing the database is necessary to add new table columns to the database schema. 
Initializing the database does not alter existing data.

17. Verify the deployment by following the instructions in “LiveCycle Form Manager post-deployment 
tasks” the Installing and Configuring LiveCycle guide.

Note: You can also verify your installation and configuration by using the samples available at 
www.adobe.com/devnet/livecycle/samples.html.

http://www.adobe.com/devnet/livecycle/samples.html
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LiveCycle Assembler, LiveCycle Workflow, and Watched Folder
This section describes how to upgrade any or all of the following products:

● LiveCycle Workflow 7.0.1 or 7.2 to LiveCycle Workflow 7.2.1

● LiveCycle Assembler 7.2 to LiveCycle Assembler 7.2.1

● Watched Folder 1.0 to Watched Folder 1.1

If you are upgrading LiveCycle Workflow as a stand-alone product, do not include the steps that pertain to 
Watched Folder or LiveCycle Assembler. Watched Folder is intended for use with LiveCycle Assembler and 
LiveCycle Workflow; you must install LiveCycle Workflow before installing Watched Folder.

To perform this upgrade, you must update the server components that are deployed to the application 
server and initialize the database. It is recommended that you install LiveCycle Assembler 7.2.1 to a new 
directory so that you do not overwrite the previously installed version.

When you configure LiveCycle Assembler 7.2.1 using Configuration Manager, ensure that you set the 
Security Groups option to the same value that you have set for LiveCycle Assembler 7.2. (The value can be 
set to an asterisk (*), which only allows users with a valid entry in the LDAP system to log in, or to no value, 
which allows any user to log in.)

➤ To upgrade to LiveCycle Assembler 7.2.1, LiveCycle Workflow 7.2.1, and Watched Folder 1.1:

1. Back up the database that currently contains the LiveCycle Workflow 7.0.1 or 7.2 configuration and 
run-time data.

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. (JBoss) If your LiveCycle deployment is running on a JBoss Application Server with a MySQL database 
that you installed using the turnkey option, stop the JBoss for Adobe LiveCycle service and the MySQL 
for Adobe LiveCycle service.

4. Undeploy the following files from your application server:

● LiveCycle.ear

● adobe-FontManager.war

● LCMBootstrapper.war

● adobe-Assembler7.ear (LiveCycle Assembler only)

For information about undeploying from WebLogic or WebSphere, see “Uninstalling EAR files” in the 
Installing and Configuring LiveCycle guide.

5. (WebSphere and WebLogic) Stop the application server.

6. Uninstall the previous versions of LiveCycle products using the uninstaller program. (See “Uninstalling 
LiveCycle Products” in the Installing and Configuring LiveCycle guide.)

7. Install LiveCycle Assembler 7.2.1 to a new (non-default) directory (for example, C:\Adobe\LiveCycle72\ 
or /opt/adobe/livecycle72/). Follow the instructions in “Installing LiveCycle Products” in the Installing 
and Configuring LiveCycle guide. 
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8. Install LiveCycle Workflow 7.2.1 to the same directory where you installed LiveCycle Assembler 7.2.1 by 
following the instructions in “Installing LiveCycle Products” in the related Installing and Configuring 
LiveCycle guide. 

Note: You can install LiveCycle Assembler and LiveCycle Workflow in any order.

9. Install Watched Folder to the same directory where you installed LiveCycle Workflow by following the 
instructions in “Installing Watched Folder” in the Installing and Configuring LiveCycle guide. LiveCycle 
Workflow must already be installed.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same [LiveCycle72 root] directory.

10. Copy the DocumentServicesLibrary.jar file, according to your application server:

● (WebLogic) From the [LiveCycle72 root]/components/csa/weblogic/lib/adobe directory to the 
[appserverdomain]/lib directory.

● (WebSphere) From the [LiveCycle72 root]/components/csa/websphere/lib/adobe directory to the 
[appserver root]/optionalLibraries.

● (JBoss) From the [LiveCycle72 root]/components/csa/jboss /lib/adobe directory to the [appserver 
root]/server/all/lib directory. Copy the adobe-service.xml file from the [LiveCycle72_root]/
configurationManager/deploy/jboss directory to the [appserver root]/server/all/deploy/jms directory.

11. Start the application server.

12. Configure the LiveCycle products by using Configuration Manager. (See “Configuring LiveCycle 
Products for Deployment” in the Installing and Configuring LiveCycle guide.) As you proceed through 
the Configuration Manager screens, choose the following options:

● Configuration Mode: Select Custom Configuration Wizard.

● Product Selection: Select the application server you are using, and then select Foundation, as well 
as all of the products that you installed.

● Task Selection: Select the following options:

● Configure and Assemble products 

● Bootstrap Database 

For WebSphere and WebLogic, also select these options:

● Deploy products 

● Verify deployed products 

13. Follow the instructions on the remaining Configuration Manager screens. Ensure that you configure your 
7.2.1 EAR file with the same settings you chose for version 7.0.1 or 7.2. If you are deploying to WebSphere 
or WebLogic, complete steps 14 and 15. If you are deploying to JBoss, complete steps 16 and 17.

Note: When prompted to specify the Global Storage Directory location, specify the same location that 
you currently use for this directory.

14. (WebSphere and WebLogic) On the Confirm Products to Deploy screen, select the archives that you 
are deploying:

● adobe-FontManager.ear

● LiveCycle.ear

● adobe-Assembler7.ear (LiveCycle Assembler only)
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15. (WebSphere and WebLogic) Follow the instructions on the Configuration Manager screens to initialize 
the database and verify the deployed products.

16. (JBoss) Deploy LiveCycle Assembler, LiveCycle Workflow, and Watch Folder 7.2. (See “Manually 
Deploying to JBoss” in the Installing and Configuring LiveCycle guide.) These components consist of 
these EAR files:

● LiveCycle.ear

● adobe-FontManager.ear

● LCM.ear

● adobe-Assembler7.ear

17. (JBoss) Run Configuration Manager to reinitialize the database. Select Custom Configuration Wizard, 
and then select Bootstrap database. (See “Initializing the Database” in the Installing and Configuring 
LiveCycle guide.)

18. Upgrade the Assembler QPAC. (See Upgrading LiveCycle Workflow Designer or the Creating Workflows 
guide, available with the LiveCycle Workflow documentation set.)

Note: Initializing the database is necessary to add new table columns to the database schema. 
Initializing the database does not alter existing data.

19. Verify the deployment by following the instructions in the “Post Deployment” section in the Installing 
and Configuring LiveCycle guide.

Note: You can also verify your installation and configuration by using the samples available at 
www.adobe.com/devnet/livecycle/samples.html.

LiveCycle Workflow Designer
You need to use the version of LiveCycle Workflow Designer that LiveCycle Workflow 7.2.1 provides. If you 
want to use the new User QPAC with existing workflows, you need to migrate your workflows.

You must upgrade your LiveCycle QPACs from LiveCycle Workflow 7.0.1 or 7.2 to version 7.2.1. See 
“Updating components” in the Creating Workflows guide that is included with LiveCycle Workflow 
Designer.

➤ To upgrade LiveCycle Workflow Designer:

1. Uninstall LiveCycle Workflow 7.0.1 Designer.

2. Install LiveCycle Workflow 7.2.1 Designer. (See “Installing LiveCycle Workflow Designer” in the Installing 
and Configuring LiveCycle guide.)

Note: LiveCycle Workflow 7.2.1 provides an updated User QPAC that includes new features. If any of 
your workflows include User actions and you want to use the new features, you must migrate 
your workflows. For more information, see the topic “Migrating Workflows from Older Versions” 
in the Creating Workflows guide or in LiveCycle Workflow Designer Help.

http://www.adobe.com/devnet/livecycle/samples.html
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BAM Server for LiveCycle Workflow
This section describes general best practices to follow when upgrading to a new version of BAM Server. 
You must use the BAM Server upgrade utility to upgrade metadata XML files that you export from 
LiveCycle Workflow Business Activity Monitor during the upgrade process.

Upgrading BAM Server involves performing the following tasks:

● Exporting the BAM metadata using BAM Workbench

● Upgrading the BAM metadata using the BAM Server upgrade utility

● Undeploying the BAM Server EAR file from the application server

● Removing recovery log files and dropping existing tables into the BAM metadata database

● Deploying the BAM Server EAR file that LiveCycle Workflow 7.2.1 provides

● Importing the upgraded BAM metadata using BAM Workbench

About the BAM Server upgrade utility

The BAM Server upgrade utility upgrades exported metadata files so that they include new features 
required for the current product version. 

The BAM Server upgrade utility is packaged in the cqupgrade.jar file. When you install LiveCycle Workflow, 
this file is located in the [LiveCycle root]/Workflow/bam/CQUpgrade directory.

Note: The upgrade utility generates the message “Error parsing input file” when files cannot be upgraded. 
If this error is generated, the file specified in the error message may be damaged. Contact Adobe 
Systems for assistance. 

Syntax

The following command upgrades metadata files that have been exported to a JAR file:

java -jar cqupgrade.jar -jar -i inJar.jar [-o outJar.jar]

Parameters

You can use the following parameters in the BAM Server upgrade utility command: 

inJar.jar: The path to the JAR file that contains the exported metadata to upgrade.

outJar.jar (optional): The path to the upgraded JAR file. If you omit this parameter, the upgraded 
files are saved in the JAR file specified in inJar.jar.

The following examples show commands that you can use to upgrade metadata stored in JAR files using 
the BAM Server upgrade utility:

● The following command upgrades the metadata files that are stored in a JAR file named toUpgrade.jar, 
which is located in the same directory as cqupgrade.jar:

java -jar cqupgrade.jar -i toUpgrade.jar

● The following command upgrades the metadata files in the toUpgrade.jar file and saves the upgraded 
files to a different JAR file named upgraded.jar. The file is saved in the same directory as cqupgrade.jar:

java -jar cqupgrade.jar -i toUpgrade.jar -o upgraded.jar
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➤ To upgrade Business Activity Monitor:

1. Log into BAM Workbench. 

2. Click the Administration tab and then click Import/Export.

3. In the Operations menu, select Export Metadata to a JAR File (download). 

4. In the File Download dialog box, click Save.

5. Specify a location and file name for the exported JAR file, and click Save.

6. Click Close in the Download Complete dialog box. 

7. Click System Settings, and then click the Checkpoint Configuration tab. Note the directory path in 
the Recovery Log Directory box. You will need to know where the recovery log directory is at a later 
step in this procedure. 

8. Shut down Business Activity Monitor.

9. Use the BAM Server upgrade utility (cqupgrade.jar) to upgrade the metadata that you exported in a 
JAR file. (See “About the BAM Server upgrade utility” on page 137.)

10. Undeploy the BAM Server EAR file by following the instructions for your application server:

● (JBoss) Remove the following directories:

● [jboss bam root]/server/default/work

● [jboss bam root]/server/default/tmp

● [jboss bam root]/server/default/data

● [jboss bam root]/server/conf/jboss.web

● (WebSphere) Undeploy the old BAM Server EAR file using WebSphere Administrative Console.

● (WebLogic) Undeploy the old BAM Server EAR file using WebLogic Server Administration Console.

11. Delete all of the files from the recovery log directory that have names similar to the following patterns:

● filestore*.dat 

● DEFAULTRECOVERYLOGGER_*

● chkpoint_.x

12. Use your database management tools to drop the database tables that store the BAM metadata. 
Alternatively, you may want to create a new BAM metadata database. For more information about the 
BAM metadata database, see “Creating the BAM metadata database” in the Installing and Configuring 
LiveCycle guide for your application server.

13. Deploy the new version of BAM Server to the application server. (See “Deploying BAM Server” in the 
Installing and Configuring LiveCycle guide.)

14. Log into BAM Workbench.

15. Review the BAM Server configuration settings to determine if updates are required. (See “Getting 
Started with BAM Server” in the Installing and Configuring LiveCycle guide.)

16. Click the Administration tab and then click Import/Export.
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17. In the Operations menu, select Import Metadata from a JAR File (upload).

18. Click Browse to locate the JAR file that contains the upgraded BAM metadata, and then click OK.

19. Restart the BAM Server instance.

LiveCycle PDF Generator
To upgrade from LiveCycle PDF Generator 7.0.1 or 7.0.2 to LiveCycle PDF Generator 7.2, you must undeploy 
the product you are currently using before installing and deploying the new product.

The instructions in this section apply to LiveCycle PDF Generator for PostScript, LiveCycle PDF Generator 
Elements, and LiveCycle PDF Generator Professional.

➤ To upgrade LiveCycle PDF Generator 7.0.2 to LiveCycle PDF Generator 7.2:

1. Back up the database that currently contains the LiveCycle PDF Generator 7.0.1 or 7.0.2 configuration 
and run-time data.

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. (JBoss) If your LiveCycle PDF Generator deployment is running on a JBoss Application Server with a 
MySQL database that you installed using the turnkey option, stop the JBoss for Adobe LiveCycle 
service.

4. If you are installing LiveCycle PDF Generator Professional or LiveCycle PDF Generator Elements, 
uninstall Adobe Acrobat 7.0.5 from the Add/Remove programs window in the Microsoft Windows 
Control Panel, and then reboot your system.

5. Undeploy the following LiveCycle PDF Generator components by following the instructions in the 
Installing and Configuring guide for LiveCycle PDF Generator 7.0.2:

● pdfg-all.ear (or pdfg-ps-all.ear)

● LiveCycle.ear

● adobe-FontManager.war

● LCMBootstrapper.war

For information about undeploying from WebLogic or WebSphere, see “Uninstalling EAR files” in the 
Installing and Configuring LiveCycle guide.

6. (WebSphere and WebLogic) Stop the application server.

7. Uninstall the previous versions of LiveCycle products by using the uninstaller program. (See 
“Uninstalling LiveCycle Products” in the Installing and Configuring LiveCycle guide.)

8. Install LiveCycle PDF Generator 7.2 to a new (non-default) directory (for example, 
C:\Adobe\LiveCycle72\ or /opt/adobe/livecycle72/. Follow the instructions in “Installing LiveCycle 
Products” in the Installing and Configuring LiveCycle guide.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same [LiveCycle72 root] directory.
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9. Copy the DocumentServicesLibrary.jar file, according to your application server:

● (WebLogic) From the [LiveCycle72 root]/components/csa/weblogic/lib/adobe directory to the 
[appserverdomain]/lib directory

● (WebSphere) From the [LiveCycle72 root]/components/csa/websphere/lib/adobe directory to the 
[appserver root]/optionalLibraries 

● (JBoss) From the [LiveCycle72 root]/components/csa/jboss/lib/adobe directory to the 
[appserver root]/server/all/lib directory. Copy the adobe-service.xml file from the [LiveCycle72_root]/
configurationManager/deploy/jboss directory to the [appserver root]/server/all/deploy/jms directory.

10. Start the application server.

11. Configure the LiveCycle products by using Configuration Manager. (See “Configuring LiveCycle 
Products for Deployment” in the Installing and Configuring LiveCycle guide.) As you proceed through 
the Configuration Manager screens, choose the following options:

● Configuration Mode: Select Custom Configuration Wizard.

● Product Selection: Select the application server you are using, and then select Foundation, and 
LiveCycle PDF Generator.

● Task Selection: Select all of the following options:

● Configure and Assemble products 

● Bootstrap Database 

For WebSphere and WebLogic, also select these options:

● Deploy products 

● Verify deployed products 

12. Follow the instructions on the remaining Configuration Manager screens. Ensure that you configure 
your LiveCycle 7.2 EAR file with the same settings you chose for version 7.0.2. If you are deploying to 
WebSphere or WebLogic, complete steps 13 and 14. If you are deploying to JBoss, complete steps 15 
and 16.

Note: When prompted to specify the Global Storage Directory location, specify the same location that 
you currently use for this directory.

13. (WebSphere and WebLogic) On the Confirm Products to Deploy screen, select the archives that you are 
deploying:

● pdfg-all.ear (or pdfg-ps-all.ear)

● adobe-FontManager.ear

● LiveCycle.ear

14. (WebSphere and WebLogic) Follow the instructions on the Configuration Manager screens to initialize 
the database and verify the deployed products. 

15. (JBoss) Deploy the LiveCycle PDG Generator 7.2 components: 

● LiveCycle.ear

● adobe-FontManager.ear

● LCM.ear

● pdfg-all.ear (or pdfg-ps-all.ear)

(See “Manually Deploying to JBoss” in the Installing and Configuring LiveCycle guide.)



Adobe LiveCycle Upgrading LiveCycle Products to Version 7.2 or 7.2.1
Installing and Configuring LiveCycle for WebLogic  LiveCycle Document Security     141

16. (JBoss) Run Configuration Manager to reinitialize the database. Select Custom Configuration Wizard, 
and then select Bootstrap database. (See “Initializing the Database” in the Installing and Configuring 
LiveCycle guide.)

Note: Initializing the database is necessary to add new table columns to the database schema. 
Initializing the database does not alter existing data.

17. Verify the deployment by following the instructions in “LiveCycle PDF Generator post-deployment 
tasks” in the Installing and Configuring LiveCycle guide.

Note: You can also verify your installation and configuration by using the samples available at 
www.adobe.com/devnet/livecycle/samples.html.

➤ To configure JMS Messaging for WebSphere running on Windows:

1. In the WebSphere Administrative Console, delete the JMS queues, topics, and listener ports for each 
server.

2. Configure WebSphere MQ by following the instructions in “Configuring JMS resources for WebSphere 
MQ” in the Installing and Configuring LiveCycle guide.

3. Run the scripts provided by Configuration Manager to create queues in the MQ installation by 
following the instructions in “Preparing WebSphere MQ” in the Installing and Configuring LiveCycle 
guide.

4. Run Configuration Manager again and select the Configure the Application Server task. Follow the 
instructions on the Configuration Manager screens to configure application server details. (See 
“Changing the application server settings” in the Installing and Configuring LiveCycle guide.) As you 
proceed through the Configuration Manager screens, choose the following options:

● JVM Settings: Select Do Not Apply.

● JMS settings: Specify values for the properties of the MQ service.

● Datasource Creation: Select Do Not Apply.

5. On the Configure Application Server screen, click Apply Settings Now to configure your application 
server, and, when the task is complete, click Next.

6. Restart the application server and, on the Application Server/Cluster Restart screen, click Next if you 
selected another task for Configuration Manager to perform, or click Finish to close Configuration 
Manager.

7. Verify that the applications start correctly.

LiveCycle Document Security
This section provides instructions for upgrading from LiveCycle Document Security 7.0 or 7.1 to LiveCycle 
Document Security 7.2. To perform this upgrade, you must update the server components that are 
deployed to the application server.

It is recommended that you install LiveCycle Document Security 7.2 to a new directory so that you do not 
overwrite the previously installed version.

http://www.adobe.com/devnet/livecycle/samples.html
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➤ To upgrade to LiveCycle Document Security 7.2:

1. Back up the following files and folders:

● ../trust.xml

● ../credentials/

● ../certificates/

● ../CRLs/

● ../keystore

● ../trust.sig

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. Undeploy the following LiveCycle Document Security components by following the instructions in the 
Installing and Configuring guide for LiveCycle Document Security 7.0 or 7.1:

4. (WebSphere) Set up default users, roles, and login files by following in the instructions in the procedure 
“To map users to roles” in the Installing and Configuring LiveCycle Security Products guide. (This 
procedure must be completed each time the LiveCycle-security.ear file is redeployed.)

5. Restart the application server.

6. Uninstall the previous version of LiveCycle products by using the uninstaller program. (See 
“Uninstalling LiveCycle Products” in the related Installing and Configuring LiveCycle guide.)

7. Install LiveCycle Document Security 7.2 to a new (non-default) directory (for example, 
C:\Adobe\LiveCycle72\ or /opt/adobe/livecycle72/. Follow the instructions in “Installing LiveCycle 
Products” in the Installing and Configuring LiveCycle Security Products guide.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same [LiveCycle72 root] directory.

8. Copy the DocumentServicesLibrary.jar file, according to your application server:

● (JBoss) From the [LiveCycle72 root]/components/csa/jboss/lib/adobe directory to the 
[appserver root]/server/all/lib directory.

● (WebLogic) From the [LiveCycle72 root]/components/csa/weblogic/lib/adobe directory to the 
[appserver domain]/lib directory.

● (WebSphere) From the [LiveCycle72 root]/components/csa/websphere/lib/adobe directory to the 
[appserver root]/optionalLibraries directory.

WebSphere and WebLogic JBoss

adobe-FontManager.war adobe-FontManager.bar

adobe-PDFManipulation.war adobe-PDFManipulation.bar

adobe-TrustManager.war adobe-TrustManager.bar

DataManagerService.war AdobeServices.sar

ServicesNatives-2.war ServicesNatives-2.war

adobe-APSProxy.war adobe-APSProxy.bar
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9. Configure LiveCycle Document Security 7.2 using Configuration Manager. (See “Configuring LiveCycle 
Products”.) As you proceed through the Configuration Manager screens, choose the following options:

● Configuration Mode: Select Custom Configuration Wizard.

● Product Selection: Select the application server you are using, as well as Foundation and the 
product you are configuring.

● Task Selection: Select the following options:

● Configure and Assemble products 

● Bootstrap Database 

For WebSphere and WebLogic, also select these options:

● Deploy products 

● Verify deployed products 

● Trust Directory Selection: Select Create a new trust directory.

● Keystore Selection: Select Create a new keystore and pair.

10. Follow the instructions on the remaining Configuration Manager screens. Ensure that you configure 
your 7.2 EAR file with the same settings you chose for version 7.0 or 7.1. If you are deploying to 
WebSphere or WebLogic, complete steps 11 and 12. If you are deploying to JBoss, complete steps 13 
and 14.

Note: When prompted to specify the Global Storage Directory location, specify the same location that 
you currently use for the “Directory for Adobe LiveCycle products” temp file.

11. (WebSphere and WebLogic) On the Confirm Products to Deploy screen, select the archives that you are 
deploying:

● adobe-FontManager.ear

● LiveCycle.ear

● LiveCycle-security.ear

12. (WebSphere and WebLogic) Follow the instructions on the Configuration Manager screens to initialize 
the database and verify the deployed products.

13. (JBoss) Deploy LiveCycle Document Security 7.2. (See “Manually Deploying to JBoss” in the Installing 
and Configuring LiveCycle Security Products guide.)

14. (JBoss) Run Configuration Manager to reinitialize the database. Select Custom Configuration Wizard, 
and then select Bootstrap database. (See “Initializing the Database” in the Installing and Configuring 
LiveCycle Security Products guide.)

15. Restart the application server.

16. Verify your installation and configuration by using the samples available at 
www.adobe.com/devnet/livecycle/samples.html.

http://www.adobe.com/devnet/livecycle/samples.html
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LiveCycle Reader Extensions
This section provides instructions for upgrading from LiveCycle Reader Extensions 7.0 or 7.0.2 to LiveCycle 
Reader Extensions 7.2. To perform this upgrade, you must update the server components that are 
deployed to the application server.

Note: (JBoss) If you previously installed LiveCycle Reader Extensions on Windows for deployment to JBoss 
using the turnkey method, see “To upgrade LiveCycle Reader Extensions using the turnkey method” 
in the Installing and Configuring LiveCycle Security Products guide for the turnkey upgrade 
instructions.

It is recommended that you install LiveCycle Reader Extensions 7.2 to a new directory so that you do not 
overwrite the previously installed version.

If you are using an existing credential, ensure the credential has not expired and is still valid. (See 
“LiveCycle Reader Extensions Rights credential” in the Installing and Configuring LiveCycle Security Products 
guide.)

Custom applications using existing APIs supported in Adobe Document Services 6.0 for Reader Extensions 
are not supported in LiveCycle Reader Extensions 7.2. Custom applications using existing APIs supported 
in Adobe Reader Extensions Server 6.1 are supported by and continue to work with LiveCycle Reader 
Extensions 7.2. 

Digital certificates issued for use with Reader Extensions Server 6.1 are compatible for use with LiveCycle 
Reader Extensions 7.2. If you are upgrading from version 6.1 to 7.2, you will not receive a new Rights 
credential.

➤ To upgrade LiveCycle Reader Extensions to 7.2:

1. Back up the following files and folders in the [LiveCycle root]/ReaderExtensions/trust directory:

● ../trust.xml

● ../credentials/

● ../certificates/

● ../CRLs/

● ../keystore

● ../trust.sig

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. Undeploy the following LiveCycle Reader Extensions components by following the instructions in the 
Installing and Configuring guide for LiveCycle Reader Extensions 7.0 or 7.0.2:

WebSphere and WebLogic JBoss

adobe-FontManager.war adobe-FontManager.bar

adobe-PDFManipulation.war adobe-PDFManipulation.bar

adobe-TrustManager.war adobe-TrustManager.bar

DataManagerService.war AdobeServices.sar



Adobe LiveCycle Upgrading LiveCycle Products to Version 7.2 or 7.2.1
Installing and Configuring LiveCycle for WebLogic  LiveCycle Reader Extensions     145

4. Restart the application server.

5. Uninstall the previous version of LiveCycle products y using the uninstaller program. (See “Uninstalling 
LiveCycle Products” in the related Installing and Configuring LiveCycle guide.)

6. Install LiveCycle Reader Extensions 7.2 to a new (non-default) directory (for example, 
C:\Adobe\LiveCycle72\ or /opt/adobe/livecycle72/. Follow the instructions in “Installing LiveCycle 
Products” in the Installing and Configuring LiveCycle Security Products guide.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same [LiveCycle72 root] directory.

7. Copy the DocumentServicesLibrary.jar file, according to you application server:

● (WebLogic) From the [LiveCycle72 root]/components/csa/weblogic/lib/adobe directory to the 
[appserver domain]/lib directory.

● (WebSphere) From the [LiveCycle72 root]/components/csa/websphere/lib/adobe directory to the 
[appserver root]/optionalLibraries directory.

● (JBoss) From the [LiveCycle72 root]/components/csa/jboss/lib/adobe directory to the 
[appserver root]/server/all/lib directory.

8. Configure LiveCycle Reader Extensions 7.2 by using Configuration Manager. (See “Configuring 
LiveCycle Products” in the Installing and Configuring LiveCycle Security Products guide.) As you proceed 
through the Configuration Manager screens, choose the following options:

● Configuration Mode: Select Custom Configuration Wizard.

● Product Selection: Select the application server you are using, as well as Foundation and the 
product you are configuring.

● Task Selection: Select the following options:

● Configure and Assemble products 

For WebSphere and WebLogic, also select these options:

● Deploy products 

● Verify deployed products 

● Trust Directory Selection: Select Create a new trust directory.

● Keystore Selection: Select Create a new keystore and pair.

9. Follow the instructions on the remaining Configuration Manager screens. Ensure that you configure 
your 7.2 EAR file with the same settings you chose for version 7.0 or 7.1. If you are deploying to 
WebSphere or WebLogic, complete steps 10 and 11. If you are deploying to JBoss, complete step 12.

Note: When prompted to specify the Global Storage Directory location, specify the same location that 
you currently use for the “Directory for Adobe LiveCycle products” temp file.

ServicesNatives-2.war ServicesNatives-2.war

ares.ear ares.ear

adobe-CredentialSecurityEJB.ear adobe-CredentialSecurityEJB.ear

adobe-APSProxy.war adobe-APSProxy.bar

WebSphere and WebLogic JBoss
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10. (WebSphere and WebLogic) On the Confirm Products to Deploy screen, select the archives that you are 
deploying:

● adobe-FontManager.ear

● LiveCycle.ear

● LiveCycle-security.ear

11. (WebSphere and WebLogic) Follow the instructions on the Configuration Manager screens to initialize 
the database and verify the deployed products.

12. (JBoss) Deploy LiveCycle Reader Extensions 7.2. (See “Manually Deploying to JBoss” in the Installing and 
Configuring LiveCycle Security Products guide.)

13. Restart the application server.

14. Verify the installation and configuration by going to the appropriate URL:

● (WebLogic) http://[host_name]:7001/ReaderExtensions or 
http://[host_name]:8001/ReaderExtensions (Managed Server)

● (WebSphere) http://[host_name]:9080/ReaderExtensions

● (JBoss) http://[host_name]:8080/ReaderExtensions

15. Type the user name and password you created when you configured the LiveCycle Reader Extensions 
user. (See “Setting up users, roles, and login files” for JBoss or WebLogic or “To map users to roles” for 
WebSphere in the Installing and Configuring LiveCycle Security Products guide.)

➤ (JBoss) To upgrade LiveCycle Reader Extensions using the turnkey method:

1. Stop the AdobeReaderExtensions Windows service from the Services window in the Administrative 
Tools area of the Windows Control Panel.

2. Verify that port 8080 is not being used. 

3. The turnkey installation specifies “localhost” as the host and “8080” as the port for use by JBoss. If JBoss 
is already installed, ensure that it is not using port 8080. You cannot configure an alternative host or 
port for JBoss during the turnkey installation and configuration process.

4. Install LiveCycle Reader Extensions 7.2 using the turnkey method to a new (non-default) directory (for 
example, C:\Adobe\LiveCycle72\). Follow the instructions in “Installing LiveCycle Reader Extensions or 
LiveCycle Document Security” in the Installing and Configuring LiveCycle Security Products guide.

5. Verify the installation and configuration by going to the URL 
http://[host_name]:8080/ReaderExtensions.

Note: For turnkey installations, the default user name is administrator and the default password is 
password. To edit these values, see “Setting up users, roles, and login files” in the Installing and 
Configuring LiveCycle Security Products guide.

Note: You can also verify your installation and configuration by using the samples available at 
www.adobe.com/devnet/livecycle/samples.html.

http://www.adobe.com/devnet/livecycle/samples.html


Adobe LiveCycle Upgrading LiveCycle Products to Version 7.2 or 7.2.1
Installing and Configuring LiveCycle for WebLogic  LiveCycle Policy Server     147

LiveCycle Policy Server
This section provides instructions for upgrading from LiveCycle Policy Server 7.0.2 to LiveCycle Policy 
Server 7.2. To perform this upgrade, you must update the server components that are deployed to the 
application server and initialize the database.

It is recommended that you install LiveCycle Policy Server 7.2 to a new directory so that you do not 
overwrite the previously installed version.

➤ To upgrade LiveCycle Policy Server to 7.2:

1. Back up the database that currently contains the LiveCycle Policy Server 7.0.2 configuration and 
run-time data.

2. Ensure that you have a back-up copy of the currently deployed LiveCycle EAR and WAR files that are 
configured for the current production system that you are planning to upgrade.

3. Undeploy the following LiveCycle Policy Server 7.0.2 components:

● asn1.jar

● jsafe.jar

● jsafeJCE.jar

● edc-server-spi.jar

● edc-server.ear

4. Remove the dom*.jar files from the [appserver root]/java/jre/lib/endorsed directory.

5. Uninstall the previous version of LiveCycle products by using the uninstaller program. (See 
“Uninstalling LiveCycle Products” in the relevant Installing and Configuring LiveCycle guide.)

6. Install LiveCycle Policy Server 7.2 to a new (non-default) directory (for example, C:\Adobe\LiveCycle72\ 
or /opt/Adobe/livecycle72/). Follow the instructions in “Installing LiveCycle Products” in the Installing 
and Configuring LiveCycle Security Products guide.

Note: If you are installing or upgrading multiple LiveCycle 7.2 products, be sure to install them to the 
same [LiveCycle72 root] directory.

7. Deploy LiveCycle Policy Server 7.2. (See the chapter about manually deploying to the application 
server in the Installing and Configuring LiveCycle Security Products guide for your application server.)

8. Run Configuration Manager to reinitialize the database. Select Custom Configuration Wizard, and 
then select Bootstrap database. (See “Initializing the Database” in the Installing and Configuring 
LiveCycle Security Products guide.)

Note: Initializing the database is necessary to add new table columns to the database schema. 
Initializing the database does not alter existing data.

9. Configure various run-time settings for LiveCycle Policy Server. (See the “Post-deployment” section of 
the Installing and Configuring LiveCycle Security Products guide.)

Note: You can verify your installation and configuration by using the samples available at 
www.adobe.com/devnet/livecycle/samples.html.

http://www.adobe.com/devnet/livecycle/samples.html
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G Enhancing Server Performance

This appendix provides general tips that you can use to improve server performance when using LiveCycle 
products.

Optimizing inline documents and impact on JVM memory
If you are typically processing documents of a relatively small size, you can improve the performance 
associated with the document transfer speed and storage space by implementing the following LiveCycle 
product configurations:

● Increase the maximum inline size for LiveCycle products so that it is larger than the size of most 
documents.

● For processing larger files, specify storage directories that are located on a high-speed disk system or a 
RAM disk.

The default maximum inline size and the storage directories (the Adobe LiveCycle products temporary file 
directory and the Global storage directory) are properties of the Data Manager Module. You can configure 
the Data Manager Module using Configuration Manager. (See “Performing a custom configuration” on 
page 41.)

Note: The default maximum inline size is 65536 bytes.

Document size and maximum inline size

When a document that is sent for processing by LiveCycle products is less than or equal to the maximum 
inline size, the document is stored on the server inline and the document is serialized as an Adobe 
Document object. Storing documents inline can have significant performance benefits. However, if you are 
using LiveCycle Workflow, the content may also be stored in the database for tracking purposes, and so 
increasing the maximum inline size might affect the database size.

A document that is larger than the maximum inline size is stored on the local file system (in the storage 
directories specified using Configuration Manager), and the Adobe Document object that is transferred to 
and from the server is only a pointer to that file. 

When document content is inlined (that is, less than the maximum inline size), the content is stored in the 
database (as part of the Document's serialization payload). So, increasing the maximum inline size might 
affect the database size.

JVM maximum heap size

An increase in the maximum inline size requires more memory for storing the serialized documents and so 
generally also requires an increase in the JVM maximum heap size. The maximum JVM heap size should 
not exceed 2GB.

A heavily-loaded system that is processing a large number of documents can rapidly saturate the JVM 
heap memory. To avoid an OutOfMemoryError, the JVM maximum heap size must be increased by an 
amount corresponding to the size of the inline documents multiplied by the number of documents that 
are typically executed at any given time. 

JVM maximum heap size increase = (inline documents size) x (average number of documents processed)
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Example G.1 Calculating the JVM maximum heap size

In this example, the current JVM maximum heap is set to 512 MB and the maximum inline size is 64 KB. The 
server needs to be configured for the scenario where 10 jobs are run simultaneously, and each job has 9 
input files and 1 result file (a total of 10 files per job, and 100 files processed simultaneously). All of the files 
are under 512 KB in size.

To store all of the files inline, the maximum inline size must be set to at least 512 KB.

The required increase in the JVM maximum heap size is calculated using the following equation:

(512 KB) x (100) = 51200 KB, or 512 MB

The JVM maximum heap size must be increased by 512 MB for a total of 1GB.

Considering heap fragmentation

Setting the size of inline documents to large values raises the risk of an OutOfMemoryError on systems 
that are prone to heap fragmentation. To store a document inline, there must be sufficient contiguous 
space in the JVM heap memory. Some operating systems, JVMs, and garbage collection algorithms are 
prone to heap fragmentation. Fragmentation decreases the amount of contiguous heap space, and can 
lead to an OutOfMemoryError even when sufficient total free space exists.

For example, previous operations on the application server have left the JVM heap in a fragmented state, 
and the garbage collector is unable to compact the heap sufficiently to regain large blocks of free space. 
An OutOfMemoryError can occur even though the JVM maximum heap size has been adjusted for an 
increase in maximum inline size.

To account for heap fragmentation, the inline document size must not be set higher than 0.1% of the total 
heap size. For example, a JVM maximum heap size of 512 MB can support a maximum inline size of 512 MB 
x 0.001 = 0.512 MB, or 512 KB. 

Cleaning up temporary files in the Global storage directory
When a workflow process is executed, temporary files are placed in the Global storage directory, but are 
not deleted when the process is complete. These files are placed under subdirectories with the name, 
Session[NNNN], where NNNN is the workflow process ID. To prevent running out of disk space, you must 
regularly remove the Session directories associated with fully completed processes. 

If the Global storage directory is not set explicitly in Configuration Manager, the default location of the 
Global storage directory is [TempDir]/AdobeDocumentStorage/global. If [TempDir] is also not specified by 
the user in Configuration Manager, the default location is java.io.tmpdir.

Improving Windows Server Performance with LDAP
Using connection pooling on the search connection can decrease the number of ports need by as much as 
50%, since that connection always uses the same credentials for a given domain, and the context and 
related objects are closed explicitly.
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➤ To configure your Windows Server for connection pooling:

1. 1. Start the registry editor by clicking Start > Run and in the Open box type regedit and click OK.

2. Navigate to the registry key: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters 

3. In the right pane of the registry editor, look for the TcpTimedWaitDelay value name. If the name does 
not appear, you can add it by selecting Edit > New > DWORD Value from the menu bar. 

4. In the name box, type TcpTimedWaitDelay.

Note: If you do not see the a flashing cursor and New Value # inside the box, right-click inside the 
right panel, select Rename from the menu, then in the name box, type TcpTimedWaitDelay.

5. Repeat this step 4 for the following value names: MaxUserPort, MaxHashTableSize, and 
MaxFreeTcbs.

6. Double-click inside the right pane to set the TcpTimedWaitDelay value. Under Base, select Decimal, 
and in the Value box, type 30.

7. Double-click inside the right pane to set the MaxUserPort value. Under Base, select Decimal, and in 
the Value box, type 65534.

8. Double-click inside the right pane to set the MaxHashTableSize value. Under Base, select Decimal, 
and in the Value box, type 65536.

9. Double-click inside the right pane to set the MaxFreeTcbs value. Under Base, select Decimal, and in 
the Value box, type 16000.

Caution: Serious problems might occur if you modify the registry incorrectly by using Registry Editor or 
by using another method. These problems might require that you reinstall your operating 
system. Modify the registry at your own risk.
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